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This application may contain a binary form of the Info-ZIP tool to create .zip files. That source code is provided under the following
license:
This software is provided "as is," without warranty of any kind, express or implied. In no event shall Info-ZIP or its contributors be
held liable for any direct, indirect, incidental, special or consequential damages arising out of the use of or inability to use this
software.
Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and
redistribute it freely, subject to the following restrictions:

1. Redistributions of source code must retain the above copyright notice, definition, disclaimer, and
this list of conditions.

2. Redistributions in binary form must reproduce the above copyright notice, definition, disclaimer,
and this list of conditions in documentation and / or other materials provided with the distribution.

3. Altered versions--including, but not limited to, ports to new operating systems, existing ports with
new graphical interfaces, and dynamic, shared, or static library versions--must be plainly marked
as such and must not be misrepresented as being the original source. Such altered versions also
must not be misrepresented as being Info-ZIP releases--including, but not limited to, labeling of
the altered versions with the names "Info-ZIP" (or any variation thereof, including, but not limited
to, different capitalizations), "Pocket UnZip," "WiZ" or "MacZip" without the explicit permission
of Info-ZIP. Such altered versions are further prohibited from misrepresentative use of the Zip-
Bugs or Info-ZIP e-mail addresses or of the Info-ZIP URL(s).

4. Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "WiZ," "Pocket UnZip,"
"Pocket Zip," and "MacZip" for its own source and binary releases.

Copyright

The software described in this manual is furnished under a license agreement and may be used or copied
only in accordance with the terms of the agreement.
_____________________________________________________________________________________
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WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and service
conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been defective.
The purchaser is responsible for all transportation charges involving the shipment of materials for warranty repairs.
Failure of any instrument or product due to operator error, improper installation, unauthorized repair or alteration, failure
of utilities, or environmental contamination will not constitute a warranty claim. The materials of construction used in
MICROMERITICS instruments and other products were chosen after extensive testing and experience for their reliability
and durability. However, these materials cannot be totally guaranteed against wear and / or decomposition by chemical
action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and
authorization to return the instrument or product. All repairs or replacements are made subject to factory inspection of
returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are
made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their respect-
ive brand names or trade names. We, therefore, make no express or implied warranty as to such products. We
shall use our best efforts to obtain from the manufacturer, in accordance with his customary practice, the repair or
replacement of such of his products that may prove defective in workmanship or materials. Service charges made
by such manufacturer are the responsibility of the ultimate purchaser. This states our entire liability in respect to
such products, except as an authorized person of MICROMERITICS may otherwise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the discretion
of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves, seals,
etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and stems,
seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such items
which perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of man-
ufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its
products other than the liability stated above. This warranty is in lieu of all other warranties, express or implied,
including but not limited to, the implied warranties of merchantability or fitness for use.

Warranty
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Contact Us

CONTACT US

Micromeritics Instrument Corporation

4356 Communications Drive

Norcross, GA / USA / 30093-2901

Phone: 1-770-662-3636

Fax: 1-770-662-3696

www.Micromeritics.com

---------------

U.S. Inquiries

U.S. Sales Phone: 1-770-662-3636

USSales@Micromeritics.com

---------------

Quotes, Orders, and Customer Satisfaction

Customer Service Phone: 1-770-662-3636

Orders@Micromeritics.com

---------------

U.S. Instrument Service Department

U.S. Service Department Phone: 1-770-662-3666
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ABOUT THIS MANUAL

The following formats may be used in this manual.

NOTE - Notes contain important information pertinent to the subject matter.

CAUTION - Cautions contain information to help prevent actions that may damage the ana-
lyzer or components.

WARNING - Warnings contain information to help prevent actions that may cause per-
sonal injury.

Labels and Buttons Description
Buttons (in the applic-
ation)

Buttons in the application are represented as bold font and blue letters —
such as: Save, Edit, and Replace All.

Buttons (on the equip-
ment)

Buttons on the equipment are represented as bold font and black letters —
such as: Onor Off.

Field Labels Field Labels are represented as italicized words — such as: Sample, Auto-
matically Collected, and Analysis Conditions.

Keyboard Commands Keyboard commands are represented as bold font and black letters — such
as: F2 and Alt+F4.

Menu Instructions Menu instructions are represented as bold and italicized words — such as:
File > New Sample and Reports > Start Report.

Screen Tabs Screen Tabs are represented as italicized words — such as: Sample Descrip-
tion, Analysis Conditions, and Report Options.

Screen Titles Screen Titles are represented as italicized words — such as: Analysis
Adsorptive Properties, Free Space, and Sample Tube.

Field Labels and Screen Titles

About this Manual
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1 ABOUT THE ASAP 2060 ANALYZER

The ASAP (Accelerated Surface Area and Porosimetry) 2060 is a single-port physisorption instrument
that includes the ASAP 2020 manifold in a smaller cabinet. The analyzer is equipped with an elevator
that raises and lowers the analysis bath fluid dewar automatically. A removable shield is included for
safety purposes.

The sample saturation pressure (Psat) tube is located next to the sample analysis port. Gas inlet ports and
cable connections are located conveniently on the rear panel of the analyzer.

The instrument includes isothermal jackets for the sample tube in order to maintain a stable thermal
profile along the full length of the sample and Psat tubes.

1 About the ASAP 2060 Analyzer
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1 About the ASAP 2060 Analyzer

ANALYZER COMPONENTS

FRONT COMPONENTS

Component Description
A Elevator Provides placement of the dewar or furnace.
B Power indicator light Illuminates when power is ON.

C Psat port Use to measure saturation pressure.

D Sample port Use to attach a sample for analysis.

Front Panel Components

1 - 2 ASAP 2060 Operator Manual
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REAR COMPONENTS

Component Description
A Gas Inlet ports For attaching the analysis gases.
B Helium Inlet port Provides connection of helium for measuring the free

space.
C Vacuum Port For attaching vacuum pumps.
D Ethernet Port Provides connection to the computer or Ethernet

switch.
E RS-232 Port Not used.
F Power Provides electrical cable connector. Includes On/Off

switch.

Rear Panel Components

Rear Components
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1 About the ASAP 2060 Analyzer

EQUIPMENT OPTIONS

Equipment Option Description
MicroPrep Temperature controller and heating mantle. Used for in-situ degassing.
SmartPrep The SmartPrep passes flowing-gas over the sample at elevated

temperatures. It contains six sample ports in which temperature, ramp
rates, and soak times are individually controlled by the analyzer program
so that all degas information is integrated into the sample data file for
future reference. It contains 2 serial ports, one for connecting to the
computer and the other for connection of up to 3 additional SmartPrep
instruments permitting 24 preparation ports to be used.
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POWER ANALYZER ON AND OFF
Power on the equipment in the following order:

1. Analyzer

2. Computer, monitor, and printer

Always exit the analysis program before powering off the computer. Failure to do so could
result in loss of data.

Power off the equipment in the following order:

1. Computer*, monitor, and printer

* If an analysis is in progress when closing the application, the following message is displayed:

2459 - An Instrument is busy. A delay in restarting this application could
result in loss of new data. Continue program exit? Yes / No

Yes. Closes the program. The analysis continues and data continue to be collected. The data
will be restored when the application is restarted. If a power failure occurs and an
uninterruptible power supply (UPS) is not attached to the analyzer, the data collected after
exiting the analysis program are lost.

No. The program remains open and the analysis continues to run.

2. Analyzer

Power Analyzer On and Off
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1 About the ASAP 2060 Analyzer

SPECIFICATIONS

Specification Description
Cryogen System

Analysis Time Unlimited. Cryogen dewars may be refilled without affecting the
accuracy of results.

Capacity 3 liter dewar, which typically provides greater than 72 hours of
unattended analysis.

Special Features Isothermal Jackets maintain cryogen level constant on sample
tube and P0 tube during analysis while evaporation of cryogen
occurs.

Electrical
Voltage 85 - 264 VAC
Frequency 47 - 63 Hz
Power 150 VA

Environment
Temperature 10 to 30 °C, operating

0 to 50 °C, storing or shipping
Humidity 20 to 80% relative, noncondensing

Gases
Argon, carbon dioxide, nitrogen, krypton, and other suitable gases

Manifold Temperature Transducer
Type Platinum resistance device (RTD)
Accuracy + 0.02 °C

Physical
Height 94.5 cm (37.2 in.)
Width 38.1 cm (15.0 in.)
Depth (chassis) 59.0 cm (23.2 in.)
Depth (with vacuum tube)) 68.1 cm (27.1 in.)
Weight 68 kg (150 lbs)

Pressure Measurement
Accuracy — Includes nonlinearity, hysteresis, and nonrepeatability. Transducer manufacturer’s spe-
cifications. All within 0.15% of reading.
Range 0 to 950 mmHg
Resolution

1000 mmHg Transducer 0.001 mmHg
10 mmHg Transducer 0.00001 mmHg
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Specification Description
0.1 mmHg Transducer 0.0000001 mmHg

Sample Size
Sample tubes are available for various size pellets, cores, and powders. Sample tube stems are nor-
mally 1.27 cm (1/2 in.) OD with 9 cc bulbs. Also available are 0.635 cm (1/4 in.) or 0.953 cm (3/8 in.)
OD with 9 cc bulbs. A 22-mm (0.87 in.) ID, 25 mm (1.0 in.) OD sample tube kit is also available. Spe-
cial tubes can be designed to accommodate unusual samples.

System Capacity
Analysis 1 sample port and 1 saturation pressure tube
Total Operating
Capacity

Up to four complete analysis units can be controlled inde-
pendently by one computer
Computer Requirements

Windows 7 Professional or higher operating system is recommended for the best user
experience. If the computer is to be connected to a network, a second Ethernet port on the
computer must be used for that purpose.

All users of the application will need Read / Write permission to all directories and
subdirectories where the application is installed.

In keeping with a policy of ongoing product improvement, specifications are subject to change without
notice.

Specifications
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2 ABOUT THE SOFTWARE

The Help menu provides access to this operator manual and tutorials on using the software.

The MicroActive feature offers a Windows interface with an easy way to collect, organize, archive,
reduce raw data, and store sample information files for later use. Scalable and editable graphs, and cut-
and-paste graphics, are easily generated. Customized reports can be generated to screen, paper, or
exported for use in other programs. There are two report functions:

l Advanced reports (using the Python module)

l MicroActive reports

Report options can be specified when creating the sample information file. When running an analysis,
data gathered during the analysis process are compiled into the predefined reports. Reports can also be
defined and generated after an analysis has been run. Each selected report is displayed on its own tab
and reflects data collected during the analysis.

SOFTWARE SETUP

If the computer is to be connected to a network, a second Ethernet port on the computer
must be used for that purpose.

The Setup program is located on the installation CD. It is used to:

l Reinstall the software version [n]

l Add an analyzer

l Move an analyzer

l Remove an analyzer

l Change analyzer setup

l Reinstall calibration files for an analyzer

l Import an analyzer from a previous installation on this PC

Insert the setup CD into the CD-ROM drive. The setup program starts automatically. If the program does
not start automatically, navigate to the CD drive, locate and double click the setup.exe file.

If the IP address needs to be changed on the computer connected to the analyzer, refer to
the computer's operating system manual or the internet for instructions. The IP address for
the computer and the IP address specified in the setup program must match. The IP address
must be 192.168.77.100.

2 About the Software
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2 About the Software

SOFTWARE UPDATES
When performing a software update, existing data files are not overwritten. There are three types of
subsequent installation:

l a later version than the current installation

l the same version as the current installation

l an earlier version than the current installation

Insert the setup CD into the CD-ROM drive. The setup program starts automatically. If the program does
not start automatically, navigate to the CD drive, locate and double click the setup.exe file.

UNINSTALL THE SOFTWARE

When the software is uninstalled, only the files required to run the application are removed. Parameter
files, sample files, reports, calibration files, and data files are not removed.

To uninstall the software, locate and double click the uninstall.EXE file located in the software
installation directory, then follow the prompts on the screen.
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MENU STRUCTURE
All program functions use standard Windows menu functionality. The title bar contains a Unit Number.
If multiple units (analyzers) are installed, ensure the appropriate unit is selected before continuing.

Option Description
File Use to manage files used by the application — such as sample files, ana-

lysis conditions files, report options files, etc.
Unit [n] Use to perform analyses, calibrations, and other analyzer operations.

A Unit [n] displays on the menu bar for each analyzer attached to the
computer.

Reports Use to run reports and view the results.
Options Use to edit the default method, specify system configuration, specify

units, and change presentation options.
Window Use to manage open windows and display a list of open windows. A

checkmark appears to the left of the active window.
Help Provides access to the operator manual, online instructional tutorials, the

Micromeritics web page, the analyzer web page, and information about
the analyzer.

Main Menu Bar Options

Menu Structure
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2 About the Software

COMMON FIELDS AND BUTTONS
The fields and buttons in the following table are located in multiple windows throughout the analyzer
application and have the same description or function. Fields and button descriptions not listed in this
table are found in tables in their respective sections.

Field or Button Description
Add Log Entry Use to enter information to appear in the sample log report that cannot be

recorded automatically through the application. Click the button again to
enter multiple log entries.

Autoscale checkbox When enabled on report parameters windows, allows the x- and y-axes to
be scaled automatically. Autoscale means that the x- and y- ranges will
be set so that all the data is shown. If Autoscale is not selected, the
entered range is used.

Axis Range On report parameters windows, the From / To fields are enabled when
Autoscale options are not selected. Enter the starting and ending values
for the x- and / or y-axes.

Bar Code Enter bar code reader information if a bar code reader is connected to the
computer’s USB port. If a bar code reader is not used, this alphanumeric
field can be used to enter additional information about the sample, such as
a sample lot number, sample ID, etc.

Browse Searches for a file. Select a file from the Name column or from the
library, then click Open. Alternatively, double click the file name to open
(or import) the file.

Cancel Discards any changes.
Close Closes the active window.
Close All Closes all active windows. If changes were made and not yet saved, a

prompt displays for each changed file providing the option to save the file.
Comments Enter comments about the sample or analysis. Comments display in the

report header.
Delete When working with report parameters, Delete removes the selected

report. Deleted reports will have to be regenerated if deleted in error.
Destination group box l Preview. Previews the predefined report on the screen.

l Print. Sends the report to the default printer.

l Copies. Select the number of copies to print. This field is only enabled
when Print is selected.

l File. Select the destination directory. Enter a new file name in the File
name field, or accept the default. Select to save the file as a report sys-

Common Fields and Buttons Table
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Field or Button Description
tem (.REP), a spreadsheet (.XLS), a portable document format (.PDF),
or an ASCII text (.TXT) file format.

Edit When working with report parameters, highlight the item in the Selected
Reports list box and click Edit to modify the report details.

Exit If a file is open with unsaved changes, a prompt displays providing the
option to save the changes and exit or to exit the application without sav-
ing the changes.

Export Exports isotherm data in a sample information file as a .REP, .TXT or
.XLS file. When saved to a file, the data can be imported into other
applications.

File name text box Select a file from either the Name column or from the library. The file
name displays in the File name text box. Click Open or double click the
file name to open the file. To select more than one file, hold down the
Ctrl key on the keyboard while selecting the files, or hold down the Shift
key to select a range of files.

From / To text boxes When working with report parameters windows, enter the From and To
range for x- and / or y-axes.

List Provides the option to create a list of sample or report options file inform-
ation, for example, file name, date / time the file was created or last
edited, file identification and file status.

Name column A list of files in the selected directory or library.
Next Click to move to the next window or next step.
OK Saves and closes the active window.
Open Opens the selected file. Alternatively, double click the file name in the

Name column to open the file.
Prev Click to move to the previous window.
Preview Previews predefined reports. Click the tabs at the top of the window to

preview each selected report. When an analysis has not been run on a
sample, this button is disabled.

Print Sends the report to the selected destination (screen, printer or file).
Remove Click to remove an item from the list.
Replace Click to select another file where the values will replace the current

file’s values.
Replace All Click to select another .SMP file where the values will replace all values

for the active Sample Information file. The original file will remain
unchanged.

Report Click to display a window to specify report output options.

l Start Date. Displays a calendar to select the start date for the report.

Common Fields and Buttons Table (continued)

Common Fields and Buttons
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2 About the Software

Field or Button Description
l Preview. Previews the predefined report on the screen.

l Print. Sends the report to the default printer.

l Copies. Select the number of copies to print. This field is only enabled
when Print is selected.

l File. Select the destination directory. Enter a new file name in the File
name field, or accept the default. Select to save the file as a report sys-
tem (.REP), a spreadsheet (.XLS), a portable document format (.PDF),
or an ASCII text (.TXT) file format.

Save Saves changes to the active window.
Save As Saves a file in the active window under a different file name.
Start Starts the report, test, analysis, or operation.
Table buttons Use to modify the table contents.

l Insert. Inserts one row above the selected row.

l Delete. Deletes the selected row.

l Clear. Clears all table entries and displays only one default value.

l Append. Inserts one row at the end of the table.

Common Fields and Buttons Table (continued)
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FILE STATUS, DESCRIPTION, EXTENSION, AND LOCATION
In the File Selector window, the Mic Description column and the Mic Status column display file
description and file status. The File Selector incorporates standard Windows features for resizing
windows, reordering and repositioning columns, and right clicking an entry to display a menu of standard
Windows functions.

File Status Description
Analyzing Sample information files that are currently being used for analysis.
Complete Sample information files used in an analysis that has been completed.
Entered Sample information files containing manually entered data.
No Analysis Sample information files which have not been used to perform an

analysis.

File Status and Description Table

File Type File Name Exten-
sion

Default Location

Alpha-s curve .ALS Param Directory
Adsorptive properties .ADP Param Directory
Analysis conditions .ANC Param Directory
Degas conditions .DEG Param Directory
Heat of Adsorption Report .HOA Param Directory
Methods .MTH Methods Directory
Report options .RPO Param Directory
Sample information .SMP Data Directory
Sample tube properties .STB Param Directory
Thickness curve .THK Param Directory
The following file types are available when printing or exporting reports:
Report .REP
Spreadsheet .XLS
Unicode .TXT
Portable document format .PDF

File Type, Extension, and Location Table

File Status, Description, Extension, and Location
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2 About the Software

APPLICATION SHORTCUTS

MENU SHORTCUTS

Shortcut menus are available for:

l the analyzer schematic when manual control is enabled

l onscreen graphs and tabular reports.

KEYBOARD SHORTCUTS

Shortcut keys can be used to activate some menu commands. Shortcut keys or key combinations (when
applicable) are listed to the right of the menu item.

Certain menus or functions can also be accessed using the Alt key plus the underlined letter in the menu
command. For example, to access the File menu, press Alt + F, then press the underlined letter on the
submenu. For example, Alt + F opens the File menu, then press O to access the File Selector for
opening files.

If the underscore does not display beneath the letter on the menu or window, press the Alt
key on the keyboard.

Field or Button Description
Alt + [Unit n] Opens the Unit [n] menu.
Alt + F Opens the File menu.
Alt + F4 Exits the program. If files are open with unsaved changes, a prompt to save

changes displays.
Alt + H Opens the Help menu.
Alt + I Opens the Options menu.
Alt + R Opens the Reports menu.
Alt + W Opens the Window menu.
Shift + F9 Opens the shortcut menu of (1) selected component on analyzer schematic when

manual control is enabled or (2) onscreen reports.
Ctrl + N Opens a new sample file.
Ctrl + O Opens the File Selector.
Ctrl + P Opens the File Selector to start a report from a selected .SMP file.
Ctrl + S Saves the open file.
F1 Opens the online help operator manual.

Keyboard Shortcut Table
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Field or Button Description
F2 Displays the File Selector window.
F3 When in the File Selector window, opens the file search box.
F4 When in the File Selector window, opens the address bar.
F6 Cascades open windows.
F7 Tiles open windows.
F8 Opens the File Selector to start a report from a selected .SMP file.
F9 Closes all open reports.

Keyboard Shortcut Table (continued)

Keyboard Shortcuts
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2 About the Software

OPTION PRESENTATION

Options > Option Presentation

Use to change the way sample files and parameter files display: Advanced, Basic, or Restricted. Each
display option shows sample information and options differently.

Presentation Display Description
Advanced Displays all parts of sample information and parameter files. Navigate to

parameter windows by selecting the tabs across the top of the window.
Basic Displays sample information in a single window. This display option is

used after the parameter files have been created. The previously entered
or default parameter files are then accessible using drop-down lists.

Restricted Displays the sample information file in a single window similar to the
Basic display option with certain functions disabled. A password is set
when the Restricted option is selected. That same password must be
entered to change to the Basic or Advanced display option. This display
type is typically used in laboratories where analysis conditions must
remain constant — such as the pharmaceutical industry. The Advanced
option is not available at the bottom of the window when using the
Restricted display option.

Presentation Display Table

Specify or change the default option presentation by selecting Options > Option Present-
ation, or select Basic or Advanced from the drop-down list at the bottom of the window.

The following examples show the same sample information file in Advanced and Basic display. Basic
and Restricted displays will look the same.
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2 About the Software

LIBRARIES
The library provides an easy way to locate and open specific analyzer files. The library is located within
the File Selector window and can be viewed only within the application.

1. To locate and open a sample information file, go to File > Open.

2. Click the Sample Information library folder on the left navigation bar.

3. Select the .SMP file on the pane on the right side of the window, then click Open.

See Manage Libraries below.

MANAGE LIBRARIES

Options > Manage Libraries

This feature is available only for Windows 7 and higher operating systems.

The library gathers sample and parameter files that are stored in multiple locations — such as folders on
a C: drive, a network location, a connected external hard drive, or a connected USB flash drive —
providing instant access at once to all of those files. Even though libraries do not store actual sample and
parameter files, folders can be added or removed within each library.

One library can include up to 50 folders. Other items such as saved searches and search
connectors cannot be included.

1. To manage folders in a library, go to Options > Manage Libraries. Select the library to modify
from the drop-down list, then clickManage.

l To add a folder to the library, click Add to browse and locate a folder.
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l Select the folder, then click Include folder.

l To remove a folder, select the folder from the library locations box, then click Remove.

When removing a folder from a library, the folder and its contents are not
deleted from the original file storage location. However, when deleting files or
folders from within a library, they are deleted from their original file storage
location.

2. Click OK when done.

Manage Libraries
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2 About the Software

METHODS

A Method determines the default sample identification format and sequence number. A Method is a
template of specifications that go into a newly created sample file. It allows for the definition of
complete sets of parameters for each type of sample commonly analyzed, so that only a single selection
is required for each new sample file created.

The Method drop-down list displays only those methods applicable to the open sample file type.

CREATE A NEWMETHOD

File > New Method

1. On the Create a Method window, select the Sample Morphology to be used and the Material Type
and Characterization, then click Next.

2. Enter a Degas temperature, then select an Analysis gas from the drop-down list.

3. Select the applicable isotherm collections. The Isotherm Collection options determine the pres-
sures of the data points measured in the analysis. Click Finish to close the wizard and open an
editor for the new method.

4. On the Method tab, if files created using this method are to be saved in a file folder other than the
default, select Use separate sample file folder, then click the Browse icon to select a folder. The
Browse icon is enabled only when Use separate sample file folder is selected. Select the new
folder, then click OK on the Browse for Folder window.
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5. If the file sequence numbers for this method will differ from other methods, select Use separate
sequence number. This option is enabled only when the Use separate sample file folder is selec-
ted.

6. In the Sequence Number text box, specify an optional default alphanumeric file sequence string.
This field must contain a minimum of three numbers. As files are created, this number is incre-
mentally sequenced as a part of the file name.

7. In the Sample file name text box, enter an optional default file name. This information will be
appended to the sequence number as a part of the file name. The $ symbol must remain in this
field.

8. In the Sample field text box, enter a format for the default sample identification. Include the $ sym-
bol to automatically include the contents of the Sequence Number field as part of the sample iden-
tification.

9. Enter default Operator, Submitter, and Bar Code identification information in the respective text
boxes.

The labels for the Sample, Operator, Submitter, and Bar Code fields can be modified by
overwriting the labels. These fields can also be omitted from a sample file by selecting the
Omit checkbox.

10. In the Sample Tube drop-down list, select a sample tube. If the required sample tube does not
appear in the list, click Edit and enter the description and other parameters for this tube. Then go
to File > Save As > Sample Tube to save these values for the next time this sample tube is used.

11. In the Mass group box, indicate if mass is to be manually entered by the operator (Enter) or cal-
culated by the system (Calculate).

Create a New Method

ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015

2 - 15



2 About the Software

12. In the Type of Data group box, indicate if the data is to be automatically collected by the system
or manually entered by the operator.

13. Enter any pertinent information about the sample information file in the Comments text box.

14. Click Add Log Entry to enter notes for the analyzer log report. Create entries that cannot be
recorded automatically through the software.

15. To auto-populate fields from another .SMP file, click Replace All, then select a .SMP file that
contains the preferred parameters. Select the file, then click Load.

16. Click Save As. Select Methods in the library and enter a file name for the method in the File
name text box.

17. Click Save.

EDIT THE DEFAULT METHOD

Options > Default Method

See Create a New Method on page 2 - 14.

EDIT A METHOD

File > Open > [Method]

1. In the File Selector, select a .MTH file and click Open.

2. On the Method tab, if files created using this method are to be saved in a file folder other than the
default, select Use separate sample file folder, then click the Browse icon to select a folder. The

2 - 16 ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015



Browse icon is enabled only when Use separate sample file folder is selected. Select the new
folder, then click OK on the Browse for Folder window.

3. If the file sequence numbers for this method will differ from other methods, select Use separate
sequence number. This option is enabled only when the Use separate sample file folder is selec-
ted.

4. In the Sequence Number text box, specify an optional default alphanumeric file sequence string.
This field must contain a minimum of three numbers. As files are created, this number is incre-
mentally sequenced as a part of the file name.

5. In the Sample file name text box, enter an optional default file name. This information will be
appended to the sequence number as a part of the file name. The $ symbol must remain in this
field.

6. In the Sample field text box, enter a format for the default sample identification. Include the $
symbol to automatically include the contents of the Sequence Number field as part of the sample
identification.

7. Enter default Operator, Submitter, and Bar Code identification information in the respective text
boxes.

The labels for the Sample, Operator, Submitter, and Bar Code fields can be modified by
overwriting the labels. These fields can also be omitted from a sample file by selecting the
Omit checkbox.

8. In the Sample Tube drop-down list, select a sample tube. If the required sample tube does not
appear in the list, click Edit and enter the description and other parameters for this tube. Then go
to File > Save As > Sample Tube to save these values for the next time this sample tube is used.

9. In the Mass group box, indicate if mass is to be manually entered by the operator (Enter) or cal-
culated by the system (Calculate).

10. In the Type of Data group box, indicate if the data is to be automatically collected by the system
or manually entered by the operator.

11. The optional user-defined fields in the User Parameters group box may be used to enter and track
information from another analyzer or source, along with other statistical process control (SPC)
data.

12. Use the Comments text box to enter notes about the Method.

13. After completing the Sample Description tab select the parameter tabs across the top portion of
the window to edit other sample information file parameters. The saved parameter settings
become the defaults for new sample files when this method is selected.

14. Click Save, then click Close.

Edit a Method
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2 About the Software

CONFIGURE THE ANALYZER

SPECIFY GAS PORTS

Unit [n] > Unit Configuration

Use to display hardware / software configurations, calibrations, and gas selections of the connected
analyzer.

The analyzer has gas inlets for up to six analysis gases. The gases connected to the inlets must be
specified in the analysis program. If the gas is changed on one of the inlets, the same change must be
made on the Unit Configuration window. The analysis software must be updated when gases change.

1. Click Gas.

2. Use the drop-down arrows to specify the type of gas installed on each port.

3. Click OK to close the window and save the changes.
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Field or Button Description
Calibration group boxes Displays calibration information for analyzer components.
Configuration group box Displays the IP address used by the analysis program and the serial

number of the selected analyzer.

l Change IP. Click to display the Unit IP Setup window. The IP address
and subnet mask assigned during installation display. Do not edit these
fields unless instructed by a Micromeritics service representative.

l Board ID. Click to display information from the electronic circuit
boards in the instrument.. These parameters cannot be edited.

Features group box Displays options installed on the analyzer.
Gas button Displays ports for gas selections.
Software Versions group
box

Displays the software versions of the MIC BIOS, controller, and analysis
program.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Unit Configuration Fields and Buttons Table

SPECIFY UNIT SELECTIONS

Options > Units

Use to specify how data should appear on the application windows and reports. This menu option is not
available if using Restricted option presentation.

Specify Unit Selections
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2 About the Software

ANALYZER STATUS

SHOW INSTRUMENT SCHEMATIC

Unit [n] > Show Instrument Schematic

Use to display an analyzer schematic. To operate the valves and elevator from this window, manual
control must be enabled (Unit [n] > Enable Manual Control).

Icon or Symbol Description
Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve. When manual control is disabled,
closed valves appear white.

Elevator.

Sample Tube. Cannot be manually controlled.

Analyzer Schematic Icon Table
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Valve Description
1 Unrestricted vacuum
2 Restricted vacuum
3 Helium inlet port valve
4 Restricted analysis gas
5 Unrestricted analysis gas
7 Lower manifold isolation
9 Sample port
10 Restricted Psat tube port
11 Unrestricted Psat tube port
P1 through P6 Gas inlet port valves
PS Supply valve for physisorption gases
PV Vacuum valve for physisorption gases

Analysis Valve Descriptions

Instrument Schematic Shortcut Menus

Each manually controlled schematic component has a shortcut menu displaying the operations available
for that particular component. To access the shortcut menu, hover the mouse pointer over the component
and right click.

Schematic Shortcut Icon Available Options:
Valve options l Close. Closes the selected valve.

l Open. Opens the selected valve.

l Pulse. Use to quickly turn the valve on and off allowing the operation
to proceed in small increments.

Elevator options l Raise. Select Raise to raise the elevator. When it is moving, press the
keyboard space bar to stop the movement (or right click and select
Stop from the menu).

l Lower. Select Lower and press the keyboard space bar to lower the
elevator.

l Stop. Stops the elevator from moving.

Schematic Shortcuts Table

Show Instrument Schematic
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SHOW STATUS

Unit [n] > Show Status

Use to show the current status for each port.

If multiple units are attached to the computer, select Show Status on each Unit [n] menu. The status for
all units display.

SHOW INSTRUMENT LOG

Unit [n] > Show Instrument Log

Use to display a log of recent analyses, calibrations, errors, or messages.

Field Description
Analysis /
Calibration /
Message

Select the logs to display.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Instrument Log Fields and Buttons Table
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EXPORT FILES

File > Export

Provides the option to print the contents of one or more sample files to either the screen, a printer, or to a
file. data can be exported as a .PDF, .REP, .TXT, or .XLS file format. The type of data to include or
exclude can be selected during the export process. When exported to a file, the data can be imported into
other software that read .TXT or .XLS file formats.

1. Select one or more files from the library. To select more than one file, hold down the Ctrl key on
the keyboard while selecting the files, or hold down the Shift key to select a range of files.

2. Click Export.

3. In the Export Options window, select the type of data to include in the export file.

Types of data that can be included:

l Options
o Target pressures

l Quantity adsorbed versus relative pressure

l Quantity dosed, absolute pressure, elapsed time, free space, Psat measurements

l Sample log

l Labels

4. Specify the export destination in the Destination section.

l Preview. Previews the predefined report on the screen.

l Print. Sends the report to the default printer.

l Copies. Select the number of copies to print. This field is only enabled when Print is
selected.

Export Files
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2 About the Software

l File. Select the destination directory. Enter a new file name in the File name field, or
accept the default. Select to save the file as a report system (.REP), a spreadsheet
(.XLS), a portable document format (.PDF), or an ASCII text (.TXT) file format.

5. Click OK.
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LIST FILES

File > List

Provides the option to create a list of sample file information, for example, file name, date, time the file
was created or last edited, file identification, and file status.

The selections in your application may differ slightly from what is displayed on this page
however the instructions are the same.

1. Select one or more files from the library. To select more than one file, hold down the Ctrl key on
the keyboard while selecting the files, or hold down the Shift key to select a range of files.

2. Click List.

3. In the Report Settings window, select one of the following:

l Preview. Previews the predefined report on the screen.

l Print. Sends the report to the default printer.

l Copies. Select the number of copies to print. This field is only enabled when Print is
selected.

l File. Select the destination directory. Enter a new file name in the File name field, or
accept the default. Select to save the file as a report system (.REP), a spreadsheet
(.XLS), a portable document format (.PDF), or an ASCII text (.TXT) file format.

4. Click OK.

List Files
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3 ABOUT SAMPLE FILES
Sample files include the information required by the analyzer to perform analyses and collect data. A
sample file identifies the sample, guides the analysis, and specifies report options and may be displayed
in either Advanced, Basic, or Restricted presentation display mode.

A sample information file consists of parameter sets; however, parameter sets can also stand alone. A
sample information file may be created either prior to or at the time of analysis.

Parameter files allow for repeated use of parameter sets. For example, if the same analysis conditions
exist for multiple analyses, an Analysis Conditions file containing the recurring conditions can be
created. When the sample file is created, the Analysis Conditions file can be selected for the analysis
conditions. Once it becomes part of the new sample file, the new file can be edited as needed without
affecting the original Analysis Conditions file.

The analysis software contains a default method. A method is a template for sample files that contains
the parameters to be used for an analysis. When a new sample information file is created, all the
parameters are filled with the values in the default method..

Specify or change the default option presentation by selecting Options > Option Present-
ation, or select Basic or Advanced from the drop-down list at the bottom of the window.

CREATE SAMPLE FILES IN ADVANCED OPTION PRESENTATION
Each analysis must be linked with a sample information file before the analysis can proceed. A sample
information file can consist of parameter files; however, parameter files can also stand alone.

Specify or change the default display option by selecting Options > Option Presentation or select Basic
or Advanced from the drop-down list at the bottom of the window.

The values specified in the parameter portions of the default method are the defaults for new sample
files. To navigate from one set of parameters to another, select the parameter tab across the top of the
window.

l Sample Tube parameters are edited on the Sample Description tab

l Adsorptive Properties are edited on the Analysis Conditions tab

1. Go to Options > Option Presentation > Advanced and ensure Advanced has a checkmark.

2. To create a new sample file, go to File > New Sample, or to open a sample file go to File > Open
and select a sample file.

3. Select a method from the Method drop-down list.

3 About Sample Files

ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015

3 - 1



3 About Sample Files

4. Enter a sample description in the Sample text box.

5. Enter Operator, Submitter, and Bar Code identification information in the respective text boxes.
Some fields may not display (or may have a different field label) if modified in the method from
which the sample file was created, either through Options > Default Method or File > Open >
Method.

6. In the Sample Tube drop-down list, select a sample tube. If the required sample tube does not
appear in the list, click Edit and enter the description and other parameters for this tube. Then go
to File > Save As > Sample Tube to save these values for the next time this sample tube is used.

7. In the Mass group box, indicate if mass is to be manually entered by the operator (Enter) or cal-
culated by the system (Calculate).
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Field or Button Description
Comments Enter comments about the sample or analysis. Comments display in the

report header.
Mass group box If mass = 1, the reported surface area equals the total surface area but it

is always shown as m2/g. If the actual mass is entered, the surface area
is reported as m2/g. Choose whether to enter mass manually or have the
system automatically calculate mass. Enter a value for sample mass.
Mass can be changed any time before, during, or after analysis.

l Enter. Enables the Sample Mass field. Enter a value for the sample
mass.

l Calculate. Enables the Empty tube and Sample + tube fields. Enter the
values necessary to calculate the sample mass. Equation used to cal-
culate sample mass:

Masssample = Masssample+tube – Masstube

l DensityValue is used for the calculated free space method only. Use
0.000 for a blank analysis.

Method Select a method from the drop-down list. See Methods on page 2 - 14.
Operator Enter operator identification information. This field label may have been

renamed or may not display if modified in Options > Default Methods.
Sample Enter a sample description.
Sample Tube Select a sample tube file from the drop-down list, or click Edit to modify

or create a new Sample Tube file. See Sample Tube on page 4 - 1.
Submitter Enter submitter identification information. This text box may have been

renamed or may not display if modified in Options > Default Methods.

Sample File Fields and Buttons Table

Create Sample Files in Advanced Option Presentation
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Field or Button Description
Type of Data group box Automatically collected. Select if the type of data will be automatically

collected by the system while an analysis is running.Manually entered.
Use to enter data manually that was collected from another source. If
Manually entered is selected, the Isotherm Report becomes available in
the Basic/Advanced drop-down list for pasting or importing data into the
file.

See Manually Enter Data on page 3 - 8.
User Parameters group
box

These fields are primarily used for the SPC (Statistical Process Control)
reporting to specify sample characteristics or its manufacturing process
but may be used for other data by entering specific analysis conditions or
sample criteria.

The entered parameters display on the Summary Report. Some fields may
not display (or may have a different field label) if modified in the method
from which the sample file was created, either through Options > Default
Method or File > Open > Method.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Sample File Fields and Buttons Table (continued)
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CREATE SAMPLE FILES IN BASIC OPTION PRESENTATION
The Basic and Restricted formats use predefined parameter files to create a sample information file.

When using the Basic option presentation, switch to Advanced to edit parameter file values.
When using the Restricted option presentation, parameter files cannot be edited.

1. Go to Options > Option Presentation > Basic (or Restricted).

2. To create a new sample file, go to File > New Sample, or go to File > Open and select a sample
file.

3. Select a method from the Method drop-down list. See Methods on page 2 - 14.

4. In the Sample field, enter a sample description.

5. Select a sample tube from the Sample Tube drop-down list.

6. In the Mass group box, indicate if mass is to be manually entered by the operator (Enter) or cal-
culated by the system (Calculate).

7. Click the down arrows to select default parameter files for Degas conditions, Analysis conditions,
and Report options. The Degas Conditions option will not display if it has not been enabled in
Options > Option Presentation> Show Degas Conditions.

Create Sample Files in Basic Option Presentation
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3 About Sample Files

8. To auto-populate fields from another .SMP file, click Replace All and select a .SMP file that con-
tains the necessary parameters. Select the file and click Replace.

9. Click Add Log Entry to enter notes for the analyzer log report. Create entries that cannot be
recorded automatically through the software, for example, when the port filter was changed.

10. Click Save, then click Close. The file can be retrieved later from the Sample Information folder in
the library.

CREATE SAMPLE FILES IN RESTRICTED OPTION PRESENTATION
The instructions for creating a sample file using the Restricted option presentation are the same as the
Basic option presentation.
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OPEN A SAMPLE FILE

File > Open > [.SMP File]

l When working with an existing file, it is recommended that a copy of the file be used
rather than the original.

l Columns on the File Selector window can be sorted by clicking the column header. To
sort the file list by status, click the Mic Status column header.

1. Go to File > Open.

2. From the Sample Information library folder, select a .SMP file:

File Status Displays
No Analysis Tabbed file editor
Complete
Analyzing
Entered

MicroActive report window

Open a Sample File
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3 About Sample Files

MANUALLY ENTER DATA

The images shown in this section may differ slightly from yours. However, the process is
the same unless otherwise noted.

This process allows the manual entry of pressure data from a sample file with a Complete status. There
are two methods for manually entering data into a sample file:

l Copy and paste onto the graph area of the interactive window

l Import data into the interactive window

COPY AND PASTE MANUALLY ENTERED DATA

1. Go to File > Open [.SMP file], then select the sample information file with a Complete status that
contains the data to be copied and pasted.

2. Click Open. The file will open to the interactive reports window.

3. Right click in the graph area of the interactive reports window, then select Copy Data. This will
copy the data from the active file to the clipboard.

4. Go to File > New Sample, then open a new sample information file. To save the file as a new file
name, go to File > Save As, then enter a new file name in the File name text box.

5. On the Sample Description tab, select Manually entered in the Type of Data group box.

6. Click the Advanced down arrow at the bottom of the window, then select Isotherm.

7. Resize the interactive window to display the Paste button.
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8. Ensure that all parameter fields are set appropriately, then click Paste. The data from the original
sample file is pasted from the clipboard and displays in the new sample file.

Copy and Paste Manually Entered Data
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3 About Sample Files

IMPORT MANUALLY ENTERED DATA

When importing data from an external ASCII text file using the Import button on the interactive
window, the ASCII text file must use the following rules:

l Data must be in two columns and separated by a comma or white-space.

l Acceptable column headings are:
o Relative Pressure
o Absolute Pressure (mmHg)
o Absolute Pressure (kPa)
o Absolute Pressure (mBar)
o Quantity Adsorbed (mmol/g)
o Quantity Adsorbed (cm³/g STP)
o Quantity Adsorbed (cm3/g STP)

ASCII text file format rules

Sample Physisorption ASCII Text File

Silica Alumina : Adsorption
Relative Pressure Quantity Adsorbed (cm3/g STP)
0.108629 50.6657
0.22288 60.7813
0.339909 71.3095
0.459512 84.4172
0.577447 102.672
0.654583 121.707
0.760074 179.096
0.855713 334.565
0.958511 394.675
0.996251 403.793

Silica Alumina : Desorption
Relative Pressure Quantity Adsorbed (cm3/g STP)
0.996251 403.793
0.86016 389.626
0.753567 256.264
0.664418 133.099
0.542416 96.7366
0.422295 79.7351
0.346371 71.5994
0.2519 62.8256
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0.152718 54.2336
0.103389 49.5803

To import the ASCII text file:

1. Go to File > New Sample, then open a new sample information file. To save the file as a new file
name, go to File > Save As, then enter a new file name in the File name text box.

2. Click the down arrow at the bottom of the window and select Advanced.

3. On the Sample Description tab, select Manually entered in the Type of Data group box.

4. Click the Advanced down arrow at the bottom of the window, then select Isotherm.

5. If necessary, resize the interactive window until the Import button displays.

6. Ensure that all parameter fields are set appropriately, then click Import.

7. On the File Selector window, locate and select the .TXT file, then click Open. The data from the
original sample file is imported and displayed in the isotherm graphs. If an error message appears
instead, verify that the .TXT file format is correct.

Import Manually Entered Data
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4 ABOUT PARAMETER FILES
Parameter files allow for repeated use of parameter sets. For example, if the same analysis conditions
exist for multiple analyses, an Analysis Conditions file containing the recurring conditions can be
created. When the sample file is created, the Analysis Conditions file can be selected for the analysis
conditions. Once it becomes part of the new sample file, the new file can be edited as needed without
affecting the original Analysis Conditions file.

The following file types can exist as part of the sample information file as well as individual parameter
files:

File Type File Extension
Adsorptive Properties .ADP
Analysis Conditions .ANC
Degas Conditions .DEG
Report Options .RPO
Sample Tube .STB

Predefined parameter files are included with the program and can be edited as needed or new parameter
files can be created.

SAMPLE TUBE

File > Open > [.STB File]

(or click Edit next to the Sample Tube selection on the Sample Description tab when in Advanced option
presentation )

Sample Tube files specify information about the sample tube.

1. Go to File > Open.

l Select the appropriate library folder for the parameter file type, then select a file name
in the list or enter it in the File Name field, then click Open, or

l Select the appropriate file type from the drop-down list on the lower right portion of the
window, then select a file name in the list or enter it in the File Name field, then click
Open.

2. Enter a description of the sample tube in the Sample Tube field. This description will be available
as a selection in the Sample tube drop-down list on the Sample Description tab.

4 About Parameter Files
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4 About Parameter Files

3. In the Empty Tube Properties group box, enter the warm free space and the cold free space.

4. Indicate if an isothermal jacket and / or filler rod will be used by selecting Use isothermal jacket
and / or User filler rod. An isothermal jacket should always be used with the analyzer. Filler rods
help to ensure accuracy in samples with lower total surface areas by reducing the free-space
volume. It is generally a good practice to use filler rods for samples having less than 100 square
meters of total surface area. Filler rods are unnecessary for samples with total surface areas
greater than 100 square meters.

5. Select the vacuum seal type to be used.

6. Click Save, then click Close.

Field or Button Description
Cold free space Empty sample tube gas capacity measured with the dewar raised.
Load from Sample File Loads parameters from the selected sample file.
Non-ideality factor Compensates for the forces of attraction between molecules in a real gas.

This value is used for a calculated free space.
Sample Tube It is a good practice to label each sample tube with a unique

identification. Enter that information here. This information will also
appear in the Sample Tube drop-down list on the Sample Description tab.

Use filler rod Select if a filler rod is to be used in the sample tube. A filler rod reduces
the stem free-space volume resulting in reduction of free-space error.

Use isothermal jacket Select if an isothermal jacket is to be used. An isothermal jacket
maintains a constant temperature profile along the sample tube stem
during an extended analysis of more than 1 or 2 hours.

Vacuum seal type Select the seal type to be used.
Warm free space Empty sample tube gas capacity measured at room temperature.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Sample Tube Fields and Buttons Table
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DEGAS CONDITIONS

File > Open > [.DEG File]

(or click the Degas Conditions tab when in Advanced option presentation)

Degassing is a required step in preparation for an analysis. The Degas Conditions tab provides settings
that will be automatically applied during the degassing procedure.

1. Go to File > Open.

l Select the appropriate library folder for the parameter file type, then select a file name
in the list or enter it in the File Name field, then click Open, or

l Select the appropriate file type from the drop-down list on the lower right portion of the
window, then select a file name in the list or enter it in the File Name field, then click
Open.

2. To overwrite degas conditions with parameters from another Degas Conditions file, click the
Degas Conditions down arrow, then select a file from the list. Alternatively, click Browse and loc-
ate the file.

3. Complete the fields using the following table.

4. Click Save, then click Close.

Degas Conditions
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4 About Parameter Files

ANALYSIS CONDITIONS

File > Open > [.ANC File]

(or click the Analysis Conditions tab when in Advanced option presentation)

Analysis conditions specify the data used to guide an analysis.

1. Go to File > Open.

l Select the appropriate library folder for the parameter file type, then select a file name
in the list or enter it in the File Name field, then click Open, or

l Select the appropriate file type from the drop-down list on the lower right portion of the
window, then select a file name in the list or enter it in the File Name field, then click
Open.

2. To overwrite analysis conditions with parameters from another Analysis Conditions file, on the
Analysis Conditions tab, click the Analysis Conditions down arrow and select a file from the list.
Alternatively, click Browse and locate the file.

3. To overwrite adsorptive properties with parameters from another Adsorptive Properties file, click
the Adsorptive down arrow and select a file from the list. Alternatively, click Browse and locate
the file. See Adsorptive Properties on page 4 - 13.

4. Enable Absolute pressure dosing to specify pressure targets in mmHg, mbar, or kPa rather than rel-
ative pressure. This option is typically selected when using adsorptives at analysis conditions
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above the critical point of the gas; for example, H2 adsorption on carbon at liquid nitrogen tem-
perature.

5. Use the following buttons to specify:

Button Use to Specify...
Backfill Provides options to backfill sample tube after analysis.
Dosing Options for dosing tolerance, low pressure dosing, and dosing near

saturation pressure.
Equilibration Provides options to specify the equilibration interval and delay time.
Free Space How the free space is to be measured.
P0 and T How the saturation pressure (P0) is to be measured or calculated and the

analysis bath temperature.
Preparation Evacuation rate / time / level, leak test and time values, elevator prompts,

and in situ degassing or activation.

Analysis Conditions Buttons Table

6. Click Save, then click Close.

Field or Button Description
Absolute pressure dos-
ing

Specifies pressure targets in mmHg, mbar, or kPa instead of relative
pressure. If this option is selected, the Relative Pressure labels and entries
change to Absolute Pressure in the selected pressure units.

Adsorptive Select an Adsorptive Properties file from the drop-down list.
Analysis Conditions Use to browse for a .ANC file that contains analysis condition parameters

to be used in the analysis.
Backfill Select gas for backfilling the sample tube at the start and end of an analysis.

The options are disabled if the file status is Entered, Complete, or
Analyzing.

Analysis Conditions Fields and Buttons Table

Analysis Conditions

ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015

4 - 5



4 About Parameter Files

Field or Button Description
Dosing l Absolute / Relative pressure tolerance.Values used to determine how

close the actual pressure must be to each target pressure from the pres-
sure table. At lower pressures, the relative tolerance value is lower. At
higher pressures, the absolute tolerance value is lower. For example:

Experiment 1. There might be an absolute tolerance of 5 mmHg, a
relative tolerance of 5%, and a target pressure of 40 mmHg; 5% of 40
mmHg is 2 mmHg. Since 2 mmHg (relative tolerance) is lower than 5
mmHg (absolute tolerance), 2 mmHg is used. Therefore a minimum
pressure of 38 mmHg (40 - 2) must be attained to collect data for a target
pressure of 40 mmHg.

Experiment 2. There might be an absolute tolerance of 5 mmHg, a
relative tolerance of 5%, and a target pressure of 200 mmHg; 5% of 200
mmHg is 10 mmHg. Since 5 mmHg (absolute tolerance) is lower than 10
mmHg (relative tolerance), 5 mmHg is used. Therefore a minimum
pressure of 195 mmHg (200 - 5) must be attained to collect data for a
target pressure of 200 mmHg.

Normally, surface area measurement points are widely spaced and the
resulting measurement is not very sensitive to the precise location of
points so wider tolerances may be used. Unnecessarily tight tolerances
lengthen the analysis.

l First pressure fixed dose.

This option is most frequently used when performing a standard nitrogen
analysis of mesoporous materials such as catalysts. If the first pressure
table point is low and the gas uptake of the sample is expected to be
high, this option can shorten the time required to reach the first point on
the pressure table.

The sample is dosed repeatedly at low pressures with a specified amount
of gas until the first pressure point is reached. This initial dosing quickly
meets the adsorptive demand of the sample.

The first point on the pressure table is the threshold value, triggering the
transition from the Fixed Dose Mode to Pressure Table Mode. When the
first pressure table value is reached, Fixed Dose Mode is disabled, and
points are equilibrated and recorded in accordance with the specified
pressure table.

In the text box, enter the amount of gas to be added to the sample for
each dose cycle.

Analysis Conditions Fields and Buttons Table (continued)
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Field or Button Description
l Low Pressure incremental dose mode.

Select when performing an analysis of microporous materials. At low
pressures on Type 1 isotherms,the pressure points are very closely
spaced, making a useful pressure table difficult to define. When enabled,
equilibrium points are measured at approximately equal intervals on the
quantity adsorbed axis. Each dose is fully equilibrated and recorded as a
data point.

In this mode, the sample is successively dosed with a specified amount
of gas until the first pressure point is reached. The first point is the
threshold value, triggering the transition from Incremental Dose Mode to
Pressure Table Mode. When the first pressure table value is reached,
Incremental Dose Mode is disabled, and points are recorded in
accordance with the specified pressure table. Because the data points
recorded during Incremental Dose Mode may define most of the
analysis, one point on the pressure table can be sufficient and serve as
the end point for the analysis.

l Maximum volume increment.Select to determine when additional data
points are collected between target pressures in regions of adsorption.
When the maximum increment has been adsorbed since the last collected
data point, another point is equilibrated and collected. During desorption,
this field is treated as a maximum volume decrement value.

Equilibration Provides a table for entering relative pressures and equilibration intervals.

l Equilibration interval. The number of seconds between successive pres-
sure readings during equilibration. Long equilibration intervals tend to

Analysis Conditions Fields and Buttons Table (continued)

Analysis Conditions
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4 About Parameter Files

Field or Button Description
lengthen analyses, however, they do improve data integrity. Short equi-
libration intervals produce a faster analysis but may reduce the accuracy
of data.

l Minimum equilibration delay at p/po > = 0.995. The minimum number
of seconds required before equilibration can occur for a relative pressure
greater than or equal to 0.995. This field is not available if Absolute pres-
sure dosing is selected on the Analysis Conditions tab.

Free Space Use to enter the free space measurement type.

l Measure

Lower dewar for evacuation. If the dewar is to be lowered for
evacuation, select this options and enter the length of time for evacuation
after the free-space measurement in the Evacuation time field.

Evacuation time. The length of evacuation time prior to free space
measurement.

Outgas test. Checks for system leaks or sample outgassing. After free
space is measured, the dewar is lowered and the sample evacuated for
the specified amount of time. The leak test is performed after
evacuation. If a leak is found, the leak test repeats nine times, with 30
minutes evacuation between tests. If the 10th leak check fails, the

Analysis Conditions Fields and Buttons Table (continued)
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Field or Button Description
analysis stops and the operator is notified. While leak testing slightly
increases analysis time, it prevents the continuation of analysis and
collection of erroneous data if a leak occurs.

l Enter. Allows manual entry of warm free space and cold free space.

l Calculate. Use to have the free space measurement calculated using the
sample and tube parameters.

Insert Range To insert an absolute pressure range, select Absolute pressure
dosing on the Analysis Conditions window.

Click to display the Insert Pressure Range window for entering parameters
for the system to autofill the Up to column with starting pressure, ending
pressure, the number of points to insert within the specified range and
whether to have linear or geometric progression.

l Ending relative pressure.The last pressure added to the table.

l Geometric from low pressure.Added pressure points will be spaced
farther apart as the pressures get higher.

l Geometric towards saturation.Added pressure points will be spaced
closer together as the pressures get higher (closer to saturation).

l Linear.Inserts evenly spaced points into the table.

l Number of points.Number of points to be taken between the specified
starting and ending relative pressures.

l Starting relative pressure.The first pressure added to the table.
P0 and Temperature
Options

Use to select options for obtaining the saturation pressure (P0) and analysis
bath temperature.

Analysis Conditions Fields and Buttons Table (continued)
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4 About Parameter Files

Field or Button Description

l Analysis Temperature Options.Select an option to enter analysis tem-
perature manually, or choose to have it automatically calculated from p°
or P0.

l p° Options.Select one option indicating how P0 is to be measured or cal-
culated.

l Psat Gas.If choosing to measure the P0 for each isotherm point using a
gas other than the adsorptive, select the P0 gas from the drop-down list..

Preparation Use to enter analysis preparation details.

Analysis Conditions Fields and Buttons Table (continued)
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Field or Button Description

l Evacuation time.The length of time for preliminary evacuation.

l Fast evacuation. Select for samples (such as pellets) that do not fluidize
or shed particles during evacuation.

l Unrestricted evac. from. The pressure at which unrestricted evacuation
is to begin.

l Leak test.Enables the system to check for leaks or sample outgassing
before the analysis. The leak test allows sample pressure to rise during
the test. If the pressure rises more than 0.15 mmHg, the analysis does not
proceed and the operator is notified. While leak testing slightly increases
analysis time, it prevents the continuation of analysis and collection of
erroneous data if a leak exists.

l Use TranSeal.Select if using the TranSeal to transfer the sample from
the preparation port to the analysis port under vacuum.

l Vacuum setpoint.The vacuum level to be achieved before timed evac-
uation begins.

Analysis Conditions Fields and Buttons Table (continued)

Analysis Conditions
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4 About Parameter Files

Field or Button Description

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Analysis Conditions Fields and Buttons Table (continued)
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ADSORPTIVE PROPERTIES

File > Open > [.ADP File]

(or click the Analysis Conditions tab when in Advanced option presentation)

(or click Edit next to the Adsorptive selection on the Analysis Conditions tab when in Advanced option
presentation )

Adsorptive properties provide the adsorptive (analysis gas) characteristics for the analysis.

1. Go to File > Open.

l Select the appropriate library folder for the parameter file type, then select a file name
in the list or enter it in the File Name field, then click Open, or

l Select the appropriate file type from the drop-down list on the lower right portion of the
window, then select a file name in the list or enter it in the File Name field, then click
Open.

2. Enter a description of the adsorptive in the Adsorptive text box (for example, the gas and the tem-
perature). When saved, this description will display in the Adsorptive drop-down list of the Ana-
lysis Conditions window.

3. Enter the mnemonic for the adsorptive gas (for example, N2) in the Mnemonic text box. If this gas
is connected to a gas inlet port, this mnemonic must be entered in the Gas Configuration for the
inlet port. See Specify Gas Ports on page 12 - 5.

Adsorptive Properties
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4 About Parameter Files

4. Adsorbed molecules occupy volume in the sample tube, reducing the cold free space. Select the
High-resolution fluid properties > Adsorbed-phase free-space correction option to adjust the repor-
ted quantity adsorbed to correct for this effect. This option is appropriate for all sample analyses
that use the real gas equation of state.

5. To import parameters from a Fluid Properties file, click Open, locate and select the .FPI file con-
taining the new parameters, then click Open. Click Save to save the changes. Changing fluid prop-
erties should only be necessary if an adsorptive is to be used for which no adsorptive properties
are provided or at an analysis temperature not covered by the standard properties. Contact Micro-
meritics Scientific Services if new fluid properties are required (http://tech-
support.micromeritics.com/portal)

6. In the Dosing Method group box, select the source to dose the adsorptive.

7. Click OK, then click Close.

Field or Button Description
Adsorbate molecular
weight

The molecular mass is used for the weight % column of the isotherm
tabular report and for the pressure composition isotherm plot.

Adsorbed phase free-
space correction

Adsorbed molecules occupy volume in the sample tube, reducing the cold
free space. Select the Adsorbed-phase free-space correction checkbox to
adjust the reported quantity adsorbed to correct for this effect. This option
is appropriate for all sample analyses that use the real gas equation of
state.

Adsorptive Name of the adsorptive gas whose properties are being defined.
Density Conversion
Factor

Factor determined by obtaining the ratio of the gas density (STP) to the
liquid volume. This field is disabled if Non-condensing Adsorptive is
selected.

Dosing Method l Normal. Dose from a pressurized tank of gas attached to a gas inlet
port.

l From Psat tube. Select if the Psat tube is to be filled with condensed
adsorptive and dosed from the Psat tube. Select this option if using
Krypton.

High-resolution fluid prop-
erties

Use to import parameters from a Fluid Properties file. Click Open to
browse and select a .FPI file. Locate and select the file, then click Open
on the file selector window. Click Save to save the changes made from
the importing selected the .FPI file. Changing fluid properties should only
be necessary if an adsorptive is to be used for which no adsorptive
properties are provided.

Ideal gas law with non-
ideality correction

Use if there is no compressibility table for the gas being used or if you
want to match existing data. This factor adjusts the ideal gas law for
calculating the quantity of gas in the cold free space. Most gases are
nearly ideal near room temperature and at pressures not much above
atmospheric pressure, so the cold free space is where the correction is

Adsorptive Properties Fields and Buttons Table
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Field or Button Description
most important. If selected, enter the non-ideality factor field.

Maximum manifold pres-
sure

The highest pressure to which the manifold will be dosed. To avoid
damage to the analyzer, this number is limited to 925 mmHg. Low
pressure sources will require lower numbers. For gases to be used for
dosing after charging a tube from a gas inlet, enter the maximum pressure
for dosing from the inlet, not from the tube of condensate.

Mnemonic Enter the mnemonic name for the adsorptive. If this gas is connected to a
gas inlet port, this mnemonic must be entered in the Unit Configuration
Gas Selection for the inlet port. See Specify Gas Ports on page 12 - 5.

Molecular cross-sectional
area

The area that a single adsorbed molecule occupies on the surface of the
sample. It is used in surface area calculations.

Non-condensing Adsorpt-
ive

Select if using a non-condensing analysis gas.

Psat and T Click to edit the Psat vs Temperature table. The table contains saturation
pressures and their corresponding temperatures. To edit, click in a field
and enter the value.

Therm. tran. hard-sphere
diameter

An estimate of molecular size used in calculating the thermal
transpiration correction.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Adsorptive Properties Fields and Buttons Table (continued)
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ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015

4 - 15



4 About Parameter Files

REPORT OPTIONS

File > Open > [.RPO File]

(or click the Report Options tab when in Advanced option presentation)

Use to specify report options for data collected from an analysis or manually entered data. Report
Options files also help in customizing report details such as axis scale, axis range, column headings, and
components of thickness curve equations. These files may contain tabular reports, plots, or both, as well
as advanced report tables.

Customized report options files can be created then loaded into a sample file, allowing quick generation
of reports.

Report Options files may be defined to include overlay options. This system allows the overlay of up to
25 plots of different samples onto a plot of the same type or overlay one plot type onto a different plot
type from the same analysis. See Graph and Sample Overlays on page 7 - 29.

1. Go to File > Open.

l Select the appropriate library folder for the parameter file type, then select a file name
in the list or enter it in the File Name field, then click Open, or

l Select the appropriate file type from the drop-down list on the lower right portion of the
window, then select a file name in the list or enter it in the File Name field, then click
Open.
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2. To overwrite report options with parameters from another Report Options file, on the Report
Options tab, click the Report Options down arrow, then select a file from the list. Alternatively,
click Browse and locate the file.

3. [Optional] To have a report title display on the report header, select Show report title, then enter a
title to appear on the report header.

4. [Optional] To have a graphic display on the report header, select Show graphic to insert a graphic
in the report header. Click Browse to locate a .BMP or a .EMF file. Specify the graphic size in
the Height andWidth text fields.

5. The Selected Reports list box displays the reports that may be generated.

l Select checkboxes to the left of the reports to include in this file.

l To specify report options, highlight the report in the Selected Reports list box, then click
Edit. Make changes as necessary. Click OK.

8. Click Save, then click Close.

Field or Button Description
Apply thermal tran-
spiration correction

Use to correct the temperature-induced pressure difference between the
manifold and the chilled sample tube. This option is most significant for
pressures less than approximately 1.0 mmHg.

Always use thermal transpiration when performing micropore analyses.
See Thermal Transpiration Correction on page B - 44.

l Inside diameter of sample tube. Enabled when Apply thermal tran-
spiration correction is selected. Enter the inside diameter of the
sample tube used in the analysis.

Overlays See Graph and Sample Overlays on page 7 - 29.
Report Options drop-down
list

Browse for a .RPO file that contains report options parameters to be
used in the report.

Selected Reports list box Select the report names to include in the report.
Show graphic Use to show a graphic on the report header. Click Browse to locate the

graphic.

l Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title Select and enter a report title to appear on the report header.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Report Options Fields and Buttons Table
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5 ABOUT DEGASSING
Most solid materials absorb moisture and other contaminants when exposed to the atmosphere. The
sample must be clean when an analysis is performed. The degas process heats the sample with an inert
gas flowing over it to remove the moisture and contaminants.

DEGAS ON THE SMARTPREP

Unit [n] > Degas

If a SmartPrep is not connected to the analyzer, the Unit [n] > Degas menu options are disabled.

SMARTPREP CONFIGURATION

Unit [n] > Degas > SmartPrep Configuration

Displays the SmartPrep configuration and software versions.

SHOW SMARTPREP STATUS

Unit [n] > Degas > Start SmartPrep Degas

The SmartPrep Status window allows the monitoring of degas operations and to stop the gas flow after
samples are degassed.

5 About Degassing
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5 About Degassing

Field or Button Description
Cancel Discards any changes.
Set Temperature Use to set the temperature of the selected port.
Skip Use to bypass the current stage.
Stop Gas flow Stops the gas flow to the selected port.

Show SmartPrep Status Fields and Buttons Table

START SMARTPREP DEGAS

Unit [n] > Degas > Start SmartPrep Degas

The six SmartPrep heating stations are represented by row numbers on the Automatic Degas window.

5 - 2 ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015



Field or Button Description
Browse Searches for a file. Select a file from the Name column or from the

library, then click Open. Alternatively, double click the file name to open
(or import) the file.

Cancel Discards any changes.
Clear Clears the sample file selection for a port.
Start Starts degassing.

Start SmartPrep Degas Fields and Buttons Table

Start SmartPrep Degas
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5 About Degassing

DEGAS A SAMPLE ON THE ANALYSIS PORT
The characterization of microporous materials may be significantly improved by degassing the sample on
the analysis port before the analysis. To avoid contaminating the analysis system, the sample must be
degassed on an external preparation device such as the SmartPrep immediately before attaching it to the
sample port.

The sample is heated with a MicroPrep heating mantle controller while under vacuum.

The sample will be open to vacuum for more than 6 hours. If a shared vacuum configuration
is used, analyses on the other units may be delayed.

The sample will be open to vacuum for more than 6 hours. If a shared vacuum configuration is used,
analyses on the other units may be delayed.

1. Deselect Backfill sample at start of analysis in the analysis conditions backfill options.

2. Put an isothermal jacket on the sample tube.

3. Install sample tube on analysis port.

4. Carefully slide the isothermal jacket up while supporting the bottom of the tube.

5. Rotate the Psat tube out of the way.

The isothermal jackets on the sample tube and Psat tube may be damaged if they are close to
the heating mantle.

6. Enable manual control.

7. Open valves 2, 7, and 9 to evacuate the sample.

8. Allow sample pressure to reach 10 mmHg then open valve 1.

9. Attach the heating mantle to the sample tube.

10. Set the MicroPrep to 250 °C. Heat for 6 hours.

WHEN DEGASSING IS COMPLETE

1. Turn off the MicroPrep. Do not backfill the sample; leave it under vacuum.

2. Remove the heating mantle.

Be careful, the metal clip and grommets may be hot.
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3. When the tube is cool enough to touch, carefully slide the isothermal jacket down while supporting
the bottom of the tube. Sliding the jacket down while the tube is hot may damage the jacket.

4. Rotate the Psat tube into position next to the sample tube an install the dewar lid.

5. Ensure that valves 1, 2, 7, and 9 are still open and start the analysis.

When degassing is complete
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6 PERFORM AN ANALYSIS

DEWAR PRECAUTIONS

Always handle glass dewars with care. Any product incorporating a vacuum is a potential
safety hazard and should be treated with caution. If in doubt, contact your safety officer.

When handling dewars containing liquefied gases or cryogenic liquids:

l Wear protective equipment:

o goggles or face shield
o an insulated or rubber apron
o insulated gloves

l When pouring liquefied gases from one container to another:

o cool the receiving container gradually to minimize thermal shock
o pour the liquified gas slowly to prevent splashing
o vent the receiving container to the atmosphere

For glass dewars:

l Use a plastic stirring rod when stirring substances in a dewar containing liquefied gases (or other
materials of extremely low temperature). Do not use a glass or metal stirring rod unless it has a
protective coating.

l Do not handle heavy objects above the dewar. If unavoidable, place a protective cover over the dewar
opening. If an object of sufficient weight is accidentally dropped into the dewar, shattering may
occur.

l Do not remove the protective mesh covering. This cover minimizes the risk of flying particles should
the dewar be knocked over, dropped, or broken.

6 Perform an Analysis
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6 Perform an Analysis

PREPARE FOR ANALYSIS
The following steps properly prepare the equipment and instrument for an analysis. It is recommended to
perform the tasks in the following order:

Select a Sample Tube below

Step 1 - Clean and Label Sample Tubes on page 6 - 4

Step 2 - Create the Sample File on page 6 - 6

Step 3 - Determine the Sample Mass on page 6 - 6

Step 4 - Degas the Sample on page 6 - 7

Step 5 - Install the Sample Tube on page 6 - 8

Step 6 - Fill and Install the Dewar on page 6 - 9

SELECT A SAMPLE TUBE

A sample tube set consists of:

l Sample tube

l Stopper or seal frit

l Filler rod

Standard sample tubes for the ASAP 2060 instrument have a 1.27 cm (1/2 in.) outside diameter (OD).
Stepped ferrules, smaller O-rings, isothermal jackets, and filler rods are available for adapting the
smaller stems to the degas or analysis ports. The stem diameter selected for use is a matter of accuracy
and precision requirements, as well as personal preference and convenience in loading the sample.

A rubber stopper may be used with all size sample tubes; however, seal frits are recommended for 1.27
cm (1/2 in.) OD sample tubes.

Filler rods help to ensure accuracy in samples with lower total surface areas by reducing the free-space
volume. It is generally a good practice to use filler rods for samples having less than 100 square meters
of total surface area. Filler rods are unnecessary for samples with total surface areas greater than 100
square meters.

Filler rods can interfere with thermal transpiration correction and, therefore, should not be
used when performing micropore analyses.
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The weight of the empty sample tube should be determined after it has been cleaned, degassed, and
filled with backfill gas. The sample tube should be allowed to cool to room temperature before
backfilling. After the sample tube has cooled, remove it from the degas port and weigh it.

If a seal frit is not used, insert a stopper immediately after removing the sample from the
degas port.

The mass of the isothermal jacket may vary slightly and cannot be considered as constant; therefore, do
not weigh it with the sample tube set.

Select a Sample Tube
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6 Perform an Analysis

STEP 1 - CLEAN AND LABEL SAMPLE TUBES

Sample tubes and filler rods must be clean and dry before samples are added and weighed. The
following table indicates which materials are supplied by Micromeritics and which are supplied by the
user. The procedures following the materials table are recommended.

The equipment shown in this section may differ slightly from yours. However, the process
is the same unless otherwise noted.

Supplied by Micromeritics Supplied by User
l Filler rod

l Funnel

l Sample data worksheet

l Sample tube

l Sample tube brush

l Sample tube rack

l Sample weighing support

l Stopper for sample tube (seal frit, rub-
ber stopper, or TranSeal)

l Acetone or isopropyl alcohol

l Analytical balance

l Detergent (such as Alconox)

l Drying oven

l Forceps

l Insulated gloves

l Pipe cleaners

l Rubber gloves or lint-free cloth

l Safety glasses

l Ultrasonic cleaning unit

l Waste container

1. Preheat drying oven to 110 ºC.

2. Verify that the ultrasonic cleaning unit is clean.

3. Use 5 grams of Alconox (or other suitable detergent) per 500 mL of warm water and fill the ultra-
sonic unit with enough water to cover the sample tubes and filler rods (if used). If too much deter-
gent is used, it may be difficult to rinse from the sample tubes. Ensure the detergent is dissolved
before placing the sample tubes and filler rods into the water.

4. Fill the sample tubes with warm water and place them in the ultrasonic cleaning unit, then place
the filler rods in the unit. Turn on the ultrasonic cleaning unit for approximately fifteen minutes.
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5. Use rubber gloves to ensure no oils or residue are transferred to the clean tubes and filler rods,
then remove the sample tubes and filler rods from the unit.

6. Clean the interior of the sample tubes with the brush supplied with the analyzer.

7. Rinse the sample tubes and filler rods thoroughly with hot water. Rinse again with isopropyl alco-
hol or acetone. If isopropyl alcohol or acetone is not available, deionized water may be used.

8. Stand the sample tubes on the sample tube rack and place the filler rods in a basket or in the rack.
Bake in a vacuum oven for two hours at 110 °C.

Samples tubes can also be cleaned with high purity acetone or isopropyl alcohol and dried
for about 10 minutes under heat. If using this method, continue with step 10.

9. Remove the sample tubes and filler rods from the oven and allow to cool.

Step 1 - Clean and Label Sample Tubes
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6 Perform an Analysis

Do not insert the filler rods at this time. Filler rods are inserted before the sample tube is
installed on the analysis port.

10. Blow out the sample tubes with oil-free compressed air.

11. Rinse the sample tube closure with isopropyl alcohol, then wipe the sample tube closure dry with
a clean, lint-free cloth.

12. Label the sample tube and stopper for identification.

13. Replace the rubber stopper, Check Seal, or TranSeal.

STEP 2 - CREATE THE SAMPLE FILE

l Create Sample Files in Advanced Option Presentation on page 3 - 1

l Create Sample Files in Basic Option Presentation on page 3 - 5

l Create Sample Files in Restricted Option Presentation on page 3 - 6

STEP 3 - DETERMINE THE SAMPLE MASS

See Worksheets on page F - 1.

Clean, dry sample tubes are essential for accurate results. How much sample to use can be determined
best by experiment. In general, a sample providing 40 to 120 square meters of total surface area is
recommended for nitrogen analysis. Less than 40 square meters may cause unreliable results. More than
120 square meters will extend analysis time.

Smaller quantities are required for samples having high surface areas. These samples require careful
weighing after degassing because a small error may represent a considerable percent of total weight.
Proper weighing techniques are most important in this case. Use no less than 100 mg to reduce the effect
of weighing errors.

Care should be taken when loading powders; the accessory funnel is useful for this purpose. Large
granules or chunks may be loaded with forceps.

The equipment shown in this section may differ slightly from yours. However, the process
is the same unless otherwise noted.

Analysis results are expressed in units of surface area per gram of sample; therefore, it is important the
true sample mass be known.

Follow the instructions on the Sample Data Worksheet and complete all fields to find the true sample
mass.
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Determine Sample Mass

1. Record the Sample Tube Identification on the Sample Data Worksheet.

2. Tare the balance and allow it to stabilize at zero.

3. Place the empty sample tube set on the balance.

4. Record the stabilized mass on the Sample Data Worksheet as [A] Mass for empty sample tube set.
Remove the sample tube set from the balance.

Do not touch the sample with bare hands while performing the following steps. Doing so
could affect the accuracy of results.

5. Place a sample container on the balance. Tare the balance and allow it to stabilize to zero (0).

6. Slowly pour the specified amount of sample into the sample container.

7. Remove the rubber stopper, seal frit, or TranSeal from the sample tube.

8. Use the sample tube funnel (provided in the accessories kit) and pour the sample from the weigh-
ing container into the sample tube.

9. Replace the rubber stopper, Check Seal, or TranSeal.

10. Weigh the sample tube set containing the sample and record the value on the Sample Data Work-
sheet as [B] Sample tube set plus sample mass (Before Degas).

11. Subtract the [A] Mass for empty sample tube set from the [B] Mass of sample tube set plus
sample and record this value as the [C] Sample mass (Before Degas).

STEP 4 - DEGAS THE SAMPLE

See Degas on the SmartPrep on page 5 - 1.

Step 4 - Degas the Sample
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6 Perform an Analysis

STEP 5 - INSTALL THE SAMPLE TUBE

If using... Then...
A rubber stopper Remove it.
An isothermal jacket Slide the jacket down over the stem of the sample tube until it touches the

sample tube bulb.
A filler rod Hold the sample tube horizontally and carefully slide the filler rod into

the tube.

1. Loosen the connector nut on the P0 tube and rotate the P0 tube out of the way.

2. Install the isothermal jacket.

3. Place the connector nut, ferrule and O-ring onto the sample tube stem.

4. Insert the sample tube into the analysis port and ensure it is completely in the port. Securely hand
tighten the connector nut onto the analysis port.

5. Position the dewar lid above the isothermal jacket.
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STEP 6 - FILL AND INSTALL THE DEWAR

See Dewar Precautions on page 6 - 1.

The equipment shown in this section may differ slightly from yours. However, the process
is the same unless otherwise noted.

1. Fill the dewar with the analysis bath liquid (such as liquid nitrogen) to no higher than 2 1/4 in. (5.7
cm) from the top. Filling the dewar higher than this will cause an error in the free space
measurement.

Incorrect fluid levels can lead to measurement errors. Check the level of the bath liquid
before each analysis.

2. Insert the dipstick and check the level of the analysis bath liquid. Condensation should not exceed
the level indicator mark.

Step 6 - Fill and Install the Dewar
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6 Perform an Analysis

3. For best results, if the dewar has not been used for a while, allow approximately 30 minutes for
the temperature of the dewar to stabilize with the bath liquid, then recheck the level of the bath
liquid. Add additional liquid if necessary.

4. If using isothermal jackets, slide the jackets down the sample tube until the jackets touch the
sample tube bulbs.

5. Slide the dewar lid down to the top of the isothermal jacket to ensure a proper seal on the top of
the dewar.

6. Attach the safety shield to the brackets on the front of the analyzer.
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PERFORM A SAMPLE ANALYSIS

Unit [n] > Sample Analysis

1. Go to Unit [n] > Sample Analysis.

2. Click Browse and select a sample information file, or click New to create a new sample inform-
ation file.

3. Verify the information populated into the sample identification fields. This information is pulled
from the selected or newly created sample file.

4. Click Report after analysis to generate reports automatically when the analysis is complete. On
the Report Settings window, select the report destination. Click OK to return to the previous win-
dow.

5. Click Start to start the analysis. A window displays data as they are collected. A short delay is
encountered before the port status at the bottom of the window changes from the Idle state.

6. When the analysis is complete, remove the sample tube and store (or dispose of) the sample mater-
ial as applicable.

Perform a Sample Analysis
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6 Perform an Analysis

Field or Button Description
Density / Mass /

Sample + Tube /

Empty Tube

Enter values for the sample’s mass and density. These values may be
edited after analysis.

l Density

l Mass

l Sample + Tube

l Empty Tube
New Creates a new sample information file.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Analysis Fields and Buttons Table

Field or Button Description
Live Graph Settings Select Thermal transpiration, X-axis Quantity (relative or absolute

pressure) and the X-Axis Scale (linear or logarithmic).
Report after analysis Generates reports automatically when the analysis is complete. On the

Report Settings window, select the report destination. Click OK to return
to the previous window.

Display Port Generates a report on data being collected. The reports are printed to the
screen only.

Sample Analysis Graph Fields and Buttons Table
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Field or Button Description
Resume Restarts the suspended analysis.
Skip Skips to the next step. Select the ports to skip.
Status window Displays the last point pressure and relative pressure for each port.
Suspend Suspends an analysis in progress.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Sample Analysis Graph Fields and Buttons Table (continued)

Perform a Sample Analysis
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7 ABOUT REPORTS
Reports can be generated for data collected on a sample that has completed analysis, collected on a
sample currently being analyzed, or manually entered.

OPEN AND CLOSE REPORTS

Reports > Open Report... > [.REP File]

Opens saved reports.

Reports > Close Reports

Closes all open reports. This option is unavailable if reports are being generated.

START REPORTS

Reports > Start Report

1. Select one or more .SMP files with a Complete status from the library. To select more than one
file, hold down the Ctrl key on the keyboard while selecting the files, or hold down the Shift key
to select a range of files. Click Report.

2. Select the report destination in the Report Settings window, then click OK.

If only one report file was selected in Step 1, the Selected Reports window displays allow-
ing the option to select additional reports. Select additional reports as needed, then click
OK. If multiple files were selected, the reports are displayed in a tiled format.

3. Click a tab at the top of the window to review each report.

7 About Reports
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7 About Reports

HEAT OF ADSORPTION REPORT

Reports > Heat of Adsorption

Use to select sample files, define quantities, and generate a Heat of Adsorption report. The isosteric heat
of adsorption is an important parameter for characterizing the surface heterogeneity and for providing
information about the adsorbent and the adsorption capacity. Multiple adsorption isotherms are obtained
on the same sample using the same adsorptive but at different temperatures to obtain the heat of
adsorption.

Field or Button Description
Add Samples Adds a sample file to the table.

1. Click Add Samples.

2. Double click the file in the Name column. Alternatively, select the
file name, then click Open.

To select more than one file, hold down the Ctrl key on the keyboard
while selecting the files, or hold down the Shift key to select a range of
files.

Clear Samples Removes all entries from the table.
Edit Quantities Use to specify the range of surface coverage to include in the report.

Heat of Adsorption Fields and Buttons Table
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Field or Button Description

Insert Range. Click to specify the starting and ending quantities
adsorbed and number of points to insert.

l Load Table. Imports values from another file.

l Save Table. Saves the current table as a .QNT file.

l Apply. Applies all table changes.
Heat of adsorption plot Generates the Heat of Adsorption data in a graphical format.
Isostere plot Generates a graph showing quantities of gas adsorbed versus the

temperature.
Remove Sample Removes the selected sample from the list.
Show graphic Use to show a graphic on the report header. Click Browse to locate the

graphic.

l Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title Select and enter a report title to appear on the report header.
Tabular report Generates a tabular report of the included samples. A tabular report con-

tains the numeric values contributed by each sample.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Heat of Adsorption Fields and Buttons Table (continued)

Heat of Adsorption Report
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7 About Reports

SPC REPORT

Reports > SPC Report Options

Use to generate reports with various SPC (Statistical Process Control) options. All selected variables
must be computed for each sample file used in an SPC report; therefore, it is more efficient to select
only the necessary variables.

The selected items display as graph variable selections in Reports > Regression Report and graph
selections in Reports > Control Chart. If additional report options are required, clickMore.
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REGRESSION REPORT

Reports > Regression Report

Use to generate a Statistical Process Control (SPC) Regression report to determine the interdependency
between two variables. Up to three dependent variables (y-axis) may be plotted against a single
independent variable (x-axis). The degree of correlation between the variables is also reported.

Field or Button Description
Autoscale When enabled, allows the x- and y-axes to be scaled automatically.
Axis Range Enter the beginning and ending values for the x- and y-axis ranges. These

fields are disabled if Autoscale is selected.
Label data Use to label the points on the plot to correspond with the values in the

sample files.
Recalculate archived SPC
results

Use to have archived SPC values recalculated ensuring any changes
made to the SPC Report Options are included in the new report. This
option lengthens the time required to generate the report.

If this recalculation option is enabled and sample files from
an earlier application version are selected, it is recom-
mended that copies of the archived sample files be used
rather than the original. Selecting this option will make some
archived sample files unreadable by the original application.

When this option is selected, the following message displays:

Saving the recalculated SPC data may render some files
unreadable by the original application. Saving the SPC data

Regression Report Fields and Buttons Table

Regression Report
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7 About Reports

Field or Button Description
speeds up future SPC reports.

Do not show me this message again.

If Do not show me this message again is selected, the mes-
sage cannot be redisplayed without Micromeritics assist-
ance.

The first time this option is used, the time it takes to generate the report is
lengthened. The second time the report is generated, if using the same
sample files used in the initial calculation, it is recommended that this
option not be selected since the data was recalculated previously. If a
sample file is added or removed from the report after the initial
recalculation, this option should be selected again to ensure the data from
the newly added or removed sample file is recalculated.

Samples To select more than one file, hold down the Ctrl key on the keyboard
while selecting the files, or hold down the Shift key to select a range of
files.

l Available Files. Contains files located in the directory specified in the
Look In text box.

l Selected Files. Files added from the Available Files list box.

l Add / Remove. Select a file in the Available Files list box, then click
Add to move the file to the Selected Files list box. Or select a file in
the Selected Files list box, then click Remove to move the file back to
the Available Files list box. Or double click the file name to move the
file from one list box to the other.

Save as Default Click to save selected report options as default report settings.
Show graphic Use to show a graphic on the report header. Click Browse to locate the

graphic.

l Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title Select and enter a report title to appear on the report header.

Regression Report Fields and Buttons Table (continued)
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Field or Button Description
Tabular report Generates a tabular report of the included samples. A tabular report

contains the numeric values contributed by each sample.
X- and Y-Axis Variable Use to designate the x- and y-axes variables. The variables in the drop-

down lists are those selected in the Reports > SPC Report Options
window. Use these options to plot the regression of up to three y-axis
variables against the x-axis variable.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Regression Report Fields and Buttons Table (continued)

Regression Report
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7 About Reports

CONTROL CHART REPORT

Reports > Control Chart

Use to generate a Statistical Process Control (SPC) control chart report which plots the changes in a
statistic.
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Field or Button Description
Graph [n] Click to define the y-axis of each graph.

l Statistic. Displays the SPC variables selected on the Reports > SPC
Report Options window. The selected variable will be plotted against
time. This selection also becomes the y-axis label.

l Autoscale. Allows the y-axis to be scaled automatically. To specify a
range, deselect this option and enter a range in the From and To fields.

l Center Line. Displays placement options for the center line in the
graph. Choose Entered to specify placement of the line.

l Limit Lines group box. Displays limiting lines options. Lines can be
placed at some multiple of the standard deviation or at specified pos-
itions (Entered). When Entered is selected, enter the High limit and
Low limit fields with appropriate values.

Recalculate archived SPC
results

Use to have archived SPC values recalculated ensuring any changes
made to the SPC Report Options are included in the new report. This
option lengthens the time required to generate the report.

If this recalculation option is enabled and sample files from
an earlier application version are selected, it is recom-
mended that copies of the archived sample files be used
rather than the original. Selecting this option will make some
archived sample files unreadable by the original application.

When this option is selected, the following message displays:

Saving the recalculated SPC data may render some files
unreadable by the original application. Saving the SPC data
speeds up future SPC reports.

Do not show me this message again.

Control Chart Fields and Buttons Table

Control Chart Report
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7 About Reports

Field or Button Description

If Do not show me this message again is selected, the mes-
sage cannot be redisplayed without Micromeritics assist-
ance.

The first time this option is used, the time it takes to generate the report is
lengthened. The second time the report is generated, if using the same
sample files used in the initial calculation, it is recommended that this
option not be selected since the data was recalculated previously. If a
sample file is added or removed from the report after the initial
recalculation, this option should be selected again to ensure the data from
the newly added or removed sample file is recalculated.

Report Generates the report.
Samples To select more than one file, hold down the Ctrl key on the keyboard

while selecting the files, or hold down the Shift key to select a range of
files.

l Available Files. Contains files located in the directory specified in the
Look In text box.

l Selected Files. Files added from the Available Files list box.

l Add / Remove. Select a file in the Available Files list box, then click
Add to move the file to the Selected Files list box. Or select a file in
the Selected Files list box, then click Remove to move the file back to
the Available Files list box. Or double click the file name to move the
file from one list box to the other.

Save as Default Click to save selected report options as default report settings.
Show graphic Use to show a graphic on the report header. Click Browse to locate the

graphic.

l Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title Select and enter a report title to appear on the report header.

Control Chart Fields and Buttons Table (continued)
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Field or Button Description
Tabular report Generates a tabular report of the included samples. A tabular report con-

tains the numeric values contributed by each sample.
X Axis Order by Select the order in which x-axis statistics are placed. Sort by:

l Time. Time the files were analyzed.

l File name. Alphanumeric order.

l Date. Date the files were analyzed.

l Minutes. Minutes elapsed from the first file placed on the list, which
is the earliest-analyzed file.

l Days. Number of days elapsed from the first file placed on the list,
which is the earliest-analyzed file.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Control Chart Fields and Buttons Table (continued)

Control Chart Report
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7 About Reports

INTERACTIVE REPORTS
When opening a sample file that contains data from a complete or in-progress analysis, the interactive
reporting feature is enabled.

1. When opening a sample file that contains analysis data, a window with the following information
displays:
l an isotherm linear plot and log plot of the data collected during analysis

l a summary of the analysis giving a single total pore volume and surface area

2. To view the plots in either relative or absolute pressure, select either the Relative Pressure or
Absolute Pressure option.

3. To view the reports selected for generation during the analysis, click Preview.

4. From the drop-down list at the bottom of the window:

l change the option presentation of the sample information window to either Basic or Advanced
to modify certain file parameters, or

l select another plot from the list and edit the data contained in the plot.

5. When ranges are edited, the changes are reflected immediately in the plots and the summary data
displayed in the window. Some editing options are:

l Drag the blue bars to increase or decrease the range of data included in the plot.

l Edit the Isotherm Linear Plot to include or omit the data point from the BET plot.

Right click to display a popup menu to include reports; enable or select overlays; edit curves,
axes, legends, titles; and copy and paste the data in a graph or in tabular format.

6. After editing the report, click Save to save the changes in the sample information file.

7 - 12 ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015



MICROACTIVE REPORTS
MicroActive reports are generated automatically after an analysis is performed. This feature provides a
quick and easy way to investigate and manipulate analysis data using a variety of reporting methods.

When a sample information file with a status of , Analyzing, or Entered is opened, an isotherm linear plot
and log plot of the data collected during analysis are displayed as well as a summary of the analysis
giving the total pore volume. Numerous reports are accessible from a drop-down menu, including:

l Advanced Report

l Alpha-S Method

l BET

l BJH Adsorption

l BJH Desorption

l DFT Pore Size

l DFT Surface Energy

l Dollimore-Heal Adsorption

l Dubinin - Astakhov

l Dubinin - Radushkevich

l f-Ratio Method

l Freundlich

l Horvath-Kawazoe

l Isotherm

l Langmuir

l MP-Method

l NLDFT Advanced PSD

l Options

l Sample Log

l Summary

l Temkin

l t-Plot

l Validation

When a report is opened, plots and summary data are displayed, and in some reports certain parameters
(for example, thickness curve type, pore geometry, and interaction parameters) are also displayed. Plots
may be edited by selecting the data points or data point range to be included in the plots and modifying
the parameters. When a report is edited, the results are immediately reflected in the plots and summary
data.

MicroActive Reports
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7 About Reports

EVALUATE REPORT RESULTS
Analysis reports provide a record of test conditions, experimental data, and information extracted from
the experimental data by application of various reduction methods. This topic discusses the elements of
various reports presented by Micromeritics’ static volumetric physical adsorption analyzers and suggest
ways by which the merit of the reported information may be evaluated.

Regardless of the precautions exercised before the analysis, problems still may occur during the
analysis, or as a result of using inappropriate parameters or even inappropriate methods. The analysis
data should be inspected for evidence of experimental error. The traditional method of confirming the
quality of the experiment is to repeat the analysis. Toward that end, Micromeritics’ analyzers log and
report the exact conditions of each analysis.

Analysis data can be evaluated by:

l Viewing the Validation Report

l Inspecting the Isotherm Plot

l Evaluating the Isotherm Tabular Data Set

l Reviewing Reduced Data

VIEW THE VALIDATION REPORT

The Validation report shows whether the data collected during an analysis are within typical ranges.
Select the types of reports to include by selecting the report in the Validation Report Options window.

When a selected report is generated, if errors occur, a message is displayed across the top portion of the
report and a unique symbol displays on the graph.
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INSPECT THE ISOTHERM PLOT

Evaluation of data should begin with a visual inspection of the isotherm plot. The plot should be
composed of data which have not been subjected to mathematical smoothing as far as possible. If the
data describe a Type I isotherm, then the plot is best shown on a logarithmic pressure axis so that details
of the low pressure region are revealed. Data in this region are important particularly for micropore
studies. Examine the plot to determine if any points are outliers or if a region of the isotherm exhibits
characteristics (spikes, steps, etc.) which are inconsistent with the physical process being monitored.
The philosophical question of whether or not these suspected extraneous data points should be removed
from the raw data is not considered here, but it may be appropriate to exclude an outlier from reduced
data. Too many outliers can cause the integrity of the total data set to come under suspicion.

Examine specific reported values to confirm that the isotherm data were collected under reasonable
conditions and using reasonable parameters. For example, confirm that the free-space values reported
are typical for the sample holder and bath in use. A problem with either warm or cold free space values
may indicate a free-space measurement error and affect all calculations of quantity adsorbed.

The raw data should be carefully examined before it is reduced. Errors that occur in raw data will only
be exacerbated in reduced data.1 )

EVALUATE THE ISOTHERM TABULAR DATA SET

Another place to look for reasonableness of the data is the adsorptive uptake by the sample in the BET
range (P/P0 = 0.05 to 0.30). Total uptake is the specific quantity adsorbed (cm

3/g STP) times the sample
mass (g). As an example, the level of uncertainty in this range typically is less than 0.1 cm3 STP for a
high performance system. Total uptake quantities should be some multiple of this level of uncertainty.
Otherwise, an unfavorable signal-to-noise ratio and unreliable data result. The solution is to use a greater
quantity of sample to increase adsorptive uptake.

Another valuable bit of information resides in the tabulated saturation pressure. This pressure is expected
to change somewhat over the duration of an analysis, but it is not expected to do so with large or abrupt
transitions. Unreasonable saturation pressures or unusual changes may indicate that a gas different from
the adsorptive was used in determining P0, that the level of the cryogen fell too far, or that the cryogen is
impure or inappropriate.

With experience, obvious signs of problems can be detected by a quick inspection of the tabular and
graphical data. If the data appear satisfactory, the next step is to evaluate the reduced data.2 )

1 ) The information in this article is extracted from Analytical Methods in Fine Particle
Technology, Webb, P. and Orr, C., (1997).
2 ) Most of the information in this article is extracted from Analytical Methods in Fine Particle
Technology, Webb, P. and Orr, C., (1997).

Inspect the Isotherm Plot
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7 About Reports

REVIEW REDUCED DATA

Isotherm data may be analyzed by any one of several reduction methods depending on instrument model
and pressure range employed. The quality of the results depends on the quality of the isotherm, the
congruity of the data reduction parameters with experimental conditions, the agreement of the theoretical
model with the physical gas-solid system, and compliance to the pressure range over which the method is
valid. Typically, results can be appraised by examining a few salient areas of the report as described in
the following topics.1 )

PHYSICAL PARAMETERS

The value of physical parameters which are used only in data reduction routines should be reviewed to
assure that they agree with experimental conditions. These parameters can be changed and the
experimental data recalculated if an error is discovered or if exploring an alternate value is desired.
Analysis condition values used in the calculation of quantity adsorbed can be changed also. These are
typically the manually entered free space(s), nonideality correction factor, and bath temperature.

The area occupied by a single adsorbed molecule is a required parameter in the calculation of surface
area by the BET and Langmuir methods. The software provides a default value, but other values are
found in the literature. McClellan and Harnsberger2 ) provide a comprehensive review of such values.

The volume of pores of a specific size range is calculated from the gas quantity adsorbed in them by
converting the quantity to its liquid equivalent volume. This is achieved through use of a density
conversion factor calculated from the ratio of molar densities of the condensed adsorbate at bath
temperature to the gaseous phase at STP. The necessary information is found in handbooks. The
software contains default values for common adsorptives; values for other adsorptives must be
calculated.

The terms for liquid surface tension g, contact angle between solid and liquid phase q, molar volume of
the adsorbate n, gas constant R, and sample temperature T are treated as one constant, the adsorbate
property factor A expressed by:

A=
γ θ

RT

2 ϑ cos

using which, the Kelvin equation3 ) reduces to

1 ) Most of the information in this article is extracted from Analytical Methods in Fine Particle
Technology, Webb, P. and Orr, C., (1997).
2 ) McClellan, A.L., and Harnsberger, H.F., Journal of Colloid and Interface Science, 23, 577
(1967).
3 ) Thomson, W., Phil. Mag. S., 42, 448 (1871).
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Either surface tension, contact angle, or molar volume can be revised individually to give a new value
for the factor A, or A can simply be altered arbitrarily for exploratory purposes.

The thermal transpiration correction requires two parameters which may be adjusted from those of the
default values. The first is the inside stem (neck) diameter of the sample holder, and the second is the
hard-sphere diameter of the adsorptive molecule. The sample holder inside diameter is available from
the documentation provided with it or is measurable. Information on hard-sphere diameters of molecules
may be obtained from handbooks.

For terms such as the interaction parameter found in the Horvath-Kawazoe calculation1 ) , the Dubinin
affinity coefficient or Astakhov exponent2 ) , the default values as provided by the software generally
are adequate. A search of the technical literature is required if the analysis involves a gas-solid system
other than that covered by the default values.

The t-Plot method plots quantity adsorbed (Va) against thickness (t) derived from a thickness equation,
and the Dubinin transform plots quantity adsorbed against log(P/P0)n. All of these data reduction
methods were first proposed for specific applications. The user must make a judgment as to the
applicability of the method to a gas-solid system.

If applied appropriately, all transform plots will exhibit a linear range and the regression analysis must
be applied only over the linear range and within the range of application. Fitting a regression line to
surface area transformation plots should yield a correlation coefficient of 0.9999 or better and for t-plots
and Dubinin plots the correlation coefficient should be 0.99 or better.

If the data reduction model does not apply to the gas-solid system under examination, then it may be that
either no linear range exists within the pressure range of validity, or that solutions derived from the
regression line of the linear range are intuitively incorrect, that is, they have no relevance to the physical
situation, such as a negative C-value from a BET transform.

BET C-VALUE

BET theory assumes uniform surface coverage with no favored adsorption sites and it also assumes that
the gas is more strongly attracted to the surface than to other gas molecules. The typical range of BET
C-values is from about 5 to well over 100. Values much less than 5 imply that the gas-to-gas affinity is
competing with the gas-to-solid affinity which conflicts with the basic assumptions of BET theory. C-
values much greater than 100 indicate very strong attraction for the surface or preferential adsorption

1 ) Everett, D.H. and Powl, J.C., J. Chem Soc., Faraday Trans. 1, 72, 619 (1976).
2 ) Dubinin, M.. and Radushkevich, L.V., Proc. Acad. Sci. USSR, 55, 331 (1947).

BET C-value
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7 About Reports

Provided the isotherm was determined with negligible error and the regression line to the BET
transformation data was fit properly, then an out-of-range C-value probably indicates that the gas-solid
interaction for the particular sample material does not conform to the BET model. An inappropriate
adsorption model may be indicated also by the coefficient of correlation of the regression line, 0.999
being about the minimum value expected with five more or less equally spaced points. In the case of
indications of poor conformance to the BET model, the Langmuir data reduction method should be
examined.

DATA ANALYSES BY THE BJH METHOD

In general, this method visualizes the incremental decomposition of an experimental isotherm, starting at
the highest relative pressure or pore size. At each step the quantity of adsorptive involved is divided
between pore-emptying and film-thinning processes and is accounted for totally. This computational
algorithm frequently leads to inconsistencies when carried to small mesopore sizes. If the thickness
curve used is too steep, ultimately it will predict a larger increment of adsorptive for a given pressure
increment than is actually observed. The algorithm must stop since a negative pore volume is
nonphysical. Accumulated error results in the calculation of a too large volume of (possibly nonexistent)
small pores if the thickness curve used underestimates film thinning.
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REPORT FEATURES AND SHORTCUTS
Reports can be customized and manipulated using the toolbar, shortcut menus, the zoom feature, or axis
cross-hairs.

l After analysis, reports can be viewed, printed, and / or copied and pasted into other documents.

l The report zoom feature provides the viewing of fine graph details and the ability to shift the axes.

l All reports contain a header displaying file statistics.

If configured, the report header can also contain a graphic and / or a title.

l Tabular and graphical reports contain sample and analyzer statistics such as analysis date / time, ana-
lysis conditions, etc.

l The headers contain notes of sample file changes occurring after analysis.

l Summary report headers contain the same information as tabular and graphical reports with the excep-
tion of notes.

Report Features and Shortcuts
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7 About Reports

REPORT HEADER SHORTCUTS

Display header shortcuts by right clicking in the report header.

Field or Button Description
Copy header as text Use to copy the report header as text. Text is copied to the clipboard and

then can be pasted into other documents.
Edit Use to edit the report title and / or graphic in the report header.

Report header Shortcut Field and Button Table
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REPORT TOOLBAR

The Report window has a toolbar on the right portion of the window and selectable tabs at the top of the
report header. To view a specific report, either select the tab or the report in the Reports list box, then
click Show.

Field or Button Description
Default Style Click to specify default report parameters for fonts and curve properties.

l Font Type. Use to edit the font type and attributes for the selected
item. Select an item in the list, click Edit, and select from various font
options.

l Thickness. Enter a thickness number for the curve.

l Histogram Fill Style. Select a histogram fill option.

l Graph border line thickness. Enter a thickness number for the graph
border.

Delete Deletes the selected report in the Reports list box. Deleted reports will
have to be regenerated if deleted in error.

Hide Hides (or temporarily removes) the selected report from the tabbed view.
The report name remains in the Reports list box.

Print Displays the Print window for report output.

l Name drop-down list and Properties. Select the printer from the drop-
down list and click Properties to change printer setup, etc.

l Copies. Select the number of copies and collate option.

l Current. Selects the active report (or selected tab).

Report Toolbar Fields and Buttons Table

Report Toolbar
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7 About Reports

Field or Button Description
l All. Selects all reports in the Reports list box.

l Shown. Selects only the reports not hidden.

l Clear. Clears all selections.
Reports list box Contains a list of all generated reports. The same reports display as tabs

at the top of the report header unless the report has been hidden using the
Hide button.

Show Displays the selected or hidden report in the Reports list box.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Report Toolbar Fields and Buttons Table (continued)
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GRAPH FEATURES AND SHORTCUTS

Display graph report shortcuts by right clicking in the body of the graph report.

Field or Button Description
Autoscale all axes Returns the report to full view after using the zoom feature.
Copy Data Copies the report data to the clipboard. It can then be pasted into

other software programs as tab-delimited columns or copied as an
overlay onto another graph.

Copy Graph Copies the graph to the clipboard. It can then be pasted into other
software programs.

Display imported data Used with pore distribution data reports only. Use to hide or show
imported or pasted ASCII text data on the active graph.

Edit axis Use to edit the selected axis properties.

l Title. Use to edit the selected axis label.

Graph Shortcuts Options and Description Table

Graph Features and Shortcuts
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Field or Button Description
l Title font. Use to modify the font for the selected axis label.
Deselect the Use default font to enable font options. Select new
font attributes for the report data. To return to the default fonts,
enable Use default font.

l Linear / Logarithmic. Select the option to scale the graph as lin-
ear or logarithmic.

l Autoscale minimum / maximum. To manually specify minimum
/ maximum autoscale, deselect the option and enter the new
amount in the text box.

l Invert scale. Use to invert the scale.

l Scale font. Use to modify the font for the scale label. Deselect
Use default font to enable font options.

l Grid lines. Use to change how to display major / minor grid
lines.

Edit curve Use to edit selected curve properties.

l Title. Use to change the title of the selected curve.

l Style. Use to select another style for the collected data curve.

l Curve group box. Use to change the interpolation, point style
and pen style for the selected curve. These options are disabled
if Use default fill style is selected in the Histogram group box.

Color. Click to change the curve color.

Use default thickness. Uses the default curve thickness.
Deselect to enter a new thickness number in the Thickness text
box.

l Histogram group box. Enabled only if Histogram is selected in
the Style drop-down list. Use to specify the type of fill, fill color

Graph Shortcuts Options and Description Table (continued)
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Field or Button Description
and label position for the selected curve.

l Label. Select where the graph point labels will display (left,
right, center, etc.) on the SPC report.

Edit imported data Used with pore distribution data reports only. Use to select
ASCII text files for import onto the active graph.

Edit legend Use to change the legend location and font. Click Font to modify
font attributes. Deselect the Use default font to enable font options.
Select new font attributes for the report data. To return to the
default fonts, enable Use default font.

Edit title Use to change the graph title and font. Click Font to font attributes.
Deselect the Use default font to enable font options. Select new font
attributes for the report data. To return to the default fonts, enable
Use default font.

Enable Overlays If overlays have been selected, this option displays (or hides) the
overlays.

Include report When selected, places a checkmark to the left of the report in the
Select Reports list box on the Report Options tab.

Paste Data Used with pore distribution data reports only. Use to paste ASCII
text data from the clipboard onto the the active graph.

Graph Shortcuts Options and Description Table (continued)

Graph Features and Shortcuts
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7 About Reports

Field or Button Description
Reset axis limits to initial set-
ting

Removes the cross-hair and returns the graph back to the initial set-
ting.

Select overlays... Displays the option to select files to overlay onto the active graph.
To view the overlays, ,click Enable Overlays on the shortcut menu.

Show curve Displays a list of all curves. Select the curve(s) to display.

Graph Shortcuts Options and Description Table (continued)

Axis Cross-hair

The cross-hair feature displays axis coordinates.

1. Left click on the graph to view the cross-hair coordinates.

2. To remove the cross-hair, right click in the graph area and select either Autoscale all axes or
Reset axis limits to initial setting.
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Graph Grid Lines

Options > Graph Grid Lines

Use to select how grid lines appear on reports. This menu option is not available if using Restricted
option presentation.

Field or Button Description
Grid Line Styles Select if the major and / or minor grid lines should appear as solid or dot-

ted lines.
X-Axis / Y-Axis Select major and / or minor lines to display in reports for the logarithmic

and linear scales. Deselect this option to remove the grid lines.

Graph Grid Lines Fields and Buttons Table

Zoom Feature

Use the zoom feature to examine graph details.

1. Open the graph.

2. Hold down the left mouse button, then drag the mouse pointer across the graphical area to be
enlarged. A box will display in the area to be enlarged.

3. Release the mouse button. The enlarged area fills the graph area. To return to normal view, right
click in the graph area, then select either Autoscale all axes or Reset axis limits to initial setting
on the shortcut menu.

Graph Features and Shortcuts
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TABULAR REPORT FEATURES AND SHORTCUTS

Display tabular report shortcuts by right clicking in the body of the tabular report. Column shortcuts
require right clicking on the column to be modified.

Field or Button Description
Align column Select to change the column alignment to either left, right, or centered.
Copy table as text Use to copy the report contents to the clipboard as tab-delimited text. It

can then be pasted into another document.
Edit title Use to edit the report title and / or title font attributes. Click Font to

modify font attributes. Deselect the Use default font to enable font
options. Select new font attributes for the report data. To return to the
default fonts, enable Use default font.

Move column Right click the column to be moved. Select Move column on the shortcut
menu and select Left or Right for the move.

Rename column Right click the column to be renamed. Select Rename column on the short-
cut menu and enter the new column name.

Resize column Right click the column to be resized. Select Resize column on the
shortcut menu and enter the new column width in inches.

Show column Displays a list of all columns. Click a column to add a checkmark to
show the column or remove the checkmark to hide the column.

Table data font Right click in the report data. Select Table data font on the shortcut menu.
Deselect the Use default font to enable font options. Select new font
attributes for the report data. To return to the default fonts, enable Use
default font.

Table header font Right click in the report data. Select Table header font on the shortcut
menu. Deselect the Use default font to enable font options. Select new
font attributes for the report data. To return to the default fonts, enable
Use default font.

Tabular Reports Shortcut Options and Descriptions Table
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GRAPH AND SAMPLE OVERLAYS
Use the graph overlay functions to compare multiple graph options. Graphical lines are differentiated by
the use of varying colored symbols outlined on a legend. Overlays may be generated in two ways:

l Multiple Graph Overlays. Overlay two different types of graphs from one sample.

l Multiple Sample Overlays. Overlay graphs of the same type with that of the current plot.

This feature is available only when using Advanced option presentation.

GENERATE PORE-SIZE DISTRIBUTION GRAPH OVERLAYS

The overlay process allows the importing of pore-size distribution data from an ASCII text file. The
ASCII text file must follow the format rules outlined below.

Multiple graph overlays can only be generated for:

l BJH Adsorption / Desorption

l Dollimore-Heal Adsorption / Desorption

l Horvath-Kawazoe

l DFT Pore Size

ASCII text file format rules:

l The header must consist of one line to include title, two unit specifications, and distribution type:

o Accepted pore dimension units are: A, nm, um
o Accepted pore volume units are: cm3/g, cm3/g, ml/g
o Accepted distribution types are: cumulative, incremental

Two examples of a header format:

My Title (A, cm3/g, incremental)

My Title (A, cm3/g, cumulative)

l The data must be in two columns and should be separated by a comma or white-space.

l The data lines must be ordered so that pore dimensions are monotonically increasing or decreasing.

Sample ASCII text file

Graph and Sample Overlays
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7 About Reports

silica alumina bjh

456.657
444.847
429.168
425.419
419.629
360.634
340.859
326.601

(A, cm3/g, cumulative)

0.0133559
0.0546427
0.0869924
0.119721
0.132681
0.156611
0.197672
0.233092

To import ASCII text files to generate graph overlays:

The following steps use BJH Adsorption as an example. Window appearance will vary depending on the
selected report. This function can be performed on samples files with a Completed status or during an
analysis.

1. Go to File > Open. Select a sample file to overlay graphs onto other samples. To select more than
one file, hold down the Ctrl key on the keyboard while selecting the files, or hold down the Shift
key to select a range of files. Click Open.

2. Select Advanced from the drop-down list at the bottom of the window.

3. Select the Report Options tab, then click Overlays to browse for the .TXT file.

If the ASCII text file does not display on the Plot Overlay Sample Selection window, click
Import. Locate the file, then click Open. Header information from the ASCII text file will then
appear in the Select Imported Overlays window. Select the entry, then click OK. If an error
message appears instead, verify that the .TXT file format is correct. Select the entry, then click
OK.

4. On the Report Options tab, highlight the type of report in the Selected Reports list box to overlay
with a graph, then click Edit.
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5. On the Report Options window, highlight the type of report in the Selected Reports list box to over-
lay with a graph, then click Edit.

6. Click the down arrow at the Variable field and select a variable to overlay. Click the down arrow
of the Overlay field, then select Imported Data. Click OK to return to the Report Options win-
dow.

7. Click OK again to return to the Report Options tab.

8. Click Save As to save the selections.

9. To view the report, click Preview.

Generate Pore-size Distribution Graph Overlays
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7 About Reports

OVERLAY MULTIPLE SAMPLE FILES

To overlay the same type of graph on multiple samples:

1. Go to File > Open.

2. Select a .SMP file, then click Open. If the Isotherm plot displays, select Advanced from the drop-
down list at the bottom of the window to display the tabbed window view.

3. Click the Report Options tab.

4. In the Selected Reports list box, highlight a report then click Edit. Use the following table to com-
plete the process for the selected report.
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If overlaying this type of
report...

Then...

l Isotherm

a. On the Isotherm Report Options window, select one or more plots
in the Selected Reports group box, then click Options to the right
of the selected plot.

b. On the Plot Options window, select Plot curve and / or Plot points
if they are to be included in the overlay. If the x- and / or y-axes
are to be autoscaled, enable Autoscale; otherwise, enter the From
and To points for the axes. Click OK to save and close the win-
dow.

c. On the Isotherm Report Options window, in the Plot Options group
box, select Plot overlays. Click OK.

d. Continue to Step 5.
l Alpha-S Method

l BET Surface Area

l f-Ratio Method

l Freundlich

l Langmuir Surface Ara

l t-plot

l Temkin

a. On the pop-up window, select Overlay samples. Verify other
fields. Click OK to return to the Report Options tab.

b. Continue to Step 5.

l BJH Adsorption

l BJH Desorption

l Dollimore-Heal Adsorp-
tion

l Dollimore-Heal Desorp-
tion

l MP-Method

a. Select the report variable from the Selected Reports group box,
then click Edit.

b. Click the down arrow on the Overlay field, then select the
Samples option. Verify other fields. Click OK to return to the
Report Options window.

c. Click OK again to return to the Report Options tab.

5. On the Report Options tab, click Overlays.

6. On the Plot Overlay Sample Selection window, use one of the following options to move up to 25
files from the Available Files box to the Selected Files box:

Overlay Multiple Sample Files
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l Double click a file name in the Available Files box to move the file to the Selected Files
box. To move a file from the Selected Files box back to the Available Files box, double
click the file name in the Selected Files box, or

l Select a file name in the Available Files box. Click Add to move the selected file to the
Selected Files box. To move a file from the Selected Files box back to the Available
Files box, select a file name in the Selected Files box, then click Remove. To select
more than one file, hold down the Ctrl key on the keyboard while selecting the files, or
hold down the Shift key to select a range of files.

6. Click OK.

7. To view the report, click Preview.
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IMPORT ASCII PORE DISTRIBUTION DATA

Import an ASCII Text File using Graph Shortcuts

1. Create an ASCII text file. See Graph and Sample Overlays on page 7 - 29.

2. Open a report with a Complete status.

3. Select a pore-size distribution report from the drop-down list at the bottom of the window.

4. Right click on the graph and select Edit imported data on the shortcut menu.

If the ASCII text file does not display on the Selected Imported Overlays window, click Import.
Locate and select the file, then click Open. Header information from the ASCII text file will
appear in the Select Imported Overlays window. Select the entry, then click OK. If an error
message appears, verify that the .TXT file format is correct.

5. To hide or show imported data,right click in the graph area and use the Display imported data
option on the shortcut menu.

Copy / Paste an ASCII Text File using Graph Shortcuts

1. Create an ASCII text file. See Graph and Sample Overlays on page 7 - 29.

2. Copy the ASCII text data to the clipboard.

3. Open a report with a Complete status.

4. Select a pore-size distribution report from the drop-down list at the bottom of the window.

5. Right click on the graph and select Paste data on the shortcut menu.

6. To hide or show imported data,right click in the graph area and use the Display imported data
option on the shortcut menu.

Copy / Paste Graph Data from Another Graph

1. Open a source pore distribution data report with a Complete status.

2. Right click on the graph and select Copy Data on the shortcut menu.

3. Open the target pore distribution data report.

4. Right click on the graph and select Paste Data on the shortcut menu.

5. To hide or show imported data,right click in the graph area and use the Display imported data
option on the shortcut menu.

Import ASCII Pore Distribution Data
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REPORT EXAMPLES

HORVATH-KAWAZOE DIFFERENTIAL PORE VOLUME PLOT
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ISOTHERM LOG REPORT

Isotherm Log Report
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ISOTHERM TABULAR REPORT
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OPTIONS REPORT

Options Report
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8 REPORT OPTIONS
File > Open > [.RPO File]

(or click the Report Options tab when in Advanced option presentation)

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

Use to specify report options for collected (from an analysis) or manually entered data. Report Options
files also help in customizing report details such as axis scale, axis range, column headings, and
components of thickness curve equations.

Reports can be generated for data:

l collected on a sample that has completed analysis

l collected on a sample currently being analyzed

l manually entered

Customized report options files can be created then loaded into a sample file, allowing quick generation
of reports.

8 Report Options
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8 Report Options

Field or Button Description
Apply thermal tran-
spiration correction

Use to correct the temperature-induced pressure difference between the
manifold and the chilled sample tube. This option is most significant for
pressures less than approximately 1.0 mmHg.

Always use thermal transpiration when performing micropore analyses.
See Thermal Transpiration Correction on page B - 44.

l Inside diameter of sample tube. Enabled when Apply thermal tran-
spiration correction is selected. Enter the inside diameter of the
sample tube used in the analysis.

Name column Displays a list of files in the selected directory.
Overlays See Graph and Sample Overlays on page 7 - 29.
Report Options drop-down
list

Browse for a .RPO file that contains report options parameters to be used
in the report.

Selected Reports list box Select the report names to include in the report.
Show graphic Use to show a graphic on the report header. Click Browse to locate the

graphic.

l Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title Select and enter a report title to appear on the report header.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Report Options Fields and Buttons Table
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ADVANCED REPORT OPTIONS
See Python Module - Advanced Reports on page E - 1

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

Up to five Advanced reports, each with up to 10 summary reports, 10 tabular reports, and 10 graphical
reports can be created. To use this feature, a file containing a Python script that imports a "mic" Python
module must be created. See Mic Module Python Calls on page E - 12 for an example of Python script
and functions for the "mic" Python Module.

1. Create the Python script and save it in the Scripts directory.

2. Open a sample file with a Completed status.

3. Select Advanced at the bottom of the window to return to the tabbed view.

4. On the Report Options tab, select Advanced in the Selected Reports list box, then click Edit.

5. On the Advanced Report Options window, click Add in the Available Scripts group box to locate
and select the Python script. Repeat for each script to be added.

6. In the Selected Reports group box, click the drop-down arrows to select up to five Python scripts
previously added in the Available Scripts box.

7. Click Pressures to add pressure points to the report.

8. Click OK to return to the Report Options tab.

9. On the Report Options tab, click Preview. The Python Reports will be included on the tabs across
the top portion of the Reports window.

10. Select the Overlay samples checkbox to enable the overlay sample feature.

Advanced Report Options
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8 Report Options

Field or Button Description
Add Click to add additional Python reports.
Available Scripts Lists the available reports and provides the option to add, replace, edit or

remove reports.
Overlay samples Use to overlay samples as defined by the function.
Advanced Report 1
through 5

Use the drop-down lists to select currently-defined functions used to
define the report calculations and output.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Advanced Report Options Fields and Buttons Table
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ALPHA-S METHOD REPORT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The Alpha-S plot converts the standard adsorption isotherm into a dimensionless isotherm using the
quantity adsorbed at a relative pressure of 0.4.

One predefined curve is located in the Reference file directory. Use the table buttons to enter relative
pressure and the alpha-s values.

Alpha-S Method Report Options
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8 Report Options

Field or Button Description
Alpha-S plot Use to plot data in graph format.

l Overlay samples. Use to overlay sample files on the plot.

l Autoscale x-axis. The x-axis field shows the relative pressure.

l Autoscale y-axis. The y-axis field shows the quantity of gas adsorbed.
Open To import values from an existing thickness curve (.ALS file), click

Open and select the file containing the values.

The table to be imported must be saved as ASCII text with a .ALS file
extension. It must have a two-column format with the relative pressures
in the first column and the alpha-s values in the second column. Columns
must be separated by a space or a tab.

Pressures Use to select a pressure range for report calculations and points for
exclusion from calculations.

l Calculation pressure range. Enter the minimum and maximum pres-
sures to be used in the pressure table.

To exclude a point from the calculations used to generate the report,
select Exclude.

l Include All. Select to include all pressure points in the table.

l Exclude All. Select to exclude all pressure points in the table.
Ref. surface area Enter the surface area from the reference curve. This value is used to

calculate the sample surface area.

Alpha-S Method Report Options Fields and Buttons Table
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Field or Button Description
Select Range for Alpha-S
Fit

Enter minimum and maximum relative pressures to determine the fit.

Selected Reports l Tabular Report. Use to have a tabular report of data generated.

l Alpha-S Plot. Use to plot data in graph format.
o Overlay samples. Use to overlay sample files on the plot.
o Autoscale x-axis. The x-axis field shows the relative pressure.
o Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Alpha-S Method Report Options Fields and Buttons Table (continued)

Alpha-S Method Report Options
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8 Report Options

BET SURFACE AREA REPORT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The BET calculation obtains the sample surface area value by determining the monolayer volume of
adsorbed gas from the isotherm data. BET uses a multilayer model.
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Field or Button Description
Pressures This option is available when the sample file has a status of Analyzing or

Complete. Use to enter a range of pressure points to be included in the
report or to modify table values for pressure points.

l Calculation pressure range. Enter the minimum and maximum pres-
sures to be used in the pressure table if not using the Use Interpolation
option.

l Use Interpolation. Use to indicate if the system should use the table
or interpolated data. This option is available for BET and Langmuir
reports only.

l Insert Predefined. Click to insert a predefined (default) set of points
into the report. Use Interpolation must be selected to enable this but-
ton. This button displays for BET reports only.

l Include All. Select to include all pressure points in the table.

l Exclude All. Select to exclude all pressure points in the table.
Select Pressure Range for
BET fit

Enter values to indicate the fitted pressure range.

Selected Reports l Tabular report. Use to have a table of measured and calculated val-
ues generated.

l BET Transform plot. Use to generate a traditional BET surface area
plot used to determine monolayer volume and BET C constant.
o Overlay samples. Use to overlay sample files on the

BET transform plot.
o Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the relative pressure for BET.
o Autoscale y-axis. The y-axis field shows BET transformation.

BET Report Options Fields and Buttons Table

BET Surface Area Report Options
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8 Report Options

Field or Button Description
l BET Isotherm plot. Uses BET monolayer volume and constant to pro-
duce an isotherm.
o Overlay samples. Use to overlay sample files on the BET isotherm

plot.
o Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the relative pressure for BET.
o Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

BET Report Options Fields and Buttons Table (continued)
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BJH ADSORPTION / DESORPTION REPORT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The BJH calculation determines the mesopore volume / area distribution, which accounts for both the
change in adsorbate layer thickness and the liquid condensed in pore cores. Reports can be generated
from both adsorption and desorption data. The fields for both BJH Adsorption Report Options and
BJH Desorption Report Options are identical unless otherwise specified.

An incomplete pore distribution may be generated if a thickness curve selection is not a
good match for the sample being analyzed.

BJH Adsorption / Desorption Report Options
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8 Report Options

Field or Button Description
Adsorptive Displays the Adsorptive Options window. The recommended adsorptives

and their values are shown. Up to eight adsorptive and adsorbate
property factor combinations may be specified.

BJH Correction Select the type of correction to apply to calculations. The selected type
displays in the report header.

l Standard. Uses original BJH models.

l Kruk-Jaroniec-Sayari. Good for reference thickness curves.

l Faas. Good for statistical thickness curves.
Cumulative Reports l Larger. Use to report the total volume found in pores larger than the

current pore size.

l Smaller. Use to report the total volume found in pores smaller than
the current pore size.

Pores Enter the minimum and maximum diameter (radius or width) of pores to
include in the BJH reports.

l Fraction of pores open at both ends. This field is not available for
the BJH Desorption Report Options window.

During adsorption calculations, the analysis program assumes that all
pores are closed at one end. Occasionally, a percentage of pores may
be open at both ends causing disagreement in the adsorption and
desorption data or in the values for total volume and total BJH pore
volume. Enter the fraction of pores open at both ends to compensate
for this error.

Pressures Use to select a pressure range for report calculations and points for
exclusion from calculations.

BJH Adsorption / Desorption Report Options Fields and Buttons Table

8 - 12 ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015



Field or Button Description

l Calculation pressure range. Enter the minimum and maximum pres-
sures to be used in the pressure table.

To exclude a point from the calculations used to generate the report,
select Exclude.

l Include All. Select to include all pressure points in the table.

l Exclude All. Select to exclude all pressure points in the table.
Select Reports Select the report names to include in the report. Highlight the report

name, then click Edit to modify report parameters.
Smooth differentials Use to smooth all differential calculations, thus eliminating variations in

the differential computation caused by noise in the input data.
Thickness Curve Select the thickness curve, then click Edit to modify the values in the

equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One predefined
curve is shipped with the analysis program and is found in the Reference
directory.

BJH Adsorption / Desorption Report Options Fields and Buttons Table (continued)

BJH Adsorption / Desorption Report Options
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8 Report Options

Field or Button Description
To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated by a
space or a tab.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-de
Boer / Carbon Black STSA. Select the thickness curve option, then
click Edit. Modify the equation for the selected curve as needed.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

BJH Adsorption / Desorption Report Options Fields and Buttons Table (continued)
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BJH PLOT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The fields for all plot options are identical for specifying plotting methods and customizing plots.
Highlight any plot option in the Selected Reports list box in the BJH Report Options window, then click
Edit.

Field or Button Description
Autoscale When enabled on the report parameters windows, allows the x- and y-

axes to be scaled automatically. Autoscale means that the x- and y-
ranges will be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

Plot curve / Plot points Select to plot points on the graph.
X-Axis Use to have the x-axis on a logarithmic or linear scale.
Y-Axis l Variable. Select a variable.

l Overlay. Select an option to overlay onto the current report.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

BJH Plot Options Fields and Buttons Table

BJH Plot Options
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8 Report Options

BJH TABULAR REPORT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

Highlight BJH Tabular Report in the Selected Reports list box on the BJH Adsorption Report Options
window, then click Edit to specify the method of data reduction.

Field or Button Description
Collected points Use to include all relative pressure points collected. Refer to the

Columns button below.
Columns Select the data types to include in the report. Column [n] indicates the

column order and data contents for the report.

Fixed pore size table Use to specify exact pore sizes for volume or area data.Click Table to
modify the fixed pore size table. Refer to Table and Columns buttons
elsewhere in this table.

Table The fixed pore size table must contain a minimum of two points. The

BJH Tabular Report Options Fields and Buttons Table
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Field or Button Description
points must be strictly decreasing. Enabled only when Fixed pore size
table is selected.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

BJH Tabular Report Options Fields and Buttons Table (continued)

BJH Tabular Report Options
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8 Report Options

DFT PORE SIZE REPORT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The DFT Pore Size report contains the results of pore size distribution analyses using a non-local DFT
range of micro and mesopore ranges.

Field or Button Description
Geometry Select the pore shape.
Model Lists the models that meet the specified criteria and match the adsorbate

and temperature of the sample data. If no models appear, no models meet
the selected criteria. One model must be selected.

Pressures Use to select a pressure range for report calculations and points for
exclusion from calculations.

DFT Pore Size Report Options Fields and Buttons Table
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Field or Button Description

l Calculation pressure range. Enter the minimum and maximum pres-
sures to be used in the pressure table.

To exclude a point from the calculations used to generate the report,
select Exclude.

l Include All. Select to include all pressure points in the table.

l Exclude All. Select to exclude all pressure points in the table.
Regularization Select the extent of smoothing to apply to the data. If 0.20000 (user) is

selected, enter a number in the text box giving a relative weight for the
smoothing during deconvolution. Larger values produce more smoothing.

Select Reports Select the reports to generate. To edit graph details, highlight the graph
option and click Edit. The Log Goodness of Fit and Goodness of Fit
graphs cannot be edited.

l Plot Type. Select the method for data display.

l Autoscale Options. Use to autoscale the x-axis and / or y-axes.

l Overlay. Select an overlay for the report.

DFT Pore Size Report Options Fields and Buttons Table (continued)

DFT Pore Size Report Options
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8 Report Options

Field or Button Description
l Axis Range. From / To fields are enabled when Autoscale options are
not selected. Enter the starting and ending values for the x- and / or y-
axes.
o X-axis. Shows the pore size.
o Y-axis. Shows the area.

Type l DFT. Model based on the density functional theory.

l Classical. Model based on the Kelvin equation and thickness for
determining the pore size distribution. See DFT Models on page C - 1.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

DFT Pore Size Report Options Fields and Buttons Table (continued)
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DFT SURFACE ENERGY REPORT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The DFT Surface Energy report contains the results of surface energy distribution analyses.

DFT Surface Energy Report Options fields and buttons are identical to the DFT Pore Size Report
Options. See DFT Pore Size Report Options on page 8 - 18.

DFT Surface Energy Report Options
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8 Report Options

DOLLIMORE-HEAL ADSORPTION / DESORPTION REPORT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The Dollimore-Heal Adsorption Report Option and the Dollimore-Heal Desorption Report Option
generate reports from both adsorption and desorption data. The fields and buttons for these reports are
identical to the BJH Adsorption / Desorption Report Options. See BJH Adsorption / Desorption Report
Options on page 8 - 11.
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DOLLIMORE-HEAL PLOT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The fields for all plot options are identical for specifying plotting methods and customizing plots.
Highlight any plot option in the Selected Reports list box in the BJH Report Options window, then click
Edit. The fields and buttons for these reports are identical to the BJH Plot Report Options. See BJH Plot
Options on page 8 - 15.

Dollimore-Heal Plot Options

ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015

8 - 23



8 Report Options

DOLLIMORE-HEAL TABULAR REPORT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

Dollimore-Heal Tabular Report Options are identical to the BJH Tabular Report Options. See BJH
Tabular Report Options on page 8 - 16.
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DUBININ REPORT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The Dubinin method provides pore volume distributions for microporous materials by making use of an
expression for the adsorption potential.

Dubinin Report Options
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8 Report Options

Field or Button Description
Adsorptive Displays the Adsorptive Options window. The recommended adsorptives

and their values are shown. Up to eight adsorptive and adsorbate property
factor combinations may be specified.

Fitted Relative Pressure
Range

Enter the minimum and maximum limits for Radushkevich or Astakhov
relative pressures included in the line fit.

Pressures Use to select a pressure range for report calculations and points for
exclusion from calculations.

l Calculation pressure range. Enter the minimum and maximum pres-
sures to be used in the pressure table.

To exclude a point from the calculations used to generate the report,
select Exclude.

l Include All. Select to include all pressure points in the table.

l Exclude All. Select to exclude all pressure points in the table.

Dubinin Report Options Fields and Buttons Table
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Field or Button Description
Report Type Select report types. If Astakhov is selected, either select Optimize

exponent or enter an appropriate exponent value in the text box.
Select Reports Select the reports to generate. Highlight the report, then click Edit to

modify report options.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Dubinin Report Options Fields and Buttons Table (continued)

Dubinin Report Options
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8 Report Options

DUBININ PORE VOLUME REPORT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

In the Dubinin Report Options window, highlight dV/dw Pore Volume in the Selected Reports list box,
then click Edit.

This option plots differential pore volume as a function of pore width.

Field or Button Description
Autoscale x-axis / Auto-
scale y-axis

Select an option to have the x- and / or y-axes scaled automatically. Both
axes begin at 0; the system uses the highest values collected during
analysis as the ending points for axis ranges.

Enable to enter beginning and ending values manually.
Overlay samples Use to overlay sample files on the plot.
Plot curve / Plot points Select to plot points on the graph.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Dubinin Pore Volume Report Fields and Buttons Table
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DUBININ TABULAR REPORT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

In the Dubinin Report Options window, highlight Dubinin Tabular Report in the Selected Reports list
box, then click Edit. Column [n] indicates the column order and data contents for the report.

Log (po/p )^n. The value for [n] is the optimized exponent if Optimize exponent is selected on the
Dubinin Report Options window. If not, then the value for [n] is the entered exponent value.

Dubinin Tabular Report Options
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8 Report Options

DUBININ TRANSFORMED ISOTHERM PLOT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

Highlight Transformed Isotherm in the Selected Reports list box in the Dubinin Report Options window,
then click Edit.

The transformed Dubinin isotherm is the logarithm of quantity adsorbed as a function of the log of
relative pressure raised to a power. Isotherms for which the Dubinin method is applicable produce
straight lines when transformed in this way.

Field or Button Description
Autoscale x-axis / Auto-
scale y-axis

Select an option to have the x- and / or y-axes scaled automatically. Both
axes begin at 0; the system uses the highest values collected during
analysis as the ending points for axis ranges.

Deselect to enter beginning and ending values manually.

l Autoscale x-axis. Shows the quantity of gas adsorbed at standard tem-
perature and pressure.

l Autoscale y-axis. Shows the log of relative pressure.
Overlay Samples Use to overlay sample files on the plot.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Dubinin Transformed Isotherm Plot Options Fields and Buttons Table
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F-RATIO METHOD REPORT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The f-Ratio report uses the measured isotherm and normalizes it using a reference isotherm.

f-Ratio Method Report Options
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8 Report Options

Field or Button Description
Pressures Use to select a pressure range for report calculations and points for

exclusion from calculations.

l Calculation pressure range. Enter the minimum and maximum pres-
sures to be used in the pressure table.

To exclude a point from the calculations used to generate the report,
select Exclude.

l Include All. Select to include all pressure points in the table.

l Exclude All. Select to exclude all pressure points in the table.
Reference isotherm Click Browse to select a sample file to use as a reference for the

isotherm. Select a file containing an isotherm measured from a non-
porous sample of the same material as the current sample. When the
referenced file is selected, the file name appears to the left of Browse.

Selected Reports l Tabular Report. Use to have a tabular report of data generated.

l f-Plot. Use to generate a normalized isotherm.
o Overlay samples. Use to overlay sample files on the f-plot.
o Autoscale x-axis. The X-axis field is dimensionless in units of f-

ratio.
o Autoscale y-axis. The Y-axis field shows the quantity of gas

adsorbed.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

f-Ratio Method Report Options Fields and Buttons Table
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FREUNDLICH REPORT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The Freundlich Isotherm is an empirical isotherm used to model low-pressure adsorption data. It can
also be applied to model some micropore isotherms. In the Selected Reports list box, highlight
Freundlich, then click Edit.

Freundlich Report Options
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8 Report Options

Field or Button Description
Pressures Use to select a pressure range for report calculations and points for

exclusion from calculations.

l Calculation pressure range. Enter the minimum and maximum pres-
sures to be used in the pressure table.

To exclude a point from the calculations used to generate the report,
select Exclude.

l Include All. Select to include all pressure points in the table.

l Exclude All. Select to exclude all pressure points in the table.
Select Reports l Tabular report. Select to include pressure points included in the

report.

l Freundlich Isotherm plot. Plots the absolute pressure vs quantity
adsorbed. Shows best fit line.
o Overlay samples. Use to overlay sample files on the Freundlich iso-

therm plot.
o Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the absolute pressure.
o Autoscale y-axis. Y-axes begin at zero. The y-axis field shows the

quantity of gas adsorbed.

l Freundlich Transform plot. Plots the log(P) vs log(Q) and the best
fit.
o Overlay samples. Use to overlay sample files on the Freundlich

transform plot.
o Autoscale x-axis. The x-axis field shows the absolute pressure.
o Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
Specify monolayer capa-
city

Select and enter the monolayer capacity of the sample.

Freundlich Report Options Fields and Buttons Table
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Field or Button Description
Tabular report Use to have a report of the pressure points generated.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Freundlich Report Options Fields and Buttons Table (continued)

Freundlich Report Options
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8 Report Options

HORVATH-KAWAZOE REPORT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The Horvath-Kawazoe method plots individual peaks for different pore sizes even if the difference
between one pore size and the next is only one angstrom (0.10 nm) or less.
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Field or Button Description
Apply Cheng-Yang cor-
rection

Use to apply the Cheng-Yang correction to the pore size analysis. This
correction substitutes the Langmuir equation of state for Henry’s Law in
the Horvath-Kawazoe derivation.

Interaction Parameter Use to determine which interaction parameter will be used in the report.
These options are disabled if Sphere is selected in the Pore Geometry
group box.

l Computed. Use to calculate using the parameters on the Horvath-
Kawazoe Physical Properties window (click Properties to display the
Physical Properties window). The interaction parameter is recal-
culated each time a parameter in the Physical Properties window is
edited.

l Entered. Calculates using the value entered in the text box.
Pore Geometry Select the option that best represents the physical geometry of the

micropores in the sample material. When Sphere is selected, options in
the Interaction Parameter group box are disabled.

Pressures Use to select a pressure range for report calculations and points for
exclusion from calculations.

l Calculation pressure range. Enter the minimum and maximum pres-
sures to be used in the pressure table.

To exclude a point from the calculations used to generate the report,
select Exclude.

l Include All. Select to include all pressure points in the table.

l Exclude All. Select to exclude all pressure points in the table.
Properties Click to view or edit the constants describing the physical properties of

the adsorbent and adsorptive.

Horvath-Kawazoe Report Fields and Buttons Table

Horvath-Kawazoe Report Options
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8 Report Options

Field or Button Description

Adsorbent. Contains the parameters for the sample. If using Computed
for the interaction parameter, all fields are enabled. If using Entered, only
the values in the Diameter and Diameter at zero energy text fields may
be edited.

l Description. Select the name of the sample used in the analysis.

l Diameter. Enter the diameter of the sample atom.

l Diameter at zero energy. Enter the diameter of an atom at zero inter-
action energy: (2/5)1/6 × diameter.

l Polarizability. Enter the polarizability of the sample.

l Magnetic susceptibility. Enter the magnetic susceptibility of the
sample.

l Density. Enter the density per unit area of the sample.

Adsorptive. Contains the parameters for the adsorptives. If using
Computed for the interaction parameter, all fields are enabled. If using
Entered, only the values in the Diameter and Diameter at zero energy
text fields may be edited.

l Mnemonic. Select the mnemonic of the adsorptive gas in use.

l Diameter. Enter the diameter of the gas phase atom.

l Diameter at zero energy. Enter the diameter of an atom at zero inter-
action energy: (2/5)1/6 × diameter.

l Polarizability. Enter the polarizability of the adsorptive.

l Magnetic susceptibility. Enter the magnetic susceptibility of the
adsorptive.

l Density. Enter the density per unit area of the adsorptive.

Horvath-Kawazoe Report Fields and Buttons Table (continued)
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Field or Button Description
Select Reports Select the types of reports to generate. Highlight the report, then click

Edit to modify report parameters.
Smooth Differentials Use to smooth all differential calculations, thus eliminating variations in

the differential computation caused by noise in the input data.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Horvath-Kawazoe Report Fields and Buttons Table (continued)

Horvath-Kawazoe Report Options

ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015

8 - 39



8 Report Options

HORVATH-KAWAZOE PLOT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

Highlight a plot option in the Selected Reports list box in the Horvath-Kawazoe Report Options window,
then click Edit to customize the plotting method. See BJH Plot Options on page 8 - 15 for additional
information on fields and buttons for this report.
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HORVATH-KAWAZOE TABULAR REPORT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

Highlight H-K Tabular Report in the Selected Reports list box in the Horvath-Kawazoe Report Options
window, then click Edit. Select the data types to include in the report. Column [n] indicates the column
order and data contents for the report.

Horvath-Kawazoe Tabular Report Options
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8 Report Options

ISOTHERM REPORT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The Isotherm report indicates adsorption (up to saturation pressure) and desorption (down from saturation
pressure) of a gas by a solid held at constant temperature.

Field or Button Description
Options Click to display related linear plot options. All plot windows contain

identical fields.

l Plot curve / Plot points.Select to plot points on the graph.

l Autoscale x-axis. Linear x-axes begin at zero. Logarithmic x-axes
begin at an appropriate value. The x-axis field shows the relative or
absolute pressure.

l Autoscale y-axis. The y-axis field shows the quantity of gas adsorbed.
Plot Options Select the types of isotherm to plot.
Quantity Adsorbed Select how to report the quantity adsorbed.

Physisorption Isotherm Report Options Fields and Buttons Table

8 - 42 ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015



Field or Button Description
l per gram (cm3/g) STP

l per BET Surface Area (cm3/m2) STP or mmol/g

l per other Surface Area (cm3/m2) STP or mmol/m2

Select Reports Select each option to include on the final report. Click the Options button
of a selected item to include plot curve, plot points, and to autoscale x-
and y-axes.

Tabular Options Select the options to include on the report.

l Weight %. Enter the mass percentage when plotting pressure com-
position

l Elapsed time. Time elapsed during the analysis

l Time between points. Time elapsed between points during the ana-
lysis

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Physisorption Isotherm Report Options Fields and Buttons Table (continued)
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8 Report Options

LANGMUIR REPORT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The Langmuir calculation determines the surface area of a sample by relating the surface area to the
volume of gas adsorbed as a monolayer. Langmuir uses a single layer model.
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Field or Button Description
Pressures This option is available when the sample file has a status of

Analyzing or Complete. Use to enter a range of pressure points
to be included in the report or to modify table values for pressure
points.

l Calculation pressure range.Enter the minimum and max-
imum pressures to be used in the pressure table.

To exclude a point from the calculations used to generate the
report, select Exclude.

l Use Interpolation. Use to indicate if the system should use
the table or interpolated data. This option is available for BET
and Langmuir reports only.

l Include All.Select to include all pressure points in the table.

l Exclude All.Select to exclude all pressure points in the table.
Select Pressure Range for Lang-
muir fit

Enter values to indicate the fitted pressure range.

Selected Reports l Langmuir Transform Plot. Use to generate a traditional
Langmuir surface area plot used to determine monolayer
volume constant
o Autoscale x-axis. Linear x-axes begin at zero. The x-axis

field shows the absolute pressure for Langmuir.
o Autoscale y-axis. The y-axis field shows Langmuir trans-

formation.
o Overlay samples. Use to overlay sample files on the Lang-

Langmuir Report Options Fields and Buttons Table
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8 Report Options

Field or Button Description
muir transform plot.

l Langmuir Isotherm Plot. Uses the Langmuir monolayer
volume and constant to produce an isotherm.
o Overlay samples. Use to overlay sample files on the Lang-

muir isotherm plot.
o Autoscale x-axis. Linear x-axes begin at zero. The x-axis

field shows the absolute pressure for Langmuir.
o Autoscale y-axis. The y-axis field shows the quantity of

gas adsorbed.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Langmuir Report Options Fields and Buttons Table (continued)
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MP-METHOD REPORT OPTIONS

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The MP-Method Report Options provides pore volume distributions for microporous materials by
correlating quantity adsorbed with the thickness of the adsorbed layer as determined from a user-selected
thickness curve. Pore size can be expressed in angstroms or nanometers. Go to Options > Units to
specify the unit.

MP-Method Report Options
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8 Report Options

Field or Button Description
Pressures Use to select a pressure range for report calculations and points for

exclusion from calculations.

l Calculation pressure range. Enter the minimum and maximum pres-
sures to be used in the pressure table.

To exclude a point from the calculations used to generate the report,
select Exclude.

l Include All. Select to include all pressure points in the table.

l Exclude All. Select to exclude all pressure points in the table.
Select Reports Select the reports to generate. Highlight the report, then click Edit to

modify report options.
Thickness Curve Select the thickness curve, then click Edit to modify the values in the

equation for the selected curve.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

MP-Method Report Options Fields and Buttons Table
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MP-METHOD PLOT REPORT OPTIONS

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

In the MP-Method Report Options window, highlight a plot option in the Selected Reports list box, then
click Edit to customize the plotting method.

Field or Button Description
Overlay drop-down list Select an option to overlay on the current report.
Plot curve / Plot points Select to plot points on the graph.
Thickness Curve Select the thickness curve, then click Edit to modify the values in the

equation for the selected curve.
X-Axis Use to have the x-axis autoscaled or enter beginning and ending values.
Y-Axis l Variable. Select a variable.

l Overlay. Select an option to overlay on the current report.

l Autoscale. Use to have the y-axis autoscaled or enter beginning and
ending values.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

MP Method Plot Options Fields and Buttons Table
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8 Report Options

MP-METHOD TABULAR REPORT OPTIONS

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

In the MP-Method Report Options window, highlight MP Tabular Report in the Selected Reports list box,
then click Edit. Column [n] indicates the column order and data contents for the report.

The MP Method reports hydraulic radius only. If Pore size in diameter is selected on the
Unit Selection window, pore size in radius will be reports.
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NLDFT ADVANCED PSD REPORT

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The NLDFT Advanced PSD report allows for more advanced computation of the pore size distribution of
a material using two separate analyses and two non-local DFT models.

The NLDFT Advanced PSD report option provides the same calculations as the DFT Pore Size report
option and more. The NLDFT report compares two sample files. The models that can be selected are
restricted to only those models which have the same analysis temperature and analysis gas as the sample
file that is open. For instance, if the sample file was analyzed with N2 at 77 degrees Kelvin, then only
the N2 DFT models at 77 degrees Kelvin will be available in the Model drop-down list.

The model curve fit is shown in the lower right quadrant along with the adsorption isotherm. This curve
fit is updated each time the calculation parameters change (selection of isotherm data points, choice of
model, choice of regularization parameter).

A second sample file and second model is used to compute a more accurate pore size distribution (PSD),
which is shown in the upper left quadrant. Typically, the second sample file will have used the same
sample material as the first sample file yet will have used a different analysis gas and temperature.

NLDFT Advanced PSD Report
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8 Report Options

In general, the isotherm for this second sample will be different than the first sample. The advanced
DFT calculation takes the data from both sample files and combines all this data into a more accurate
calculation of the pore size distribution. More accurate means getting the pore distribution at smaller
pore sizes (a few Angstroms) as well as larger pore sizes (one thousand Angstroms).

To make a successful advanced calculation, a second sample file must be selected using the
Select button. A second model must also be selected. Use the options next to the two
sample file names to select the isotherm data points for each sample. After selecting an
option, the blue bars in the isotherm graph will be toggled to select either the red points or
the green points. Once these selections have been done, the results will appear in the left-
hand plots and a second isotherm will appear in the isotherm plot (lower right) as well as a
second curve-fit. As the selection of points is adjusted, the DFT editor will recalculate the
PSD results and also recalculate the two model curve fits.

To run the NLDFT report:

1. Go to File > Open. Select a sample file with a Complete status, then click Open.

2. In the drop-down list at the bottom of the window, select NLDFT Advanced PSD. Graphs for the
first sample file display and the sample description shows as the first group box title in the upper
right corner of the window.

a. Select the Geometry andModel from the drop-down lists for the first sample file.

b. To select isotherm data points for calculation for the first sample file, ensure the
option to the left of the first sample file description is selected. Slide the two blue
bars on the isotherm graph to select data points. Without a second sample selected,
the report will perform a single model DFT calculation and show the results in the
two left-hand result windows.

3. To calculate data from the second sample file, click Select to locate and open the second sample
file with a Complete status. Graphs for the second sample file display and the sample description
displays as the second group box title in the upper right corner of the window.
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a. Select the Geometry andModel from the drop-down lists for the second sample file.

b. To select isotherm data points for calculation for the second sample file, ensure the option
to the left of the second sample file description is selected. Slide the two blue bars on the
isotherm graph to select data points. Data are automatically calculated for both sample
files.

c. Click Edit to make any necessary modifications to the second sample file.

Field or Button Description
Geometry Select the pore shape.
Model Lists the models that meet the specified criteria and match the adsorbate

and temperature of the sample data. If no models appear, no models meet
the selected criteria. One model must be selected.

Regularization Select the extent of smoothing to apply to the data. If 0.20000 (user) is
selected, enter a number in the text box giving a relative mass for the
smoothing during deconvolution. Larger values produce more smoothing.

Select Use to select the second sample file.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

NLDFT Advanced PSD Report Fields and Buttons Table
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OPTIONS REPORT
The Options report lists the conditions used to perform the analysis— such as:

l Adsorptive properties

l Analysis conditions

l Analysis method

l Degas conditions

l Free space

l Saturation pressure (P0) and temperature

If Automatically collected is selected in the Type of Data group box on the Sample Description tab, the
following information is reported:

l Task Summary. Lists conditions specified for each task selected.

l Analysis Task Options. Details conditions specified for the analysis task.

l Experiment Log. Identifies actual conditions under which each task transpired.

l Leak Test Results. Identifies outgas rates and the outcome for each leak test performed.

Options reports cannot be edited.

SAMPLE LOG REPORT
This report provides information on:

l Manual control operations performed during analysis

l Information entered using Add Log Entry on the sample file editor

l Warnings and / or errors which occurred during analysis
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SUMMARY REPORT OPTIONS

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The Summary Report provides a condensed listing of selected data results.

In the Pore Volume group box, if Adsorption total or Desorption total is selected, the p/po field is
enabled. Enter the relative pressure used to calculate the total pore volume.

Summary Report Options

ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015

8 - 55



8 Report Options

Field or Button Description
Item [n] Use to enable the first Pass/Fail item. Until the Summary Report is

selected, S A Single-point BET will be displayed by default. When
selected, click Pass/Fail, then select pass/fail criteria options.

l S A: Single-point BET. Use to enable Pass/Fail [n] in the Item [n]
group box.

l Pass/Fail [n]. Click to display the Pass/Fail Options window for selec-
tion of pass/fail criteria.

l Upper / Lower. Specify upper and lower limits for the selected para-
meter. A range can be left open by not selecting the limit. In the text
box to the right of Upper / Lower, enter operator instructions to be dis-
played if a failure is encountered.

Select All / Deselect All Selects (or deselects) all options.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Summary Report Fields and Buttons Table
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T-PLOT REPORT OPTIONS

A tutorial is available for this topic. To view the tutorial, click the Tutorial tab in Online Help.

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The t-Plot calculation allows quantitative analysis of the area and total volume ascribed to micropores.
Matrix area (the area external to micropores) is directly determined and often proves to be a valuable
way of characterizing complex mixed materials.

t-Plot Report Options
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Field or Button Description
Fitted thickness range Enter the minimum and maximum thicknesses (in angstroms or

nanometers) to include in the thickness curve. Go to Options > Units to
specify default units.

Pressures Use to select a pressure range for report calculations and points for
exclusion from calculations.

l Calculation pressure range. Enter the minimum and maximum pres-
sures to be used in the pressure table.

To exclude a point from the calculations used to generate the report,
select Exclude.

l Include All. Select to include all pressure points in the table.

l Exclude All. Select to exclude all pressure points in the table.
Selected Reports l Tabular Report. Use to have a tabular report of data generated.

l t-Plot. Use to have a graphical representation of data generated.
o Overlay samples. Use to overlay sample files on the t-plot.
o Autoscale x-axis. The X-axis field shows the statistical thickness

of the adsorbed film.
o Autoscale y-axis. The Y-axis field shows the quantity of gas

adsorbed.
Surface area correction
factor

Enter the value to correct for surface areas that are not smooth. This
brings the values for BET surface area and micropore surface area into
accordance. For most samples, the default value of 1.000 is adequate.

Surface Area Select the surface area value used for thickness calculations. BET is the
most commonly used option.

Thickness Curve Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness curve
can be applied using the Halsey option.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One predefined

t-Plot Report Options Fields and Buttons Table
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Field or Button Description
curve is shipped with the analysis program and is found in the Reference
directory.

To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be imported
must have a .TXT or .THK file extension and have a two-column format
with the relative pressures in the first column and the thickness values in
the second column. Columns must be separated by a space or a tab.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-de
Boer / Carbon Black STSA. Select the thickness curve option, then
click Edit. Modify the equation for the selected curve as needed.

t-Plot Use to have a graphical representation of data generated.

l Overlay samples. Use to overlay sample files on the t-plot.

l Autoscale x-axis. The X-axis field shows the statistical thickness of
the adsorbed film.

l Autoscale y-axis. The Y-axis field shows the quantity of gas
adsorbed.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

t-Plot Report Options Fields and Buttons Table (continued)

t-Plot Report Options
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8 Report Options

TEMKIN REPORT OPTIONS

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

The Temkin isotherm is used to model adsorption data where the heat of adsorption drops linearly with
increasing coverage.
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Field or Button Description
Pressures Use to select a pressure range for report calculations and points for

exclusion from calculations.

l Calculation pressure range. Enter the minimum and maximum pres-
sures to be used in the pressure table.

To exclude a point from the calculations used to generate the report,
select Exclude.

l Include All. Select to include all pressure points in the table.

l Exclude All. Select to exclude all pressure points in the table.
Selected Reports l Tabular Report. Generates a tabular report of the included samples.

A tabular report contains the numeric values contributed by each
sample.

l Temkin transform plot. Plots a linear form of the Temkin transform
plot.
o Autoscale x-axis. The X-axis field shows the logarithm of pressure

(ln).
o Autoscale y-axis. The Y-axis field shows the quantity of gas

adsorbed.
o Overlay samples. Use to overlay sample files on the transform

plot.

l Temkin isotherm plot. Overlays the Temkin isotherm with the ana-
lysis data.
o Overlay samples.Use to overlay sample files on the isotherm plot.
o Autoscale x-axis. Linear X-axes begin at zero. The X-axis field

shows the absolute pressure.
o Autoscale y-axis. Y-axes begin at zero. The Y-axis field shows the

quantity of gas adsorbed.
Specify differential heat
of adsorption

Select and enter the differential heat of adsorption at zero surface
coverage. This allows inclusion of all Temkin constants.

Temkin Report Options Fields and Buttons Table

Temkin Report Options
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8 Report Options

Field or Button Description
Specify monolayer capa-
city

Select and enter the monolayer capacity of the sample.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Temkin Report Options Fields and Buttons Table (continued)

VALIDATION REPORT OPTIONS

To edit reports, open the Sample Information file. Select the Report Options tab, then high-
light the report name in the Selected Reports list box. Click Edit.

This report allows data to be examined by the analysis program to determine if the results are within
typical ranges. If the data for any reports selected for validation are determined to be out of range, a
warning displays, and suggestions are given for corrective action. This information is detailed in the
report and plotted on the graph as a unique plot symbol.
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9 DIAGNOSTICS

START DIAGNOSTIC TEST

Unit [n] > Diagnostics > Start Diagnostic Test

Provides a method to start a diagnostic test immediately. To view the print options, resize the window.
Upon completion of the diagnostic test, the file is saved as a .REP file which can be retrieved by going
to Reports > Open Report and selecting the report file.

Field or Button Description
Comments Displays comments from the selected diagnostic test.
Estimated time (min.) Approximate time for test completion.
File Shows a status bar of steps complete once the test begins.
Next Starts the next test.
Operator Enter information to identify the person running the service test.
Repeat Repeats the selected diagnostic test.
Report after test Automatically generates reports to the selected destination when the test

is complete.
Sequence Sequence number assigned to the test.
Start Starts the diagnostic test.
Test Select the diagnostic test to be performed.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Start Diagnostic Test Fields and Buttons Table

9 Diagnostics
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9 Diagnostics

SAVE FILES FOR PROBLEM DIAGNOSIS

Unit [n] > Diagnostics > Save Files for Problem Diagnosis

Use to compress pertinent diagnostic information into a single zip file. This file can be sent to a
Micromeritics Service Representative for problem resolution. The following files are included in the
compressed file:

l [instrument model].ini

l info[sn].dat

l cal [sn].dat

l [sn].dat

l UserInformation.txt

l Any files selected by the user

To send the problem description and problem files to Micromeritics Customer Support.

1. Complete all fields. The Comments field is used to provide information that would be helpful to
the Micromeritics representative.
l If the computer is not connected to the internet, complete the Comments field.

l If the computer is connected to the internet, either complete the Comments field on this win-
dow OR complete the Description field on the portal listed in Step 6.

2. Click Add to include files that show the problem diagnosis.

3. Click Save As. A file named Diagnostics-[date].zip is created. This compressed file contains
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information from this window, any added file(s), and other system files.

4. Specify a location for the saved file. Save the file to:

l the desktop - if this computer has an internet connection, or

l a network drive or a portable media device - if the computer is not connected to the inter-
net.

5. Click Save.

6. From a computer with internet connection, go to http://techsupport.micromeritics.com/portal to
access the Micromeritics Customer Support portal.

7. Either log in or register.

8. Click the Requests tab.

9. Click New Request, then complete all fields on the window.

10. To attach the zipped file, click the Attach File(s) link, then select the Diagnostics-[date].zip file.

11. Click Add request to submit the problem request.

12. Return to the portal to track the progress of the problem solution.

Field or Button Description
Comment Enter information that would be helpful to the Micromeritics rep-

resentative. If the computer is not connected to the internet, complete this
field. If the computer is connected to the internet, this information can be
completed on the Micromeritics Customer Support portal.

Include Files l Add. Click to select additional files to send with this problem dia-
gnosis. To select more than one file, hold down the Ctrl key on the
keyboard while selecting the files, or hold down the Shift key to select
a range of files.

l Delete. Select the file in the Include Files box, then click Delete to
remove the file from the list.

l Clear. Click to clear all files from the Include Files box.
Save As Click to specify the name and location of the compressed file. Make a

note of the file name and location. This file will need to be sent to your
Micromeritics representative for problem resolution.

Save Files for Problem Diagnostic Fields and Buttons Table

Save Files for Problem Diagnosis
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9 Diagnostics

Field or Button Description
Micromeritics rep-
resentative

Enter the name of your Micromeritics representative. This information
will remain on the window each time files for problem diagnosis need to
be submitted (can be modified as necessary).

User Information Enter information for the person to be contacted by a Micromeritics rep-
resentative. This information will remain on the window each time files
for problem diagnosis need to be submitted (can be modified as neces-
sary).

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Save Files for Problem Diagnostic Fields and Buttons Table (continued)
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SHOW ALL READINGS

Unit [n] > Diagnostics > Show All Readings

The Show All Readings window displays the calibrated readings of all sensors in the system.

DIAGNOSTIC TEST REPORT

Unit [n] > Diagnostics > Diagnostic Test Report

Displays previously run diagnostic service tests. Separate directories store tests run once, daily, weekly,
and monthly. Diagnostic test report files have a .SVT file extension and are stored in the ...\Service
directory.

1. To open a diagnostic test report, select a service test report, then click Open. Alternatively,
double click the report file name.

2. On the Selected Reports window, select the reports to display, then click OK.

3. The reports display on separate tabs at the top of the report window.

Show All Readings

ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015

9 - 5





10 ABOUT CALIBRATION
Unit [n] > Calibration

Use to perform system calibrations. Disabled calibration options can be accessed only with the
assistance of an authorized Micromeritics service representative. Calibrations can be saved to a file and
reloaded later.

CALIBRATE PRESSURE ZERO

Unit [n] > Calibration > Pressure Zero

This procedure evacuates the system and zeroes the pressure transducers. This calibration should only be
performed by qualified service personnel. In order to perform this procedure, sample tubes must be
attached to each port.

The system automatically zeros the transducers before an analysis begins. Therefore, this procedure may
not need to be performed unless operating the system in manual mode.

RESET

Set the pressure transducer and temperature sensor calibrations to nominal values.

Recalibration should be performed by a Micromeritics service representative.

10 About Calibration
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10 About Calibration

LOAD CALIBRATION FROM FILE

Unit [n] > Calibration > Load from File

Use to load a previously saved calibration file.

It is recommended that the current calibration settings be saved using Unit [n] > Calibration > Save to
File prior to loading another calibration file. When loading a previously saved calibration file, a backup
of the current file is created and saved as [SN]last.cal. The backup file is overwritten each time a new
one is created.

Changing the calibration may affect the analyzer’s performance.

SAVE CALIBRATION TO FILE

Unit [n] > Calibration > Save to File

Use to save the current calibration settings to a backup file which can later be reloaded using Unit [n] >
Calibration > Load from File menu option.

The default file naming convention for calibration files can be used or the file name can be changed. The
default file name of 0217-2013-04-25.CAL is interpreted as:

0217 is the analyzer serial number
2013-04-25 is the date the calibration file was saved
.CAL is the file name extension
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11 HARDWARE COMPONENTS AND ACCESSORY INSTALLATION

FILL AND INSTALL AN ANALYSIS DEWAR

See Step 6 - Fill and Install the Dewar on page 6 - 9

ENABLE CRYOSTAT OPTION

Unit [n] > Enable Cryostat

A Cryostat is an available option. See Parts and Accessories on page 13 - 1.

Select to enable the cryostat, if using this option.

SAMPLE TUBE INSTALLATION
See Step 5 - Install the Sample Tube on page 6 - 8

11 Hardware Components and Accessory Installation
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12 TROUBLESHOOTING AND MAINTENANCE

The instrument has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of time.

What Happened Why What to Do
Analysis dewar cannot be
raised or lowered

Dewar elevator stuck in up
position, down position, or
somewhere in between.

Check for possible obstruction to elevator
movement.

Analysis valves cannot be
operated.

Circuit opened by circuit
breaker.

Reset breaker (depress breaker button) loc-
ated on the right side of the instrument
beneath the tray cover. See Front Com-
ponents on page 1 - 2. If the circuit
breaker trips (pops out), call your Micro-
meritics service representative.

Cable from computer to the
instrument is loose.

Ensure the cable is seated properly.

Furnace cannot be raised
or lowered

Elevator is stuck. Check for possible obstruction to elevator
movement.

Vacuum pump gurgles
continuously.

Sample tube O-ring or fit-
ting loose.

Tighten fitting. Replace O-ring.

Sample tube cracked. Replace with new sample tube.
No sample tube loaded on a
selected port.

Install plug or empty sample tube.

Gas inlet valve open while
vacuum valve open.

Go to Unit [n] > Enable Manual Control
to ensure a checkmark appears next the
Enable Manual Control. Right click on the
open valve and select Close.

Vacuum gauge shows
reading above 20 µmHg,
even after extended pump-
ing through unrestricted
valve with analysis port
closed.

Filter in sample port is dirty. Replace filter in port. See Replace Port Fil-
ters on page 12 - 10.

Leak in vacuum plumbing. Check and tighten all connections in
vacuum plumbing, including cold traps.

Vacuum pump turned off or
unplugged.

Check pump power plug and power switch.

Dry roughing pump needs to
be serviced.

Replace the diaphragms.

12 Troubleshooting and Maintenance
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12 Troubleshooting and Maintenance

GUIDELINES FOR CONNECTING GASES
l Place gas cylinders within 6 feet (2 m) of the gas inlets of the instrument. Using gas line extenders on
gas cylinders located in remote areas may degrade gas quality and reduce pressure. Gas lines are typ-
ically five to six feet long. Place the cylinders close enough to allow for proper connection at the ana-
lyzer inlet.

l Use a retaining strap (or other appropriate tether) to secure the gas cylinder.

l Always use the gas lines provided with the analyzer. It is very important that proper gas lines are
used with the analyzer.

o Do not use polymer tubing for the gas line.
o Do not use flexible gas lines. Some flexible lines may appear to be appropriate, such as

those with a herringbone covering, but the line may be coated internally with a polymer.

l Long gas lines, such as those used with gas cylinders placed in remote areas, must be evacuated for
an extended period of time to remove ambient gases. When possible, avoid placing gas cylinders in
remote locations. It is always better to have gas cylinders located near the analyzer.

l Carefully route the gas lines from the cylinder to the analyzer avoiding overlapping or entangling gas
lines. This will help avoid confusion when maintenance is required.

l Label the gas line at the analyzer inlet for proper identification and maintenance.

l Replace gas cylinders before gas is depleted. It is best to replace a gas cylinder when the pressure
reads approximately 200 psi (1500 kPa) on the high pressure gauge. Contaminants absorbed to the
walls of the cylinder will desorb as the pressure decreases.

l Ensure the gas cylinder is closed before connecting to the analyzer.

To use oxygen, the analyzer must be equipped with an oxygen-compatible vacuum pump
that uses Fomblin® (or a suitable equivalent) pump oil or a dry pump. Failure to use the
proper vacuum system could result in hazardous conditions, including fire and personal
injury.
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REPLACE A GAS CYLINDER

These instructions apply to working with inert gases only. When working with hazardous
gases, follow the safety procedures established by your lab.

A power failure can result in dangerous pressures in the sample chamber. When using toxic
or flammable gases, additional venting of the cabinet may be required.

Disconnect the Depleted Gas Cylinder

1. Close the regulator shut-off valve and gas cylinder shut-off valve by turning the knobs clockwise.

2. Disconnect the gas line from the regulator. Gas will be vented from the line. It is not necessary to
disconnect the gas line from the analyzer inlet if the cylinder will be replaced immediately with
one of the same type.

3. Open the gas regulator shut-off valve by turning the knob counter-clockwise. Gas will be vented
from the regulator.

4. Turn the regulator control knob clockwise to open and vent any remaining gas. Both gauges should
read at or near zero. If not, make sure the gas regulator shut-off valve is open.

5. Close the regulator by turning the control knob counter-clockwise.

Replace a Gas Cylinder
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12 Troubleshooting and Maintenance

6. Use an appropriate wrench to loosen the nut at the regulator connector nut then remove the reg-
ulator from the bottle.

7. Replace the protective cap on the depleted bottle. Disconnect the retaining strap and move the
bottle to an appropriate location.

Connect A Gas Cylinder

Analyzer Series Gauge should indicate
3Flex 15 psig (103 kPag)
AccuPyc 15 psig (103 kPag)
ASAP  15-17 psig (69 kPag)
AutoChem 5 psig (35 kPag)
AutoPore 45 - 50 psig (310 - 345 kPag)
Gemini 19.5 psig (134.4 kPag)
TriStar 15 psig (03 kPag)

Regulator Pressure Settings

Move the replacement bottle close to the analyzer and tether it into place.

1. Use an appropriate cylinder wrench to remove the protective cap from the replacement gas cyl-
inder. Place the protective cap in a secure location. It will be needed to recap the gas cylinder
when it is depleted and replaced.

2. Attach the gas regulator to the gas cylinder connector. Hand tighten the nut, then use an appro-
priate wrench to tighten an additional 3/4 turn.

Over-tightening the fitting may cause a leak.

3. Check for leaks at the high-pressure side of the regulator and in the connector.

a. Turn the regulator control knob fully counter-clockwise.

b. Slowly open the gas cylinder shut-off valve, then quickly close it.

c. Observe the pressure on the high-pressure gauge for approximately one minute.

l If the pressure is stable, proceed with the next step.

l If the pressure decreases, tighten the regulator connector nut until it
becomes stable. If the pressure does not remain stable, remove the reg-
ulator and clean all contacts at the regulator connection, then reinstall the
regulator.

4. Connect the gas line to the regulator. Use two 7/16 in. (11 mm) wrenches to tighten the gas line
connection. One wrench holds the fitting steady and the other tightens the connector nut.
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5. Open the gas cylinder shut-off valve.

6. Purge the air from the lines if the regulator or gas lines have been open to atmosphere for more
than a short period of time.

a. Disconnect the gas line from the analyzer inlet if connected.

b. Turn the regulator control knob clockwise until the low-pressure gauge reads approx-
imately 5 psi (30 kPa).

c. Open the regulator shut-off valve. Allow gas to flow for 30 seconds.

d. Close the regulator shut-off valve.

7. Connect the gas line to the analyzer if not already connected.

8. Open the regulator shut-off valve.

9. Turn the regulator control knob clockwise until the low-pressure gauge indicates the appropriate
pressure. See Regulator Pressure Settings on the previous page.

SPECIFY GAS PORTS

Unit [n] > Unit Configuration

Use to display hardware / software configurations, calibrations, and gas selections of the connected
analyzer.

The analyzer has gas inlets for up to six analysis gases. The gases connected to the inlets must be
specified in the analysis program. If the gas is changed on one of the inlets, the same change must be
made on the Unit Configuration window. The analysis software must be updated when gases change.

1. Click Gas.

Specify Gas Ports
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12 Troubleshooting and Maintenance

2. Use the drop-down arrows to specify the type of gas installed on each port.

3. Click OK to close the window and save the changes.

Field or Button Description
Calibration group boxes Displays calibration information for analyzer components.
Configuration group box Displays the IP address used by the analysis program and the serial

number of the selected analyzer.

l Change IP. Click to display the Unit IP Setup window. The IP address
and subnet mask assigned during installation display. Do not edit these
fields unless instructed by a Micromeritics service representative.

l Board ID. Click to display information from the electronic circuit
boards in the instrument.. These parameters cannot be edited.

Features group box Displays options installed on the analyzer.
Gas button Displays ports for gas selections.
Software Versions group
box

Displays the software versions of the MIC BIOS, controller, and analysis
program.

For fields and buttons not listed in this table, see the Common Fields and Buttons sec-
tion of this operator manual.

Unit Configuration Fields and Buttons Table
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PREVENTIVE MAINTENANCE

Perform the following preventive maintenance procedures to keep the analyzer operating at peak
performance. Micromeritics also recommends that preventive maintenance procedures and calibration be
performed by a Micromeritics Service Representative every 12 months.

Maintenance Required Frequency
Clean the Analyzer As required or every 6 months
Lubricate elevator screw As required or every 6 months. Use a light coat of lithium

grease.
Check analysis port dewar Weekly
Replace sample tube O-ring As required or every 3 months
Replace port filters Every 30 days
Replace diaphragm in vacuum
pump **

Every 12 months

Calibrate manifold temperature
sensor

Every 12 months

Calibrate system volume Every 12 months
Check analyzer outgassing rate Every 6 months
Test analyzer for leaks As required or every 12 months
Perform reference material ana-
lysis

As required or every 3 months

**   After about 12 to 18 months of operation, the diaphragm in the pump will wear out and
become completely inoperable. To prevent any instrument downtime due to an inoperable pump,
it is recommended that you have the diaphragm replaced by a Micromeritics Service
Representative every 12 months.

Preventive Maintenance
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12 Troubleshooting and Maintenance

CHECK THE DEWAR

Review Dewar Precautions on page 6 - 1 for information on handling dewars.

Always handle glass dewars with care. Any product incorporating a vacuum is a potential
safety hazard and should be treated with caution. If in doubt, contact your safety officer.

Ice and suspended frost particles may accumulate in the bottom of the analysis port dewar. Particles or
deposits exceeding 1/4 in. (0.64 cm) in depth may jam between the bottom of the sample tube and the
bottom of the dewar, causing the dewar not to raise fully. Accumulations of fine particles impede liquid
nitrogen circulation around the bottom of the sample tube. This causes the sample temperature to be
slightly higher which, in turn, can cause pore volume measurement errors in those samples exhibiting
high isotherm slope above 0.97 relative pressure. Accumulated ice is likely to melt and form a pool of
water in the dewar if all liquid nitrogen evaporates. The water must be removed; otherwise it will
solidify when liquid nitrogen is added and could press on the bottom of the sample tube causing
breakage.

To ensure problems do not develop due to ice accumulation, check the dewar after each use. Clean on a
weekly basis.

1. Remove the dewar from the instrument.

2. Pour out liquid nitrogen into an appropriate cryogenic container. Do not re-use liquid nitrogen.

Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes to burst.

3. Rinse the dewar with warm water to melt any remaining ice accumulation which may remain.
Dry thoroughly.

4. Replace the dewar.
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CLEAN THE ANALYZER

The exterior casing of the analyzer may be cleaned using a clean cloth, dampened with isopropyl alcohol
(IPA), a mild detergent, or a 3% hydrogen peroxide solution. Do not use any type of abrasive cleaner.

l Do not allow liquid to penetrate the casing of the analyzer. Doing so could result in dam-
age to the unit.

l Use only a mild detergent in water to clean safety shields. The use of isopropyl alcohol
can damage the shield surface.

LUBRICATE THE ELEVATOR DRIVE ASSEMBLY

The elevator screw is lubricated before it leaves the factory and should not require lubricating. If the
elevator starts to vibrate or becomes noisy when traveling, contact a Micromeritics Service
Representative for disposition.

Should lubrication become necessary, apply a light coat of lithium grease to the elevator screw, accessed
from the rear of the instrument, as needed.

Clean the Analyzer
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12 Troubleshooting and Maintenance

PORT FILTERS

Replace Port Filters

A porous metal filter is located in the analysis port and in each degas port. Using a contaminated filter
on the analysis port may extend the time required to achieve a vacuum at that port and the contaminant
may also adsorb or desorb during analysis, affecting the analysis results. A contaminated filter on the
analysis port may be detected by a leak test (if the contaminant outgasses) or by a free-space reading
much lower than normal.

Replace the Analysis Port Filter

To avoid analysis problems, the new filter and O-ring must be clean. Wear gloves when per-
forming this task. Do not touch the parts with bare hands.

1. Remove the dewar and sample tube (or plug).

2. Close the sample valve.

3. If the O-ring and filter are stuck in the port, use a fingernail or plastic instrument to remove them.
Using a metal instrument may scratch the sealing surface, causing a leak.

4. Replace the filter and the O-ring.

5. Carefully reassemble the sample tube fitting, filter, O-ring and manifold connector and hand
tighten. Then tighten with a wrench to prevent leaks when evacuated.
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REPLACE THE PSAT TUBE O-RING

1. Turn the connector nut counter-clockwise to loosen.

2. Pull the connector nut downward.

3. Gently pull the Psat tube downward to remove it from the Psat port.

4. Remove the O-ring from the Psat tube and replace with a new one.

5. Insert the Psat tube into the Psat port.

6. Slide the connector nut up to the Psat port and turn the connector nut clockwise to tighten.

Replace the Psat Tube O-ring
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12 Troubleshooting and Maintenance

REPLACE THE SAMPLE TUBE O-RING

It is important to maintain a vacuum-tight seal near the top of the sample tube stem. If an O-ring
becomes worn or cracked, it does not provide a good seal and will need to be replaced.

Before removing (or installing) a sample tube, ensure that the port valve is closed. Observe
the analyzer schematic to verify valve status.

1. Carefully remove the dewar from the elevator. Take care not to bump the sample tube bulbs with
the dewar during this process. Place the dewar aside.

2. Hold the sample tube firmly with one hand and loosen the sample tube connector nut by turning
counter-clockwise.

3. Carefully pull the sample tube down until it is free from the port. It may be necessary to grasp the
sample tube with both hands.

4. Remove the O-ring from the top of the sample tube and replace it with a new one.

If the O-ring remains inside the sample port, use a pair of tweezers or needle-nose pliers to
remove it.
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5. After the new O-ring is in place, insert the sample tube back into the sample port until it is fully
seated.

6. Slide the sample tube connector nut up the tube until it comes in contact with the port fitting (the
ferrule and O-ring will move along with the connector nut). Then, turning clockwise, hand tighten
the connector nut to the sample connector.

RECOVER FROM A POWER FAILURE
The analyzer saves entered and collected data in case of power failure. File parameters and any other
data entered will still be present when power is restored. If an analysis was in progress when the power
failure occurred, it will be canceled when the analyzer restarts. Any data collected during the analysis
will still be present, but the analysis should be restarted in order to produce complete results.

Recover from a Power Failure
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12 Troubleshooting and Maintenance

ENABLE MANUAL CONTROL

Unit [n] > Enable Manual Control

Use to enable the manual control of valves and the elevator. When this option is enabled, a checkmark
appears to the left of Unit [n] > Enable Manual Control. If the analyzer schematic is not immediately
visible, go to Unit [n] > Show Instrument Schematic. The schematic should display automatically when
manual control is enabled.

Valve Description
1 Unrestricted vacuum
2 Restricted vacuum
3 Helium inlet port valve
4 Restricted analysis gas
5 Unrestricted analysis gas
7 Lower manifold isolation
9 Sample port
10 Restricted Psat tube port
11 Unrestricted Psat tube port
P1 through P6 Gas inlet port valves
PS Supply valve for physisorption gases
PV Vacuum valve for physisorption gases

Analysis Valve Descriptions
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Icon or Symbol Description
Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve. When manual control is disabled,
closed valves appear white.

Elevator.

Sample Tube. Cannot be manually controlled.

Analyzer Schematic Icon Table

Enable Manual Control
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13 PARTS AND ACCESSORIES
Order system components and accessories using one of the following methods:

l Call our Customer Service Department at 1-770-662-3636

l Email orders to Orders@Micromeritics.com

l Contact your local sales representative

Part Number Item and Description
Analyzer Optional Equipment

021-00000-00 Model 021 LN2 transfer system, for easy filling of sample dewars;
includes 44 L dewar, mobile platform, and pump with 100 cm dis-
charge line

060-00000-24 FlowPrep 060, degasses up to six samples at up to 400 °C with flow-
ing gas. A gas source and regulator are required.

061-00000-24 VacPrep 061, degasses up to six samples at up to 400 °C; using flow-
ing gas or vacuum. A vacuum pump, gas source and regulator are
required.

065-00000-24 SmartPrep 065, Windows interface provides programmable ramp and
soak rate for degassing up to six samples with flowing gas. A gas
source and regulator are required.

246-33010-00 MicroPrep Option, temperature controller and heating mantle for in-
situ degassing.

Cables
003-63801-01 Cable, Ethernet straight-thru

Chiller Dewar Parts and Accessories
025-25820-00 Hose Assembly (replacement), for connecting the Chiller Dewar to a

recirculating bath (2 each required per Chiller Dewar assembly)
025-63801-00 Recirculating Bath Temperature Control RTD, replacement for the

RTD cable supplied in the Recirculating Bath Temperature Control
RTD Kit

Dewar and Accessories
025-00202-00 Chiller Dewar Option, permits connection of recirculating bath to

cryogen dewar to control analyses at a variety of temperatures.
025-26002-00 Recirculating Bath, -28 °C TO 200 °C, 230V 50HZ, refrigerated and

heating circulator for temperature control of the bath in the Chiller
Dewar.

025-26004-00 Recirculating Bath, -28 °C TO 200 °C, 115V 60HZ, refrigerated and
heating circulator for temperature control of the bath in the Chiller
Dewar.

13 Parts and Accessories

ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015

13 - 1

mailto:Orders@Micromeritics.com?subject=Parts and Accessories Inquiry


13 Parts and Accessories

Part Number Item and Description
025-33001-00 Recirculating Bath Temperature Control RTD Kit, optional RTD

mounted in the Chiller Dewar bath and connected to the recirculating
bath controller. Includes RTD cable assembly and mounting bracket.
Note: The connector on the RTD cable assembly is designed to plug
into a Micromeritics supplied recirculating bath.

202-14702-00 Dewar shield, for use with Chiller Dewar Option
202-25850-00 Dewar, 3 liter, analysis
202-31707-00 Dewar lid, analysis
240-25901-00 Dewar depth gauge

Gas Cylinder Accessories and Replacement Parts
004-25103-00 Ferrule, front, teflon 1/4 in., for use with 1/8 in. tube × 1/4 in. tube

reducer
004-25104-00 Ferrule, rear, nylon 1/4 in., for use with 1/8 in. tube × 1/4 in. tube

reducer
004-25549-00 Reducer, 1/8 in tube × 1/4 in. tube, brass, accepts 1/8 in. tube,

connects to 1/4 in. swage fittings
004-25913-00 1/8 Peek Ferrule Set for sealing gas inlet lines into th gas inlet man-

ifold assemblies
004-33601-00 Expansion Kit, adds an additional outlet to the gas regulator, includes

fittings and instructions
004-33602-00 Pressure Relief Kit, prevents excessive gas pressure in the event of

regulator failure (not to be used with toxic gases)
004-62230-32 Gas pressure regulator, CGA 320 fitting (CO2), 30 psig
004-62230-35 Gas pressure regulator, CGA 350 fitting (CO, H2), 30 psig
004-62230-54 Gas pressure regulator, CGA 540 fitting (O2), 30 psig
004-62230-58 Gas pressure regulator, CGA 580 fitting, 30 psig (He, N2, Kr, Ar)
004-62230-326 Gas pressure regulator, CGA 326 fitting (N2O), 30 psig
004-62230-705 Gas pressure regulator, CGA 705 fitting (NH3), 30 psig
201-25818-00 Gas Inlet Line, 6 ft, SS
201-25818-01 Gas Inlet Line, 16 ft (5 m), SS
290-25846-00 Gas Inlet Line, 1/8 in × 6 ft, copper
290-25846-01 Gas Inlet Line, 1/8 in × 16 ft (5 m), copper

Heating Mantle
003-26043-00 Heating mantle with type K thermocouple, 450 °C maximum, 24 V
003-26045-00 Heating mantle with type K thermocouple, 450 °C maximum, 24 V,

side-laced to accommodate monolithic & nonstandard sample tubes
230-25808-00 Heating mantle clip
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Part Number Item and Description
MicroPrep Parts and Accessories

003-26043-00 Heating mantle with type K thermocouple, 450 °C maximum, 24 V
230-25808-00 Heating mantle clip

Operating Supplies and Replacement Parts
004-25006-00 O-ring, size 006, Buna-N, for P0 tube
004-25466-00 O-ring, -010 70 Durometer Buna-N, for sealing frit in sample tube

port
004-27041-00 Frit, µm SS 1/4D × 1/16T, for replacement in sample tube port
004-54130-00 Removal tool for CheckSeal opener
200-25840-00 Saturation pressure tube, includes isothermal jacket
206-14701-00 Dewar shield, for use on sample port, cold trap, and degas ports
206-33010-06 Physisorption operating supplies (6 month supply), O-rings, sample

port frits, 1/8 Peek ferrule sets, sample tubes, filler rod.
206-33010-12 Physisorption operating supplies (12 month supply), O-rings, sample

port frits, 1/8 Peek ferrule sets, sample tubes, filler rods, sample tube
brush, isothermal jacket, dewar lid, sample tube stoppers, reference
material

Reference Material
004-16816-00 Reference material, low surface area (krypton)
004-16821-00 Reference material, high surface area
004-16843-00 Reference material, micropore, 13X
004-16844-00 Reference material, micropore, Y-zeolite

Sample Tube Accessories
004-54609-00 Brush for cleaning sample tube
004-54618-00 Tool, for removing sample port O-ring
202-33052-00 22 mm ID Sample Tube Kit (see table for kit contents)
240-14855-00 Sample tube rack
240-25853-00 Sample tube funnel
240-32805-00 Sample tube support, assists sample weighing

Software and Manuals
202-33027-00 MicroActive Software Package, interactive data analysis software
206-20800-00 ASAP 2060 Software program
206-33001-00 Software Package, ASAP 2060; includes current version of software

and operator manual.
206-42800-00 ASAP 2060 Operator Manual (includes binder and dividers)

Vacuum Pump and Accessories

13 Parts and Accessories
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13 Parts and Accessories

Part Number Item and Description
004-62023-01 Service kit, for Vaccubrand dry forepump
206-33002-00 Vacuum Connection Expansion Kit (2nd or 4th Unit). Tee, flexible

stainless steel tubing, centering rings, and clamps required for
connecting a 2nd or 4th unit to the free-standing hybrid-turbo vacuum
system.

206-33003-00 Vacuum Connection Expansion Kit (3rd Unit). Tee, flexible stainless
steel tubing, centering rings, and clamps required for connecting a
3rd unit to the free-standing hybrid-turbo vacuum system.

Valves
201-22600-00 Valve spring, for Buna-N plunger, for analysis manifold
250-25608-00 Valve gasket, Kel-F, for analysis manifold
250-25627-00 Valve plunger, Buna-N seal, for analysis manifold

SAMPLE TUBES AND COMPONENTS

Part Number Item and Description
A 004-25466-00 O-ring, size 010, Buna-N, for 1/4 in. sample tube
B 240-25803-00 Ferrule, 1/4 in.
C 004-32604-00 Cap (stopper) for 1/4 In. sample tube (not shown)
D 202-25901-00 Isothermal jacket, 1/4 in.
E 240-61001-00 Sample tube, 1/4 in.

1/4 in., 3/8 in., and 1/2 in.Sample Tubes
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Part Number Item and Description
F 240-61014-00 Volume displacement insert, 1/4 in.
G 004-25022-00 O-ring, size 012, Buna-N, for 3/8 in. sample tube
H 240-25802-00 Ferrule, 3/8 in.
I 004-32004-00 Stopper, for 3/8 in. sample tubes
J 202-25902-00 Isothermal jacket, 3/8 in.
K 240-61002-00 Sample tube, 3/8 in.
L 240-61015-00 Volume displacement insert, 3/8 in
M 260-25891-00 Opener, seal frit, for 1/2 in. sample tube
N 004-25044-00 O-ring, size 013, Buna-N, for 1/2 in. sample tube
O 260-25843-00 Ferrule, 1/2 in.
P 240-32000-00 Stopper, for 1/2 in. sample tube
Q 260-25890-00 Seal Frit with built-in check valve for air-sensitive samples
R 202-25903-00 Isothermal jacket, 1/2 in. sample tube
S 240-61003-00 Sample tube, 1/2 in.
T 240-61016-00 Volume displacement insert, 1/2 in.
U 300-25824-00 Nut, sample tube

1/4 in., 3/8 in., and 1/2 in.Sample Tubes (continued)

Part Number Item and Description
004-25609-02 O-ring, -022, 70 Buna-N
004-32230-00 Stopper, rubber, for 22 mm ID tube
202-25868-00 Fitting, sample port, 25 mm sample tube
202-25869-00 Nut, for 25 mm sample tube
202-25870-00 Ferrule for 25 mm sample tube
202-25871-00 Fitting, degas port, 25 mm sample tube
202-25904-00 Isothermal jacket, for 25 mm OD sample tube
202-31709-00 Dewar lid, 25 mm OD sample tube
202-61022-00 Sample tube, 22 mm ID, 25 mm OD
202-61022-01 Filler rod for 22 mm ID sample tube

22 mm Sample Tube Kit (part number 202-33052-00)

Sample Tubes and Components
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A CALCULATE FREE SPACE VALUES FOR MICROPORE
ANALYSES
Many microporous materials, such as zeolites and activated carbons, trap and hold helium in their
complex pore structures for many hours after being exposed to helium. Helium trapped in micropores can
interfere with the analysis at low pressures, causing an “S”-shaped curve at the lower end of the
isotherm. For this reason, it is recommended that you enter the warm and cold free-space volumes when
performing micropore analyses, therefore avoiding exposure of the sample to helium. Two techniques
can be used for determining warm and cold free-space values.

The first method is to perform a short analysis on the sample after partial degassing (one pressure point
with no incremental dosing), but prior to final sample preparation. Measure the free space during this
analysis. The measured free-space values will be printed on the report and may then be entered into the
sample file after more thorough sample preparation.

The second method requires prior tests using empty tubes that will be employed later for the sample
analyses. The measured free-space data can be used thereafter on every analysis performed using these
sample tubes. This small initial investment of time will save considerable time later. Perform an empty
tube analysis on each sample tube you intend to use for micropore analysis. Measure the free space of
each sample tube, taking only one pressure point.

1. Create a sample tube file from each empty tube test.

2. Use the Load from Sample File button to read in the measured free space from the empty tube
tests.

3. In the sample file for the sample analysis, pick the appropriate sample tube from the sample tube
list.

4. Enter the mass and density of the sample.

5. Choose Calculate in the free space options in the analysis conditions.

 






V V= −ws wm
M

ρ

T

T

s std

amb

where

Ms = mass of sample to be analyzed (in grams)
Tamb = ambient temperature (in kelvins)
Ts = approximate sample true density (in grams/cm3)
Tstd = standard temperature (273.15 K)
Vwm = warm free space measured for the empty tube (in cm3 STP/atm)
Vws = calculated warm free space with sample present (in cm3 STP/atm)

To correct cold free space:

A Calculate Free Space Values for Micropore Analyses
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A Calculate Free Space Values for Micropore Analyses

V V M T ρT= − ( ÷ )cs cm s std bath

ρ = approximate sample true density (in grams/cm3)
Ms = mass of the sample to be analyzed (in grams)
Tbath = analysis bath temperature (in kelvins)
Tstd = standard temperature (273.15 K)
Vcm = cold free space measured for the empty tube (in cm3 STP/atm)
Vcs = calculated cold free space with sample present (in cm3 STP/atm)

A - 2 ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015



B CALCULATIONS

ALPHA-S METHOD

The alpha-S curve is calculated from the reference isotherm by dividing each quantity adsorbed by the
quantity adsorbed at 0.4 relative pressure.

α Q Q= /s 0.4

where Q0.4 is found by linear interpolation.

A least-squares analysis fit is performed on the (αi,Q) pairs. The following are calculated:

a. Slope (s cm3/g STP)

b. Y-intercept (Q0 cm
3/g STP)

c. Uncertainty of the slope (cm3/g STP)

d. Uncertainty of the Y-intercept (cm3/g STP)

e. Correlation coefficient

Surface area is calculated as:

A A s Q= /s ref 0.4

where Aref is the entered reference surface area.

Pore size is calculated as:

V Q D= /p 0

B Calculations
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B Calculations

BET SURFACE AREA
The BET1 ) transformation is calculated as:

( )
y =

Q ρ ρ

1

/ − 1
0

A least-squares fit is performed on the (Prel, y). The following are calculated:

a. Slope (S cm3/g STP)

b. Y-intercept (y0 cm
3/g STP)

c. Uncertainty of the slope (u(s) cm3/g STP)

d. Uncertainty of the Y-intercept (u(y0) cm
3/g STP)

e. Correlation coefficient

Using the results of the above calculations, the following can be calculated:

BET Surface Area (m2/g):

A =
( )

A N

V
m nms × 10

−18 2
/

2m A

m s+y 0

BET C value:

C s y= / − 1
0

Quantity in the Monolayer (cm3/g STP):

Q Cy= 1 / =
s ym 0

1

+
0

Error of the BET Surface Area (m2/g):

( ) ( )
u A( ) =s

u s u y

s y

+

+

2 2
0

0

1 ) Brunauer, S.; Emmett, P.H.; and Teller, E., J. Am. Chem. Soc. 60, 309 (1938).
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BJH PORE VOLUME AND AREA DISTRIBUTION
For adsorption data, the relative pressure and quantity adsorbed data point pairs collected during an
analysis must be arranged in reverse order from which the points were collected during analysis. All
calculations are performed based on a desorption model, regardless of whether adsorption or desorption
data are being used.

The data used in these calculations must be in order of strictly decreasing numerical value. Points which
do not meet this criterion are omitted. The remaining data set is composed of relative pressure (P),
quantity adsorbed (Q) pairs from (P1, Q1) to (P, Qn) where (Pn = 0, Qn = 0) is assumed as a final point.
Each data pair represents an interval boundary (or desorption step boundary) for intervals i=1 to i=n-1
where n = total number of (P, Q) pairs.

Generally, the desorption branch of an isotherm is used to relate the amount of adsorbate lost in a
desorption step to the average size of pores emptied in the step. A pore loses its condensed liquid
adsorbate, known as the core of the pore, at a particular relative pressure related to the core radius by
the Kelvin1 ) equation. After the core has evaporated, a layer of adsorbate remains on the wall of the
pore. The thickness of this layer is calculated for a particular relative pressure from the thickness
equation. This layer becomes thinner with successive decreases in pressure, so that the measured
quantity of gas desorbed in a step is composed of a quantity equivalent to the liquid cores evaporated in
that step plus the quantity desorbed from the pore walls of pores whose cores have been evaporated in
that and previous steps. Barrett, Joyner, and Halenda2 ) developed the method (known as the BJH
method) which incorporates these ideas. The algorithm used is an implementation of the BJH method.

EXPLANATION OF TERMS

A pore filled with condensed liquid nitrogen has three zones:

a. The core - evaporates all at once when the critical pressure for that radius is reached; the rela-
tionship between the core radius and the critical pressure is defined by the Kelvin equation.

b. The adsorbed layer - composed of adsorbed gas that is stripped off a bit at a time with each pres-
sure step; the relationship between the thickness of the layer and the relative pressure is defined
by the thickness equation.

c. The walls of the cylindrical pore - the diameter of the empty pore is required to determine the
pore volume and pore area. End area is neglected.

1 ) Kelvin, J. (published under the name of Sir William Thomson), Phil. Mag. 42, 448-452 (1871).
2 ) Barrett, E.P.; Joyner, L.S.; and Halenda, P.., J. Am. Chem. Soc. 73, 373-380 (1951).

BJH Pore Volume and Area Distribution

ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015

B - 3



B Calculations

CALCULATIONS

The quantities adsorbed (Qa) are converted to the liquid equivalent volumes (Vl, cm3/g):

Vl =i
Q V

cm STP22414

i mol

3

where Vmol is the liquid molar volume from the fluid property information.

The relative pressure (Pi) is assumed to be close to unity so that substantially all the pores in the sample
are filled.

The corresponding Kelvin core radius is calculated. Only pores smaller than this size will be included:

( ) ( )
Rc =i

A

F P

−

1 + ln i

where
A = adsorbate property factor (from the BJH Adsorptive Options window)
F = fraction of pores open at both ends (from the BJH Adsorption Report Options

window or the BJH Desorption Report Options window); assumed to be
zero for desorption

Rc = Kelvin radius (Å) of core

This radius will be adjusted for the thickness of the adsorbed layer during subsequent calculation steps.

The following calculations (a-c) are made for each relative pressure interval based on the increment of
volume desorbed during that interval:

where
i = interval number, that is i=1 for the first interval from P1 to P2, and so on
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j = each previous interval during which new pores were found
k = the total number of intervals in which new pores have been found. It is also

the number of lines reported on the BJH table for collected data

a. The thickness of the adsorbed layer at the end of the interval is calculated using the equation
located in Thickness Curve on page B - 45.

For the last pressure interval from the lowest Pri to zero relative pressure, reference the
calculations from the equations in Thickness Curve on page B - 45.

For the first pressure interval, there are no previously opened pores so the volume of liquid
desorbed from walls of previously opened pores is zero (Vd1 = 0), and the remainder of Step (a) is
skipped.

The change in thickness of the wall layer due to desorption from previously opened pores is
calculated as:

Tw Tw Tw∆ = −
i1 +1

The annular cross-sectional area of the wall layer desorbed is calculated for all previously
opened pores:



























CSA π Rc Tw Rc= + ∆ − 10j j j

cm
2

2 −16

Å

2

2

The total volume of gas desorbed from walls of previously opened pores is calculated:


















ΣVd LP CSAa=i

j
j j

for all previously opened pores

where LPj = length of previously opened pores as calculated in Step b(2).

b. The physical processes occurring for this pressure interval are determined as:

1. If Vdj is greater than the current increment of volume desorbed (Vli - V1i+1), desorp-
tion from walls only is occurring. Total surface of walls exposed thus far (cm2/g) is
calculated as:



























ΣSA π LP D=w

j
j avg j

cm
,

10

Å

−8 for all previously opened
pores

Calculations
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B Calculations

where
Davg,j = weighted average pore diameter calculated in Step b.2.

A new layer thickness (ΔTw) that will not overcompensate for the actual volume desorbed
in this interval is calculated:




















Tw∆ =

Vl Vl

SAw

− 10i i cm

i

+1
8 Å

Since no cores are evaporated in this pressure interval, no new pores are revealed. Thus no
ending Kelvin radius and average pore diameter are calculated for this interval. Note that
this means the report may have fewer tabulated intervals on the collected data report than
experimental pressure intervals.

2. If Vdi is less than the volume increment desorbed during this interval (Vli-Vli+1), the
remaining volume is due to new pores with core evaporation taking place in this inter-
val. K, the number of intervals with new pores exposed, is increased by 1. (For the
interval from the lowest Pr1 to zero relative pressure, no new pore volume is cal-
culated and the rest of Step b is skipped.)

The volume desorbed from newly opened pores in this interval is calculated as:

Vc VI VI Vd= ( − ) −i i i i+1

The Kelvin radius for the end of the interval is calculated as:

( ) ( )
Rc =k

A

F P
+1

−

1 + ln i+1

All new pores opened in this interval are represented by one pore having a length-weighted
average pore diameter and a corresponding length sufficient to account for the required
volume of adsorbate. The weighted average pore diameter is calculated as:

D =avg k
Rc Rc Rc Rc

Rc Rc
,

2( + ) ( ) ( )

+

k k k k

k k

+1 +1

2
+1
2

Davg,k is the diameter of a pore which would have a surface area that is the average of the
areas for pores radius Rck and Rck+1, if its length was the mean of the lengths at those radii.

The relative pressure corresponding to Davg,k is calculated as:
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









( ) ( )

P = lnavg k
A

F D
,

exp −2

1 + avg k,

The thickness of the adsorbed layer at this pressure is calculated as:











( )

Tw HP= 1avg k
HP

P

HP

,
2

ln

3

avg k,

The decrease in thickness of the wall layer by desorption from the walls of new pores
during the lower portion of the pressure interval is calculated as:

∆Td Tw Tw= −avg k i, +1

The cross-sectional area of the newly opened pores is calculated as:


















CSAc ∆Td= +k

cm

2

2
10

Å

avg k,
−16 2

2

The length of the newly opened pores is calculated as:

LP =k

Vc

CSAc

i

k

Pore diameters and radii are adjusted for the change in thickness of the adsorbed wall layer
during this interval. If new pores were opened during this interval, the average diameter is
adjusted by the change in layer thickness during the second portion of the desorption interval
as:

( )D D ∆Td= + 2avg k new avg k old, , , ,

The layer thickness change during the whole interval is added to diameters of previously
opened pores as:

( )D D ∆Tdw= + 2avg k new avg k old, , , ,

(not including Davg,k)

The layer thickness change desorbed during this interval also is added to the radii
corresponding to the ends of the pressure intervals as:

Calculations
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B Calculations

Rc Rc ∆Tw= +j new j old, ,

for all except Rck+1.

Steps a to c are repeated for each pressure interval.

After the above calculations have been performed, the diameters corresponding to the ends
of the intervals are calculated as:

( )Dp Rc= 2
j j

for all Rcj including Rck+1.

The remaining calculations are based on Dpi, Davg,i, and LPi These calculations are only
done for Davg,i values that fall between the Minimum BJH diameter and the Maximum
BJH diameter specified by the operator on the BJH Adsorption Report Options window or
the BJH Desorption Report Options window.

(1) Incremental Pore Volume (Vpi, cm
3/g):



























Vp π L=

i i

D cm

2

2
10

Å

avg i,
16 2

2

(2) Cumulative Pore Volume (Vpcum,i, cm
3/g):









ΣVP Vp for J= ≤ 1cum i

j
j,

(3) Incremental Surface Area (SAi, m
2/g):




































SA π LP D=i i

m

cm avg i
m10

,
10

Å

−2 −10

(4) Cumulative Surface Area (SAcum,i, m
2/g):

SA SA J= ∑ for ≤ 1cum j,10

(5) dV/dD pore volume (dV/dDi, cm
3/g-A):

=
dV

dD

VP

Dp Dp−i

i

i i+1
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(6) dV/dlog(D) pore volume (dV/dlog(D)i, cm
3g):











=
dDv

d D

VP

log
logi

i

Dpi

Dpi+1

(7) dA/dD pore area (dA/dDi, m
2/g-A):

=
dA

dD

SA

Dp Dp−i

i

i i+1

(8) dA/dlog(D) pore area [dA/dlog(D)i, m
2/g]:











=
dA

d D

SA

log
logi

i

Dpi

Dpi+1

For fixed pore size tables (if selected), the following calculations are performed:

(1) Average Fixed Pore Size (DFavg,j, A):

DF =avg j

DP Dp

,

+

2

F j F j+1

calculated for all intervals in the fixed pore size table.

For the intervals with between the Minimum BJH diameter and the Maximum BJH
diameter.

(2) Cumulative Pore volume (VpFcum,i, cm
3/g):

( )VpF DpFcum i INTERP i, = +1

where INTERP(x) is the value interpolated from the function X = Dpj+i and

Y = VPcum,i, using an AKIMA semi-spline interpolation.

(3) Incremental Pore Volume (VpFi, cm
3/g):

VpF VpF VpF= −i cum i cum i, , −1

where VpFcum,0 = 0.

(4) Cumulative Surface Area (SAFcum,i, m
2/g):

Calculations
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B Calculations

( )SAFcum i INTERP DpFi, = +1

where INTERP(x) is the value interpolated from the function X = Dpj+i and

Y = SAcum,j.

(5) Incremental Surface Area (SAFi, m
2/g):

SAF SAF SAF= −i cum i cum, i−1

where SAFcum,0 = 0.

(6) dV/dD pore volume (dV/dDpFi, cm
3/g-A):











dV

dDpF
INTERP DpFi=

+1
i

where INTERP(x) is the value interpolated from the function X = Davg,j and

Y = dV/dDj.

(7) dV/dlog(D) pore volume [dV/dlog(DpFi), cm
3/g]:









( )

dV

d DpF
INTERP DpFilog

= +1
i

where INTERP(x) is the value interpolated from the function X = Davg,j and

Y = dV/dlog(D)j.

(8) dA/dD pore area (dA/dDpFi, m
2/g-A):











dA

dDpF
INTERP DpFi

1
= +1

where INTERP(x) is the value interpolated from the function X = Davg,j and

Y = dA/dDj.

(9) dA/dlog(D) pore area [dA/dlog(DpFi), m
2/g]:









( )

dA

d DpF
INTERP DpFilog

= +1
i
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where INTERP(x) is the value interpolated from the function X = Davg,j and

Y = dA/dlog(D)j.

COMPENDIUM OF VARIABLES

ΔTd = thickness of layer desorbed from walls of newly opened pores (Å)
ΔTw = thickness of adsorbed layer desorbed during interval (Å)
A = adsorbate property factor; from the BJH Adsorptive Options window
CSA = analysis gas molecular cross-sectional area (nm2), user-entered on the

Adsorptive Properties window
CSAa = annular cross-sectional area of the desorbed layer (cm2)
CSAc = cross-sectional area of opening of newly opened pores (cm2)
Davg = average pore diameter (Å)
Dp = pore (or core) diameter (Å)
F = fraction of pores open at both ends; from the BJH Adsorption Report

Options window or the BJH Desorption Report Options window
LP = length of pore (cm/g)
P = relative pressure
Q = quantity adsorbed expressed as a volume (cm3/g STP)
Rc = Kelvin radius (Å) of core
SAw = total surface area of walls exposed (cm2/g)
Tw = thickness of remaining adsorbed wall (Å)
Vc = volume desorbed from cores of newly opened pores (cm3/g)
Vd = volume of gas desorbed from walls of previously opened pores (cm3/g)
Vl = liquid equivalent volume of volume adsorbed (cm3/g)
Vmol = liquid molar volume, from the fluid property information

Compendium of Variables
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B Calculations

DFT (DENSITY FUNCTIONAL THEORY)
The adsorption isotherm is known to convey a great deal of information about the energetic heterogeneity
and geometric topology of the sample under study. The data of physical adsorption have been used for
many years as the basis for methods to characterize the surface area and porosity of adsorbents. Real
solid surfaces rarely approach ideal uniformity of structure. It is accepted that in general, the surface of
even a nonporous material presents areas of greater or lesser attraction for adsorbed molecules.

This energetic heterogeneity greatly affects the shape of the adsorption isotherm with the result that
simple theories such as the Langmuir and BET formulas can, at best, give only approximate estimates of
surface area. Porous solids virtually are never characterized by a single pore dimension, but instead
exhibit a more or less wide distribution of sizes. The observed adsorption isotherm for a typical material
is therefore the convolution of an adsorption process with the distribution of one or more properties
which affect that process. This was first stated mathematically by Ross and Olivier1 ) for the case of
surface energy distribution and has become known as the integral equation of adsorption.

THE INTEGRAL EQUATION OF ADSORPTION

In a general form for a single component adsorptive, the integral equation of adsorption can be written as

( ) ( ) ( )∫Q p da db dc q p a b c f a b c= ... ,  ,  ,  ... ,  ,  ... (1)

where
Q(p) = the total quantity adsorbed per unit weight at pressure p,
a,b,c,... = a set of distributed properties,
ƒ(a,b,c,...) = the distribution function of the properties, and
q(p,a,b,c,...) = the kernel function describing the adsorption isotherm on unit surface of

material with fixed properties a,b,c,...

Equation (1), a Fredholm integral of the first kind, is a member of a class of problems known as ill-
posed, in that there are an infinite number of functional combinations inside the integral that will provide
solutions. Even when the kernel function is known, experimental error in the data can make solving for
even a single distribution function a difficult task. Solving for multiple distribution functions requires
more data than provided by a single adsorption isotherm.

1 ) Ross and Olivier, J.P., “On Physical Adsorption,” J. Wiley and Sons, New York (1964).
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APPLICATION TO SURFACE ENERGY DISTRIBUTION

Under certain conditions, an energetically heterogeneous surface may be characterized by a distribution
of adsorptive energies. The conditions are that the sample is not microporous, i.e., that adsorption is
taking place on essentially a free surface with no pore filling processes at least to about 0.2 relative
pressure. Secondly, that each energetically distinct patch contributes independently to the total adsorption
isotherm in proportion to the fraction of the total surface that it represents. This condition is satisfied if
the patches are relatively large compared to an adsorptive molecule, or if the energy gradient along the
surface is not steep. In mathematical terms, this concept is expressed by the integral equation of
adsorption in the following form.

( ) ( ) ( )∫Q p d q p f= ϵ , ϵ ϵ (2)

where
Q(p) = the experimental quantity adsorbed per gram at pressure p,
q(p,ε) = the quantity adsorbed per unit area at the same pressure, p, on an ideal

free surface of energy ε, and
ƒ(ε) = the total area of surface of energy ε in the sample.

The exact form of the energy-dependent term depends on the form of the model isotherms expressed in
the kernel function and is provided in the model description.

APPLICATION TO PORE SIZE DISTRIBUTION

Similarly, a sample of porous material may be characterized by its distribution of pore sizes. It is
assumed in this case that each pore acts independently. Each pore size present then contributes to the
total adsorption isotherm in proportion to the fraction of the total area of the sample that it represents.
Mathematically, this relation is expressed by

( ) ( )∫Q p dH q p H f H=  ,  ( ) (3)

where
Q(p) = the experimental quantity adsorbed at pressure p,
q(p,H) = the quantity adsorbed per unit area at the same pressure, p, in an ideal pore

of size H, and
ƒ(H) = the total area of pores of size H in the sample.

Numerical values for the kernel functions in the form of model isotherms can be derived from modern
statistical mechanics such as density functional theory or molecular simulations, or can be calculated
from one of various classical theories based on the Kelvin equation. Several types are found in the
models library.

Application to Surface Energy Distribution
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B Calculations

PERFORMING THE DECONVOLUTION

The integrations in equations (2) and (3) are carried out over all surface energies or pore sizes in the
model. The functions q(p,ε) and q(p,H), which we call the kernel functions, are contained in numeric
form as model isotherms. Because, in general, there is no analytic solution for equation (1), the problem
is best solved in a discrete form; the integral equation for any distributed property Z becomes a
summation

     























ΣQ p q p Z f Z= , (4)
i

i i

Given a set of model isotherms, q(p,Z), from a model chosen from the models library and an
experimental isotherm, Q(p), contained in a sample information file, the software determines the set of
positive values f(Z) that most nearly, in a least squares sense, solves equation (4). The distributed
property, surface energy or pore size, is then displayed on the Report Options window as a selection of
tables or graphs.

REGULARIZATION

DFT allows a selectable regularization (also referred to as smoothing) constraint to be applied during the
deconvolution process to avoid over-fitting in the case of noisy data or ill-fitting models. The method
used is based on co-minimization of the second derivative of the distribution. The relative weight given
to this term is determined by the value of the regularization parameter, which is set on the DFT Pore
Size or Surface Energy window and also is shown in the header of reports. The value of the
regularization parameter varies from zero (for no second derivative constraint) to ten (indicating a
weight equal to minimizing the residuals), or even larger. When the distribution and residuals obtained
change little with the value of the regularization parameter, it indicates that the chosen model provides a
good representation of the data. Conversely, a large sensitivity to the regularization parameter might
indicate inadequate data or a poor choice of model to represent the data.
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DOLLIMORE-HEAL ADSORPTION
The calculations for the Dollimore-Heal reports are the same as those for BJH, except for the
calculation of average pore diameter and pore length.

PORE DIAMETER

Pore diameter is determined from the Kelvin radius and thickness equation:

D r P tP= 2 +i k i i

The average pore diameter is the arithmetic mean of the diameters that bound the interval.

( )D =i
D D+

2

i i+1

PORE LENGTH

l =i
A

πD

+ 10i

i

,
8

( )
A =p i

∆V

,

4 × 10 p

i

8

( ( ) ( ))V Cυ D Q Q t A πtl∆ = − − ∆ ×10 − 2
i i c m i c m−1

8
, ,

 






Cv =
D

r t P t P2( + ( ) − ( )

2
i

k i i+1

t =
D

r2 −

i

k

( )
r =k

r r+

2

k i k i, , +1

where
ΔVp = Change in pore volume

Dollimore-Heal Adsorption

ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015

B - 15



B Calculations

Ap,i = Pore surface area
Ap,i,cum, li,cum = Summations over the lengths and areas calculated so far
Cv = Volume correction factor
D = Density conversion factor
rk = Average Kelvin radius

t = Average thickness
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DUBININ-ASTAKHOV
The Dubinin-Astakhov equation is:

       
























Q Qlog = log − × log
RT

βE

P

P

N

0
0

0

where
β = the affinity coefficient of the analysis gas relative to the P0 gas, from the

Dubinin Adsorptive Options window
E0 = characteristic energy (kj/mol)
N = Astakhov exponent, may be optimized or user entered from the Dubinin

Report Options window
P = equilibrium pressure
P0 = saturation vapor pressure of gas at temperature T
Q = quantity adsorbed at equilibrium pressure (cm3/g STP)
Q0 = the micropore capacity (cm3/g STP)
R = the gas constant (0.0083144 kj/mol)
T = analysis bath temperature (K)

For each point designated for Dubinin-Astakhov calculations, the following calculations are done:

LV Q= log( )

( )LP = log
P

P

N
0

A least-squares fit is performed on the (LP,LV) designated pairs where LP is the independent variable
and LV is the dependent variable. If the user selected Yes for the Optimize Astakhov Exponent prompt, a
systematic search for the optimum value of N is conducted by recalculating the linear regression and
selecting the value of N that gives the smallest standard error of the y-intercept. The exponent N is
optimized to within 10-4. If the optimum value for N is not found in this range, an exponent of 2 is used.
The following are calculated:

a. Slope (S cm3/g STP)

b. Y-intercept (YI cm3/g STP)

c. Error of the slope (Serr cm
3/g STP)

d. Error of the y-intercept (YIerr cm
3/g STP)

Dubinin-Astakhov
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B Calculations

e. Correlation coefficient

f. Optimized Astakhov exponent (N)

Using the results of the above calculations, the following can be calculated:

Monolayer Capacity (cm3/g STP):

Q = 10
YI

0

Micropore Volume (cm3/g):

V =i
Q V

22414

i mol

where
Vmol = liquid molar volume conversion factor from the fluid property information

Limiting Micropore Volume (cm3/g):

V =
Q V

cm STP
0

22414

mol0

3

where
Vmol = liquid molar volume from the fluid property information

Error of Limiting Micropore Volume (cm3/g):

( )V W YI= 10 − 1.0err err0, 0

Characteristic Energy (KJ/mol):

( )
E =

RT

β S

2.303( )

2.303 ×
N1/

Modal Equivalent Pore Diameter (Å):




























⋅
D = 2 ×mode

N

N

N
nm

β E

3

3 + 1

1/

10 / Å

1/3
3 3 3

0

where
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β  = affinity coefficient of the analysis gas relative to the P0 gas from the Dubinin
Adsorptive Options window

Maximum Differential Pore Volume (cm3/g-Å):

This value is also known as frequency of the mode1 ) .











































































   

⋅

















Max N W= 0.5 3 + 1 exp −
dV

dD

N

N

N

β E

nm

N

N0
3 + 1

3

1/3

10 / Å

1/3

3 + 1

3emod

0

3 3 3

Mean Equivalent Pore Width (Å):



























⋅

( )
D = 2 ×mean

Γ

1/3
nm

β E

N

N

103 3 / Å
3

0

3 + 1

3

Micropore surface area (m2/g):





 ( )SDA W= 1000×2.0 × × × Γ

E

k

N

N
0

1/3
3 + 1

3

0

Γ is calculated by a polynomial approximation over the domain 0 ≤ × ≤ 1:

( ) ( )x b x b x b x b x b x b x b x b x x xΓ + 1 = 1 + + + + + + + + + ϵ ϵ ≤ 3 101 2
2

3
3

4
4

5
5

6
6

7
7

8
8 −7

where
b1 = -0.57719 1652
b2 = 0.98820 5891
b3 = -0.89705 6937
b4 = 0.91820 6857
b5 = -0.75670 4078
b6 = 0.48219 9394

1 ) Ross and Olivier, J.P., “On Physical Adsorption,” J. Wiley and Sons, New York (1964).

Dubinin-Astakhov
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B Calculations

b7 = -0.19352 7818
b8 = 0.03586 8343

and where

( )x + 1 =
N

N

3 + 1

3

Equivalent Pore Diameter (Å):


































⋅

( ) ( )
D = 2i W W

N

−

ln − ln

1/3

nm

β E

N

i

103 3 / Å
3

0

0

dV/dD Pore Volume (cm3/g-Å):















































⋅ ⋅
W N= 0.5 × × 3 × exp −

dV

dD

nm

β E

D
N

nm

β E

N
D

N

0
10 / Å

2

−(3 +1)
10 / Å

2

−3

i

N
i i

3 3 3

0

3 3 3

0
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DUBININ-RADUSHKEVICH
The Dubinin-Radushkevich1 ) equation is:











































Q Q
BT

β

P

P
log = log

0
− × log

2
2

0

where
β = the affinity coefficient of analysis gas relative to P0 gas (for this application

β is taken to be 1)
B = a constant
P0 = saturation vapor pressure of gas at temperature T
P = equilibrium pressure
Q = quantity adsorbed at equilibrium pressure (cm3/g STP)
Q0 = the micropore capacity (cm3/g STP)
T = analysis bath temperature (K), from the P0 and Temperature Options win-

dow

For each point designated for Dubinin-Radushkevich calculations, the following calculations are done:

LV Q= log( )

( )LP = log
P

P

2
0

The intercept, log(Vo) can be found by performing a least-squares fit on the (LP,LV) designated pairs
where LP is the independent variable and LV is the dependent variable. Assuming the adsorption of gas
is restricted to a monolayer, Vo is the monolayer capacity. Based on this assumption, the following are
calculated:

a. Slope (S cm3/g STP)

b. Y-intercept (YI cm3/g STP)

c. Error of the slope (Serr cm
3/g STP)

1 ) Dubinin, M., Carbon 21, 359 (1983); Dubinin, M., Progress in Surface and Membrane Science
9, 1, Academic Press, New York (1975); Dubinin, M. and Astakhov, V., Adv. Chem. Ser. 102, 69
(1971); Lamond, T. and Marsh, H., Carbon 1, 281, 293 (1964); Medek, J., Fuel 56, 131 (1977);
Polanyi, M., Trans. Faraday Soc. 28, 316 (1932); Radushkevich, L., Zh. fiz. Kemi. 33, 2202
(1949); Stoeckli, H., et al, Carbon 27, 125 (1989).

Dubinin-Radushkevich
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B Calculations

d. Error of the y-intercept (YIerr cm
3/g STP)

e. Correlation coefficient

Using the results of the above calculations, the following can be calculated:

Monolayer Capacity (cm3/g STP):

Q = 10
YI

0

Error of Monolayer Capacity (cm3/g STP):

( )Q Q= 10 − 1.0
err

YI err

0, 0
,

Micropore surface area (m2/g):











SDP =
σ Q N

cm22414

A

nm

m

0

3 10
18 2

2

where
σ = molecular cross sectional area of gas (nm2) from the Adsorptive Properties

window
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EQUATION OF STATE
The ideal gas law relates pressure, volume, temperature, and quantity of gas.

n =
PV

RT

where
P = pressure
V = volume
R = a constant that depends on the units of n

For n in cm3 STP, R = PSTD / TSTD

For n in moles, R = 8.3145 J mol-1 K-1

T = temperature

The non-ideality correction is made by replacing P with P(1 + ɑP), where ɑ is the non-ideality factor.
This gives

( )n αP= 1 +
PV

RT

The real gas equation of state uses

n =
PV

RT P T( , )z

where z(P,T) is the compressibility factor for the gas at the given pressure and temperature.

Equation of State
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B Calculations

EQUILIBRATION
Equilibration is reached when the pressure change per equilibration time interval (first derivative) is less
than 0.01% of the average pressure during the interval. Both the first derivative and average pressure are
calculated using the Savitzky-Golay1 ) convolution method for polynomial functions. The following
equations are those used to compute weighted average and first derivative, respectively, for the 6th point
of an 11-point window.

P =avg
P P P P P P P P P P P−36( + ) + 9( + ) + 44( + ) + 69( + ) + 84( + ) + 89( )

429

11 1 10 2 9 3 8 4 7 5 6

P =chg
P P P P P P P P P P5( − ) + 4( − ) + 3( − ) + 2( − ) + ( − )

110

11 1 10 2 9 3 8 4 7 5

P = 100%pcp i

P

P,
chg

avg

pressure change per equilibration time interval

where the numerical constants are from the Savitzky-Golay convolution arrays, and
Pavg = average pressure
Pchg = change in pressure
Ppcp,i = percent change per interval
Pi = ith pressure reading taken at equilibrium intervals

If a non-zero value that is too small is entered for the maximum equilibration time, the
points are collected before equilibration is reached.

If Pavg is greater than 0.995 times the current P0, equilibration will not take place until the
Minimum equilibration delay for P/P0 0.995 has expired, in addition to the standard equi-
libration criteria.

1 ) Savitzky, A. and Golay, M.J.E., Anal. Chem. 36, 1627 (1964).
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F-RATIO METHOD

The f-Ratio is the quantity adsorbed divided by the quantity adsorbed in a reference isotherm at the same
pressure.

f =
i

Q

Q P

i

ref i

The reference quantity adsorbed is found by spline interpolation of the reference isotherm.

FREUNDLICH ISOTHERM
The Freundlich isotherm has the form

CP=
Q

Q
m
1

m

where
C = temperature-dependent constant
m = temperature-dependent constant
P = equilibrated collected pressure measured by gauge at temp Tamb
Q = quantity of gas adsorbed
Qm = quantity of gas in a monolayer

The pressure is absolute; typically, m > 1. In terms of quantity adsorbed,

Q Q CP=
m

m
1

Taking the log of both sides yields

Q Q C Plog = log + log
m m

1

f-Ratio Method
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B Calculations

HEAT OF ADSORPTION
The adsorption isostere is represented by

 






Cln = +
P

P

q

RT

i

0

where
qi = isosteric heat of adsorption
C = unknown constant
R = gas constant
T = analysis temperature

The isosteric heat of adsorption, qi, is determined by finding the slope of ln (P/P0) as a function of 1/RT
for a set of isotherms measured at different temperatures.
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HORVATH-KAWAZOE

A relative pressure lower limit is determined such that L-d0 never equals zero. All pressure points less
than this limit are discarded. For each collected relative pressure point, values of L are chosen in an
iterative manner, and the relative pressure (P/P0) determined by solving one of the following equations:

l Slit Pore Geometry (original Horvath-Kawazoe)

l Cylinder Pore Geometry (Saito / Foley)

l Sphere Pore Geometry (Cheng / Yang)

SLIT PORE GEOMETRY (ORIGINAL HORVATH-KAWAZOE)

When using the original Horvath-Kawazoe1 ) method, the following equation is solved for each value
of P. The value of L is determined when the solved-for relative pressure is within 0.1% of the collected
absolute pressure.

ln = − − +
P

P

K

RT

IP

σ L d

σ

L d

σ

L d

σ

d

σ

d

×10

− 2 3 − 9 − 3 90

32

4

0

4

0

3

10

0

9

4

0

3

10

0

9

where
1032 = the number of Å4 that are equal to 1 cm4

α = gas solid nuclear separation at zero interaction energy (Å),Z Z+

2

S A

d0 = D D+

2

A S

DA = molecular diameter (Å) from the Horvath-Kawazoe Physical
Properties window

DS = diameter of sample atom (Å) from the Horvath-Kawazoe
Physical Properties window

IP = interaction parameter (erg-cm4) from the Horvath-Kawazoe Report Options
window

K = Avogadro Constant (NA)
L = pore width (nucleus to nucleus) (Å)
K = Avogadro Constant (NA)
P = equilibrium pressure

1 ) Horvath, G. and Kawazoe, K., J. Chem. Eng. Japan 16(6), 470 (1983).

Horvath-Kawazoe
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B Calculations

P0 = saturation pressure
R = gas constant (8.31441 × 107 erg/mol K)
T = analysis bath temperature (K), from an entered or calculated value on the P0 and

Temperature Options window

where:

Zs = sample equilibrium diameter at zero interaction energy (Å)
from the Horvath-Kawazoe Physical Properties window

ZA = zero interaction energy diameter from the Horvath-Kawazoe
Physical Properties window

CYLINDER PORE GEOMETRY (SAITO/FOLEY)

When using the Saito/Foley1 ) method, the following equation is solved for each value of P. The value
of L is determined when the solved-for relative pressure is within 0.1% of the collected absolute
pressure.
























































α βln = × × Σ 1 − × −

P

P

πK

RT

IPx

d k k

d

r

k

k
d

r k

d

r

3

4

10

=0

∞
1

+ 1

2

21

32

10 4

0

32

0

4

0 0 0

where
1032 = the number of Å4 that are equal to 1 cm4

βk =
( ) β β, = 1.0

k

k k

−1.5 −
2

−1 0

αk =
( ) a a, = 1.0

k

k
k

−4.5 −
2

−1 0

d0 = D D+

2

A S

where
DA = molecular diameter (Å) from the Horvath-Kawazoe

Physical Properties window
DS = diameter of sample atom (Å) from the Horvath-

Kawazoe Physical Properties window
IP = interaction parameter (10-43 erg-cm4) from the Horvath-Kawazoe Report

Options window
K = Avogadro Constant (NA)

1 ) Saito, A. and Foley, H. C., AlChE Journal 37(3), 429 (1991).
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L = pore width (nucleus to nucleus) (Å)
P = equilibrium pressure
Po = saturation pressure
R = gas constant (8.31441 × 107 erg/mol K)
rp = radius of the cylindrical pore, L

2

T = analysis bath temperature (K), from an entered or calculated value on the Po
and Temperature Options window

SPHERE PORE GEOMETRY (CHENG/YANG)

When using the Cheng / Yang1 ) method, the following equation is solved for each value of P. The
value of L is determined when the solved-for relative pressure is within 0.1% of the collected absolute
pressure.























































ln = − + + +

P

P

N ε N ε L

RTL d

d

L

T T d

L

T T6 * + * ×10

−

6

12 8

12

90 800

1 12 2 22

3 32

0

3

0 1 2 0 3 4

where
1032 = the number of cm4 that are equal to Å4

ε*12 = ( )
where, Å =

d
s

mc a aÅ

4

6

+

S

s

S A

aS

XS

aA

XA

6

2

ε*22 = ( )( )( )
where, Å =

A

D
A

mc a X

4

3

2
A

A

A A

6

2

d0 = D D+

2

A S

where
DA = molecular diameter (Å) from the Horvath-

Kawazoe Physical Properties window
DS = diameter of sample atom (Å) from the Hor-

vath-Kawazoe Physical Properties window

L = pore width (nucleus to nucleus) (Å)
N1 = 4π L2NS, where Ns = number of sample atoms/cm

2 at monolayer

1 ) Cheng, Linda S. and Yang, Ralph T., Chemical Engineering Science 49(16), 2599-2609
(1994).

Sphere Pore Geometry (Cheng/Yang)
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B Calculations

N2 = 4π (L-d0)
2NA, where NS = number of gas molecules/cm

2

P = equilibrium pressure
P0 = saturation pressure
R = gas constant (8.31441 × 107 erg/mol K)
T = analysis bath temperature (K), from an entered or calculated value on the P0

and Temperature Options window

( ) ( )
T = −

S S

1
1

1 −

1

1 +
3 3

( ) ( )
T = −

S S

2
1

1 +

1

1 −
2 2

( ) ( )
T = −

S S

3
1

1 −

1

1 +
9 9

( ) ( )
T = −

S S

4
1

1 +

1

1 −
8 8

where
S =

L d

L

− 0

CHENG/YANG CORRECTION

This factor corrects for the nonlinearity of the isotherm. It adds an additional term to the equations for
the different geometrics:

     






















G Lln = − 1 − ln
P

P θ θ

1 1

1 −0

where
G(L) = one of the Horvath-Kawazoe equations given above
θ = degree of void filling; θ is estimated by first computing the monolayer capa-

city (Qm) with the Langmuir equation over the range of data points from rel-
ative pressure 0.02 to 0.2 or the maximum relative pressure included in the
Horvath-Kawazoe analysis. θ is computed as the quantity adsorbed over Qm.
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INTERACTION PARAMETER

The interaction parameter (IP) results from the following calculations:

The Kirkwood-Muller dispersion coefficients

A =S
mc α α6

+

S A

αS

XS

αA

XA

2

A =A
mc a x3

2

A A

2

where
αA = polarizability of gas molecule (cm3)
αS = polarizability of sample atoms (cm3)
mc2 = kinetic energy of electron (0.8183 × 10-6 erg)
XA = diamagnetic susceptibility of gas molecule (cm3)

IP N A N A= ( ) + ( )A A S S

NA = number of gas molecules/cm2 at monolayer from the Hor-
vath-Kawazoe Physical Properties window

NS = number of sample atoms/cm2 from the Horvath-Kawazoe
Physical Properties window

Xs = diamagnetic susceptibility of sample atom (cm3)

See Interaction Parameter Components Table on page B - 33 for recommended values.

ADDITIONAL CALCULATIONS

Based on the previous calculations, the following can be calculated:

Adjusted Pore Width (Å):

(Shell to Shell)

AL L D= −i i S

Cumulative Pore Volume (cm3/g):

Interaction Parameter
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B Calculations

V =cum i

Q V

cm STP
,

22414

i mol

3

where
Vmol = liquid molar volume from the fluid property information

dV/dD Pore Volume (cm3/g-Å):

=
dV

dD

V V

AL AL

−

−i

cum i cum i

i i

, , −1

−1

Median Pore Width (Å):

V =half

V

2

cum n,









D D D D= exp ln + (ln − ln )ι g ι

V V

V Vmed
ln − ln

ln − lng ι

half ι

where
D1 = pore width (Li) that corresponds to Vι
Dg = pore width (Li) that corresponds to Vg
Vcum,n = total cumulative pore volume (Vcum,i) for points designated for Horvath-

Kawazoe calculations
Vg = cumulative pore volume (Vcum,i) for first point greater than Vhalf
Vhalf = 50% of total cumulative pore volume
Vl = cumulative pore volume (Vcum,i) for first point less than Vhalf
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Gas

Bath
Temperature

(K) Sample Type

Interaction
Parameter

Calculated Value *
Argon 87.3 Carbon (Ross/Olivier value)

Carbon (Horvath/Kawazoe value)
Zeolite

2.61
5.89
3.19

Carbon Diox-
ide

298.15 Carbon (Ross/Olivier value)
Carbon (Horvath/Kawazoe value)
Zeolite

4.20
9.20
5.08

273.15 Carbon (Ross/Olivier value)
Carbon (Horvath/Kawazoe value)
Zeolite

4.34
9.35
5.22

194.65 Carbon (Ross/Olivier value)
Carbon (Horvath/Kawazoe value)
Zeolite

4.72
9.72
5.60

Nitrogen 77.15 Carbon (Ross/Olivier value)
Carbon (Horvath/Kawazoe value)
Zeolite

2.84
6.53
3.49

* The interaction parameter is entered in the Horvath-Kawazoe Report Options window in the
following field:

Interaction parameter: (calculated value) × 10-43 erg-cm4

Interaction Parameter Components Table

The following values were used to calculate the values in the previous table.

Carbon-Graphite Zeolite
DS = 3.40 DS = 3.04
NS = 3.845 × 1015 NS = 3.75 × 1015

XS = 1.05 × 10-29 (Ross/Olivier) XS = 1.94 × 10-29

13.5 × 10-29
(Horvath/Kawazoe, implicit)

αs = 0.85 × 10-24

αs = 1.02 × 10-24

Nitrogen Argon
DA  = 3.00 DA = 2.95
NA  = 6.71 × 1014 NA = 7.608 × 1014

XA  = 3.6 × 10-29 XA  = 3.22 × 10-29

Additional Calculations
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B Calculations

αA = 1.76 × 10-24 αA = 1.63 × 10-24

Carbon Dioxide
DA  = 3.23
NA = 4.567 × 1014 (25 ºC)

5.45 × 1014 (0 ºC)
7.697 × 1014 (-78 ºC)

XA  = 5.0 × 10-29

αA = 2.7 × 10-24

DA values are from van der Waal's constant.

NA values are from liquid densities.

x and a values are derived from data found in Ross and Olivier1 ) .

The physical parameters referenced in Saito/Foley are:

Aluminophosphate Aluminosilicate
DS = 2.60 DS = 2.76
NS = 1.48 × 1015 NS = 1.31 × 1015

XS = 1.3 × 10-29 XS = 1.3 × 10-29

αs = 2.5 × 10-24 αs = 2.5 × 10-24

1 ) Ross and Olivier, J.P., “On Physical Adsorption,” J. Wiley and Sons, New York (1964)
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LANGMUIR SURFACE AREA
For each point designated for surface area calculations, the Langmuir1 ) transformation is calculated
as:

L =
P

N

rel

ads

where L is in units of g/cm3 STP.

A least-squares fit is performed on the (Prel, L) designated pairs where Prel is the independent variable
and L is the dependent variable. The following are calculated:

a. Slope (S g/cm3 STP)

b. Y-intercept (Yint g/cm
3 STP)

c. Error of the slope (Serr g/cm
3 STP)

d. Error of the y-intercept (YIerr g/cm
3 STP)

e. Correlation coefficient

Using the results of the above calculations, the following can be calculated:

Langmuir Surface Area (m2/g):




















SA =Lan

CSA N

cm STP S

×

22414

A

nm

m

3 10
18

  
2

2

where
CSA = analysis gas molecular cross-sectional area (nm2), user-entered on the Adsorpt-

ive Properties window

Quantity of the Monolayer (cm3/g STP):

Q =
m S

1

Langmuir b Value:

b Y V= mint

1 ) Langmuir, I., J. Am. Chem. Soc. 38, 2267 (1916); J. Am. Chem. Soc. 40, 1361 (1918); Phys.
Rev 8, 149 (1916).

Langmuir Surface Area
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B Calculations

Error of the Langmuir Surface Area (m2/g):

LAN =err

SA S

S

Lan err
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MP-METHOD

With the (ti,Qi) data pairs
1 ) , the Akima semi-spline interpolation method is used to interpolate quantity

adsorbed values based on thickness values that are evenly spaced 0.2 angstrom apart starting at the first
outlier point. Outliers are defined as those points that have the maximum instantaneous slope within an
iteratively shrinking subset of all points. The remaining pore surface area calculation result is the slope
of the line defined by two consecutive interpolated points. The slopes of each pair of consecutive points
from the origin to the last point must be monotonically decreasing and non-negative. With the
interpolated points set the following can be calculated:

Average pore hydraulic radius (Å):

R =
i

t t+

2

i i−1

Remaining pore surface area for the ith point (m2/g):

S = × 10i

Q Q

t t

V

cm STP

−

− 22414

4i i

i i

mol−1

−1
3

where
104 = unit conversions
Vmol = liquid molar volume from the fluid property information

Incremental pore surface area occluded for the ith point (m2/g):

S S S= −inc i i i, −1

Cumulative pore surface area occluded for the ith point (m2/g):

S S S S= + +… +cum inc i inc i inc i, , −1 ,i

dA/dR pore surface area for the ith point (m2/g-Å):

=
dA

dR

S

t t−i

inci

i i−1

Incremental pore volume occluded for the ith point (cm3/g):

1 ) Mikhail, R., Brunauer, S. and Bodor, E., J. Colloid and Interface Sci. 24, 45 (1968).

MP-Method
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V S R= × 10inc i inc i i, ,
−4

Cumulative pore volume occluded for the ith point (cm3/g):

V V V V= + +… +cum i inc i inc i, , −1 ,

dV/dR pore volume for the ith point (cm3/g-Å):

=
dV

dR

V

t t−i

inc i

i i

,

−1
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RELATIVE PRESSURE
Relative pressure is defined as:

P =rel i

P

P
,

i

i0,

P0,i depends on the method selected in the P0 and Temperature options

If P0 was measured for each point,P0,i is the saturation pressure measured when Pi was equilibrated.

If P0 was measured at intervals, P0,i is found by linear interpolation.

 






P P P P= + −
i i i i

t t

t t
0, 0, −1 0, +1 0, −1

−

−

i i

i i

−1

+1 −1

The last measured P0 is only for points taken after the last P0 measurement.

If P0 was calculated from measured Psat or entered temperature the calculated P0 is used for all data
points.

If P0 was entered, the entered P0 is used for all data points.

SATURATION PRESSURE
Saturation pressure (P0) is selected on the P0 and Temperature Options window. It may be entered or
measured in the P0 tube. The analyzer uses the following methods to get P0:

1. P0 is measured in the P0 tube for each isotherm point. This method can be used only if the instru-
ment has a dedicated P0 transducer.

2. P0 is measured at a specified time interval using the 1000 mmHg manifold transducer.

3. The saturation pressure of a gas is measured in the P0 tube for prior to data collection. The bath
temperature is found by looking up the temperature for the measured saturation pressure in the
Psat vs. T table. P0 is found by looking up the calculated bath temperature in the adsorptive
properties Psat vs. T table.

4. P0 is found by looking up the entered bath temperature in the adsorptive properties Psat vs. T
table.

5. P0 is entered.

Relative Pressure
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SPC REPORT VARIABLES

REGRESSION CHART VARIABLES

The line of best fit for the Regression Chart is calculated by the usual least squares method. 1 ) If there
is only a single point or all N points have the same x-value, there can be no line of best fit in the standard
form.

x =
x

N

Σ i

y =
y

N

Σ
i

( )( )

( )
Slope =

x x y y

x x

Σ − −

Σ −

i i

i
2

⋅y xIntercept = − Slope

The coefficient of correlation for this line is also calculated in the usual way. 2 )

( )
σ =x

x x

N

Σ −i
2

( )
σ =y

y y

N

Σ −
i

2

( )( )
x yCov( , ) =

x x y y

N

Σ − −i i

Correlation Coeff =
x y

σ σ

Cov( , )

x y

1 ) BASIC Scientific Subroutines Vol II, by F.R. Ruckdeschel, Copyright 1981 BYTE
Publications/McGraw Hill, p. 16.
2 ) Mathematical Handbook for Scientists and Engineers, G.A. Korn and T.M. Korn, McGraw
Hill, Sec. 18.4. (1968)
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CONTROL CHART VARIABLES

Mean =
y

N

Σ
i

( )
Standard Deviation =

y

N

Σ −Mean

− 1

i
2

C. V.=
StdDev

Mean

⋅+ n σ = Mean + n Standard Deviation

⋅− n σ = Mean − n Standard Deviation

Control Chart Variables
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T-PLOT
A least-squares analysis fit is performed on the (ti, Nads,i) data pairs where ti is the independent variable
and Nads,i is the dependent variable. Only the values of ti between tmin and tmax, the minimum and
maximum thickness, are used. The following are calculated:

a. Slope (S cm3/g-Å STP)

b. Y-intercept (Yint cm
3/g STP)

c. Error of the slope (Serr cm
3/g-Å STP)

d. Error of the Y-intercept (YIerr cm
3/g STP)

e. Correlation coefficient

Using the results of the above calculations, the following can be calculated:

External Surface Area (m2/g):

× 10
SV

F cm STP×22414

4mol

3

where
104 = unit conversions
F = surface area correction factor, user-entered on the t-Plot Report Options

screen
Vmol = liquid molar volume, from the fluid property information

Micropore Surface Area (m2/g):

SA SA SA= +µρ total ext

where SAtotal is the BET surface area if the user enabled the BET report exclusively, or Langmuir
surface area if the user enabled the Langmuir report exclusively. If neither report has been selected,
SAtotal is the BET surface area value calculated using a set of default parameters.

Micropore Volume (cm3 liquid/g):

Y V

cm STP22414

molint

3
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TEMKIN ISOTHERM
The Temkin isotherm has the form









ln A P=

Q

Q

RT

q α o
m 0

where
A0 = adjustable constant
alpha adjustable constant
P = equilibrium pressure measured by gauge at temp Tamb
q0 = the differential heat of adsorption at zero surface coverage
Q = quantity of gas adsorbed
Qm = quantity of gas in a monolayer
R = molar gas constant

8.31441 × 10
kJ

molK

−3

T = bath temperature

In terms of quantity adsorbed
















Q A= ln + ln

RTQ

q α

P

P0
s

0 0

Thus, the plot of the natural log of absolute pressure vs. quantity adsorbed yields a straight line with

slope

RTQ

q

m

0 and intercept
Aln
RTQ

q a0
m

0 .

Temkin Isotherm
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THERMAL TRANSPIRATION CORRECTION
During data reduction, thermal transpiration correction is applied to the data if the user selected Apply
thermal transpiration correction from the Report Options window. Starting with the first collected
pressure, the following calculations are performed until the pressure ratio (PC/P) is greater than or equal
to 0.99.









Y = 10

P SD MD

T

× ×

2.33 ×

3
2

µ =
G Y

H Y

(1 + )

(1 + )

F =
αY βY

1

+ + µ
2


















P F= 1 − 1 −

T

T

bath

amb

where
α = Weber’s coefficient, 0.033
β = Weber’s coefficient, 0.245
F,Y µ = intermediate values for subsequent calculations
G = Weber’s coefficient, 2.5
H = Weber’s coefficient, 2
MD = thermal transpiration hard sphere diameter of gas (Å), from the Adsorptive

Properties window
P = equilibrated collected pressure measured by gauge at temp Tamb
SD = inside diameter of sample tube (mm), from the Report Options window
T = average temperatureT T+

2

amb

Tamb = room temperature (298 K)
Tbath = analysis bath temperature (K), from the P0 and Temperature Options window
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THICKNESS CURVE
For each point designated, the following parameters are used in thickness curve calculations:

C1 = parameter #1
C2 = parameter #2
C3 = parameter #3
Prel, i = relative pressure for the ith point (mmHg)
ti = thickness for ith point

REFERENCE

Interpolated from table.

KRUK-JARONIEC-SAYARI











( )
t =

C

C P

c

= log

3

rel i

1

2 ,

HALSEY













( )
t C=i

C

P

C

1
ln rel i

2

,

3 Halsey1 )

HARKINS AND JURA













( )
t =i

C

C P

C

− log rel i

1

2 ,

3 Harkins and Jura2 )

1 ) Halsey, G., J. Chem. Phys. 16, 931-937 (1948).
2 ) Harkins, W.D. and Jura, G., J. Chem. Phys. 11, 431 (1943).

Thickness Curve
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BROEKOFF-DE BOER

   















P C c tlog = + exprel i

C

t i
i,

,
2 3

1

2

CARBON BLACK STSA

( ) ( )t C P C P C= + +i rel i rel i1 ,

2

2 , 3
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C DFT MODELS

Theories are developed by scientists in an attempt to explain a class of observed behavior. In the
experimental physical sciences, theories are often expressed in terms of a model that can be visualized
and described mathematically. Early models of physical adsorption were quite simple, both conceptually
and mathematically, for very practical reasons — hand computations were required. Today we can
explore complex models that describe adsorption systems on the atomic scale of size and sub-picosecond
time frame. This is not because scientists are smarter, but because of available tools. The DFT models
are created by classical approaches to adsorption as well as models based on modern statistical
thermodynamics.

MODELS BASED ON STATISTICAL THERMODYNAMICS

Included in this group are methods that model the adsorption system in terms of forces acting between
individual molecules.

THEORETICAL BACKGROUND

Traditional adsorption theories attempt to describe experimental adsorption isotherms with an isotherm
equation containing a small number of parameters. At a minimum, these parameters include the extent of
the surface, such as the monolayer capacity (Vm), and the molar intensity of the gas-surface interaction,
such as the Langmuir “K” constant or the BET “C” constant. In some equations, additional parameters
take into account the lateral interaction of adsorbed molecules with each other. Other theories, such as
the Dubinin-Astakhov approach, also include parameters for the effect of adsorbent porosity.

Instead of this classical kinetic or phenomenological approach, we can use a molecular-based statistical
thermodynamic theory that allows us to relate the adsorption isotherm to the microscopic properties of
the system: the fluid-fluid and fluid-solid interaction energy parameters, the pore size, the pore geometry,
and the temperature.

The following example is given so that you may understand how such a theory is constructed:

A clean sample of a solid material containing slit-shaped pores of a single width is placed
in an evacuated space. It is kept at a fixed temperature as a known quantity of pure argon
gas is admitted into the space surrounding the sample. The pressure within the space is
recorded over time. In this situation, the pressure falls rapidly from its initial value and
gradually approaches a steady reading, called the equilibrium pressure. The amount
adsorbed corresponds to the quantity of gas effectively removed from the gas phase by the
solid surface. A graph that plots amount adsorbed versus equilibrium pressure is called an
adsorption isotherm.

C DFT Models
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C DFT Models

Under such conditions, the argon atoms that randomly enter the pore space feel the
presence of the solid surface as the action of an external attractive force (the dispersion
forces or Van der Waal’s forces) and spend more time near the surface. As a result, the
space near the surface acquires a greater average density of argon atoms than regions
farther removed.

If the equilibrium distribution of the gas atoms near the surface could be described as a
function of pressure and the molecular properties of the components of the system, then a
model could be constructed for the adsorption isotherm for the system. Modern physical
chemistry provides several ways to calculate this distribution. All these methods are based
on the fundamental thermodynamic law that such a system adopts a configuration of
minimum free energy at equilibrium. Also needed is a description of the pairwise
interaction energy between atoms, U(s), commonly given by a Lennard-Jones potential:

( ) ( ) ( )U s = 4ϵ −
σ σ
12 6

where

ε = a characteristic energy of the adsorptive,
σ = the diameter of the adsorptive molecule, and
s = the separation distance.

MOLECULAR SIMULATION METHODS

Two simulation techniques are commonly used to determine the distribution of gas molecules in a system
in equilibrium: the molecular dynamics method and the Monte Carlo method. Both of these are used as
reference methods because their results are considered exact.

MOLECULAR DYNAMICSMETHOD

In the molecular dynamics method, the position and velocity of individual gas particles are calculated
over time at very short intervals. This method takes into account both the forces acting between the gas
particles themselves and those acting between the gas particles and the atoms of the simulated surface.
As the simulated particles collide with each other and with the surface, the average concentration of
particles in the space near the surface is calculated; this calculation yields the amount of gas adsorbed.

This method can be thought of as a way to determine the chronological record of the movement of each
particle in the system using time steps of 10-14 seconds. Although the mathematics are simple, the
number of calculations required for a system of even a few hundred particles is astronomical and
challenges even the fastest computers.

C - 2 ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015



MONTE CARLO METHOD

In the Monte Carlo method, determination of the system equilibrium distribution begins with an
assumption (which may be only approximate) about the initial configuration of particles in the system.
The system is “equilibrated” through a process of randomly selecting one particle and conditionally
moving it a random distance in a random direction.

If the move results in a configuration of lower total energy, then the move is completed and another
particle is randomly selected to be moved.

If the move results in a configuration of higher energy, a probability for that event is calculated, and a
random number between zero and one is generated. If the generated number is smaller than the
probability of the event, then the move is accepted; otherwise, another particle is selected and the
process is repeated. This process continues until the average total energy of the system no longer
decreases; at this point, average configuration data are accumulated to yield the mean density
distribution of particles in the system.

Monte Carlo simulations require considerably less computation time than molecular dynamic simulations
and can yield the same results; however, neither method provides a really practical way to calculate
complete isotherms.

DENSITY FUNCTIONAL FORMULATION

Density functional theory offers a practical alternative to both molecular dynamic and Monte Carlo
simulations. When compared to reference methods based on molecular simulation, this theory provides
an accurate method of describing inhomogeneous systems yet requires fewer calculations. Because the
density functional theory provides accuracy and a reduced number of calculations, it is the basis
embodied in the DFT models.

The system being modeled consists of a single pore represented by two parallel walls separated by a
distance H. The pore is open and immersed in a single component fluid (adsorptive) at a fixed
temperature and pressure. Under such conditions, the fluid responds to the walls and reaches an
equilibrium distribution. In this condition (by the definition of equilibrium), the chemical potential at
every point equals the chemical potential of the bulk fluid. The bulk fluid is a homogenous system of
constant density; its chemical potential1 ) is determined by the pressure of the system using well-known
equations. The fluid near the walls is not of constant density; its chemical potential is composed of
several position-dependent contributions that must total at every point to the same value as the chemical
potential of the bulk fluid.

1 ) Chemical potential may be thought of as the energy change felt by a probe particle when it is
inserted into the system from a reference point outside the system. It can also be defined as the
partial derivative of the grand potential energy with respect to density (or concentration).

Monte Carlo Method
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C DFT Models

As noted previously, at equilibrium, the whole system has a minimum (Helmholtz) free energy, known
thermodynamically as the grand potential energy (GPE). Density functional theory describes the
thermodynamic grand potential as a functional of the single-particle density distribution; therefore,
calculating the density profile that minimizes the GPE yields the equilibrium density profile. The
calculation method requires the solution of a system of complex integral equations that are implicit
functions of the density vector. Since analytic solutions are not possible, the problem must be solved
using iterative numerical methods. Although calculation using these methods still requires
supercomputing speed, the calculation of many isotherm pressure points for a wide range of pore sizes is
a feasible task. The complete details of the theory and the mathematics can be found in the papers listed
under DFT Model References on page C - 16.

The following graphs and accompanying text illustrate the results of using density functional theory to
predict the behavior of a model system.

Figure 1 shows the density profile for argon at a carbon surface as calculated by density functional
theory for a temperature of 87.3 K and a relative pressure of about 0.5.

Figure 1. Density Profile for Argon on Carbon at 87.3 K and a Relative Pressure of 0.5

This figure represents a cross-section of the region near the surface. Note the layerwise distribution of
adsorbate; the first monolayer is sharply defined and a third layer can be distinguished. The area under
the profile curve represents the amount adsorbed per unit area at this pressure. The positions of the
maxima are separated by a distance determined by the size of the adsorptive atom.
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Given the density profile, the amount adsorbed at the stated pressure can be easily calculated as the
integral over the profile. Repeating this calculation over a range of pressures yields the adsorption
isotherm for the model. If the value of H is very large, the isotherm obtained corresponds to that of an
external, or free, surface. If H is smaller, a range of pressures is reached where two minima exist for
the grand potential, showing the presence of two metastable phases having different density distributions
but the same chemical potential. The phase with the lower GPE is the stable one. As the pressure is
increased, a point is reached where the other phase becomes the stable one. This phase transition
reflects condensation of adsorbate in the pore; the pressure at which it occurs is called the critical pore-
filling pressure. This pressure is analogous to the condensation pressure predicted by the Kelvin equation
in the classical model of pore filling.

Figure 2 shows how the profiles change with pressure for a model pore with H = 40 angstroms. The inset
shows the density profiles for the corresponding points of the isotherm.

Figure 2. Model Isotherm for Argon at 87.3 K in a 40 Å Slit in a Carbon Substrate

The profiles show the density distribution from one wall to the center of the slit; the other half of the
distribution is a mirror image of the profile shown.

As the pressure is first increased from zero, almost all the adsorbed atoms occupy a position close to the
surface.

l Inset a shows the profile corresponding to point a on the isotherm where the surface is about half
covered.

l At point b, the first layer is so full that it is more favorable for atoms to start a new layer.

l At point c, a third layer is forming. Point c, for this size slit, is the critical pore-filling pressure. In
inset c, the profile shows the density decreasing to near zero (actually the bulk gas density) at 4 or 5
molecular diameters from the surface.

Density Functional Formulation
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C DFT Models

l Inset d shows the profile converging on a density similar to that of bulk liquid argon in the center of
the pore, indicating a phase transition.

Note that the adsorption isotherms for pores larger than the one shown in the previous graph is identical
up to point c. The lower branch of the isotherm simply continues to a higher pressure for larger pores.
This trend is illustrated in the Figure 3, where isotherms for some larger size pores are shown. It is clear
that pore size is uniquely characterized by a corresponding critical pore-filling pressure. At large pore
sizes, density functional theory produces results for the critical filling pressures that are in good
agreement with those produced by the Kelvin equation.

Figure 3. Model Isotherms for Some Larger Pore Widths Argon on Carbon at 87.3 K

Figure 4 shows model isotherms for pores in the micropore size range. Note the logarithmic scale for
pressure.

Figure 4. Model Isotherms in the Micropore Size Range of Pore Width Argon on Carbon at 87.3 K
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Pores of 4 Å width, barely larger than the argon atom (3.38 Å), fill at pressures below 1 millitorr. Pores
below 15 Å fill before a monolayer is completed on the surface of the larger pores. In the micropore size
range, the pore volume fills more gradually with pressure and the total shape of the isotherm is important
in characterizing the pore size.

Models Included

Non-Local Density Functional Theory with Density-Independent Weights

N2 - DFT Model
AR - DFT Model

Geometry: Slit
Substrate: Carbon (graphite)
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Using the methods of non-local density functional theory, two sets of isotherms have been calculated to
serve as kernel functions for the characterization of porous solids from adsorption data. The model
isotherms are stored in binary format files. These models assume a slit-like pore geometry. The pore
size range from 4.0 to 4000 Å is covered in 91 classes in a geometric progression. The class intervals
are rounded to the nearest 0.02 molecular diameters. A model for the free or external surface is included
to account for unfilled pores. Each of the 92 model isotherms has been calculated at 181 pressure points
from near 1×10-6 to near 1.00 relative pressure.

These models are identical to those supplied with the original DOS version of DFT software. Some
slight difference from the DOS results may be noted when they are applied to the same data due to
improvements in the deconvolution algorithm and better regularization of the current software.

Non-Local Density Functional Theory with Density-Dependent Weights

N2 - Modified Density Functional

Geometry: Free surface
Substrate: Surface energy
Method: Nitrogen at 77K

Using the modified Tarazona prescription described by Olivier (see DFT Model References on page C -
16 [items 3 and 4]), model isotherms were calculated for a wide range of adsorptive energies to a
relative pressure of 0.6. The model makes no provision for pore filling in the micropore region. If the
sample solid contains small mesopores, the isotherm data should be truncated (using the Select Data
Points window) to a suitably low relative pressure to avoid trying to fit this region; mesopore filling
reports as a large area of low energy in the calculated distribution of adsorptive potential.

Density Functional Formulation
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C DFT Models

The surface energy is reported in terms of the effective Lennard-Jones interaction parameter, ie, for the
adsorptive / adsorbent pair divided by Boltzmann constant. The units are therefore Kelvin.

N2 - Cylindrical Pores - Oxide Surface
AR - Cylindrical Pores - Oxide Surface

Geometry: Cylinder
Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using a combination of statistical mechanical calculations and
experimental observations for macroporous silicas and MCM-41 mesoporous silicas as well as zeolites.
The pore-filling pressures were determined as a function of the pore size from adsorption isotherms on
MCM-41 materials characterized by X-ray and other techniques. The variation of the pore fluid density
with pressure and pore size has been accounted for by density functional theory calculations. The N2
model reports pore sizes ranging from 3.8 to 387 Å and the AR model from 3.8 to over 500 angstroms.

References: M. Jaroniec, M. Kruk, J.P. Olivier, and S. Koch, “A New Method for the
Accurate Pore Size Analysis of MCM-41 and Other Silica-Based Meso-
porous Materials,” Proceedings of COPS-V, Heidelberg, Germany (1999).

N2 – Cylindrical Pores – Pillared Clay Surface (Montmorillionite)

Geometry: Cylinder
Substrate: Crystalline Silicate
Category: Porosity
Method: Nitrogen at 77K

Model isotherms were calculated using a combination of statistical thermodynamic Non-Local Density
Functional Theory (NLDFT) calculations and experimental isotherms for reference samples of
montmorillionite.The construction method for the hybrid models was analogous to that described in the
first reference below (Jaroniec et al,1999). The additional references add additional theoretical details as
well as examples of the application of the model to pillared clay catalysts.This model reports pore widths
from 3.8 to 387 angstroms.

References: Mietec Jaroniec, Michal Kruk, James P. Olivier and Stefan Koch, “A New
Method for the Characterization of Mesoporous Silicas,” Proceedings of
COPS-V, 1999, Studies in Surface Science, Vol 128, Characterization of
porous Solids V , Unger, et al, Eds, Elsevier, Amsterdam, 2000.

James P. Olivier and Mario L. Occelli, “Surface Area and Microporosity of
a Pillared Interlayered Clay (PILC) from a Hybrid Density Functional
Theory (DFT) Method,” The Journal of Physical Chemistry B; 2001, 105(3),
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623-629.

M. L. Occelli, J. P. Olivier, J. A. Perdigon-Melon, and A. Auroux, “Surface
Area, Pore Volume Distribution, and Acidity in Mesoporous Expanded Clay
Catalysts from Hybrid Density Functional Theory (DFT) and Adsorption
Microcalorimetry Methods,” Langmuir 2002, 18, 9816-9823.9b.

James P. Olivier, “The Importance of Surface Heterogeneity in Developing
Characterization Methods.” 6th International Symposium on the
Characterization of Porous Solids, Studies in Surface Science and Catalysis
144, Elsevier, 2002.

James P. Olivier and Mario L. Occelli, “Surface Area and Microporosity of
Pillared Rectorite Catalysts from a Hybrid Density Functional Theory
Method,” Microporous and Mesoporous Materials 2003, 57, 291-296.

C02 - DFT Model

Geometry: Slit
Substrate: Carbon
Category: Porosity
Method: Carbon dioxide at 273 K

Model isotherms were calculated using the non-local prescription of Tarazona, employing molecular
parameters derived from the known bulk properties of carbon dioxide.

AR - Modified Density Functional Model

Geometry: Free surface
Substrate: Any
Category: Surface energy
Method: Argon at 87K

This model was produced in the same manner as the N2 Modified Density Functional model listed
earlier, except applicable to argon adsorbed at 87.3 K.

N2 - Tarazona NLDFT, Esf = 30.0K

Geometry: Cylinder
Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77K

Density Functional Formulation
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Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting
functions and a cylindrical pore geometry. The wall potential used is k = 30 K, typical for a silica or
alumina surface.

This model file is particularly useful for sizing zeolites or zeolite containing materials that have
substantial micropore volume. The reported pore size range is 3.8 to 387 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Slit Pores by NLDFT
Ar - Carbon Slit Pores by NLDFT

Geometry: Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting
functions and a slit-like pore geometry. These models are slightly different from N2-DFT and Ar-DFT
models that were calculated using NLDFT with density independent weighting functions.

The reported pore size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Finite Pores, As=6, 2D-NLDFT
Ar - Carbon Finite Pores, As=6, 2D-NLDFT

Geometry: Finite Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting
functions assuming 2D model of finite slit pores having a diameter-to-width aspect ratio of 6.

This model is particularly useful for microporous carbon materials. The reported pore size range is from
3.5 to 250 angstroms

References: Jacek Jagiello and James P. Olivier. “A simple two-dimensional NLDFT
model of gas adsorption in finite carbon pores. Application to pore structure
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analysis.,” The Journal of Physical Chemistry C, 113(45):19382-19385,
2009.

N2 - Carbon Finite Pores, As=12, 2D-NLDFT
Ar - Carbon Finite Pores, As=12, 2D-NLDFT

Geometry: Finite Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using the same methods and assumptions that were used in the model
above except in this model, the aspect ratio is equal to 12.

These two finite pore models may be used as a research tool in conjunction with independent analytical
techniques such as high-resolution transmission electron microscopy (HRTEM) and / or X-ray diffraction
(XRD) to obtain comprehensive information about the structure of studied carbon material.

References: Jacek Jagiello and James P. Olivier. “A simple two-dimensional NLDFT
model of gas adsorption in finite carbon pores. Application to pore structure
analysis.,” The Journal of Physical Chemistry C, 113(45):19382-19385,
2009.

N2 - Carbon Cylinder, single-wall nanotube by NLDFT
Ar - Argon Cylinder, single-wall nanotube by NLDFT

Geometry: Cylinder
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting
functions and cylindrical pore geometry. The pore wall potential is described by the Lennard-Jones
potential of interaction between a gas molecule and the graphitic surface of an infinitely long cylinder.

This model is particularly useful for characterizing carbon single-wall nanotubes. The reported pore size
range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Cylinder, multi-wall nanotube by NLDFT
Ar - Argon Cylinder, multi-wall nanotube by NLDFT

Density Functional Formulation
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Geometry: Cylinder
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting
functions and cylindrical pore geometry. The pore wall potential is described by the Lennard-Jones
potential of interaction between a gas molecule and multiple concentric graphitic surfaces of infinitely
long cylinders.

This model is particularly useful for characterizing carbon multi-wall nanotubes. The reported pore size
range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987)

Ar - Zeolites H-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argon at 77 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting
functions and cylindrical pore geometry. The pore wall potential is described by the Lennard-Jones
potential of interaction between a gas molecule and the oxide surface of an infinitely long cylinder.

This model is particularly useful for characterizing oxides and H+ and (NH4)+ exchanged zeolites. The
reported pore size range is from 3.5 to 300 angstroms.

Ar - Zeolites Me-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argon at 77 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting
functions and cylindrical pore geometry. The pore wall potential is described by the Lennard-Jones
potential of interaction between a gas molecule and the oxide surface of an infinitely long cylinder.

This model is similar to the model above, but it more appropriate is for characterizing alkali metal
exchanged zeolites. The reported pore size range is from 3.5 to 300 angstroms.
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MODELS BASED ON CLASSICAL THEORIES
Both surface energy distribution and pore size distribution may be evaluated using classical approaches
to model kernel functions for use with equation (1) of the DFT Theory in DFT (Density Functional
Theory) on page B - 12. Be aware that the deconvolution method only provides a fitting mechanism; it
does not overcome any inherent shortcomings in the underlying theory.

SURFACE ENERGY

The use of classical theories to extract adsorptive potential distribution is mostly of historical interest. At
a minimum, the equation must contain a parameter dependent on adsorption energy and another
dependent on monolayer capacity or surface area. This is sufficient to permit the calculation of the set of
model isotherms that is used to create a library model. The Langmuir equation has been used in the past,
as have the Hill-de Boer equation and the Fowler-Guggenheim equation. All of these suffer from the fact
that they only describe monolayer adsorption, whereas the data may include contributions from
multilayer formation.

PORE SIZE

It is well established that the pore space of a mesoporous solid fills with condensed adsorbate at
pressures somewhat below the prevailing saturated vapor pressure of the adsorptive. When combined
with a correlating function that relates pore size with a critical condensation pressure, this knowledge
can be used to characterize the mesopore size distribution of the adsorbent. The correlating function
most commonly used is the Kelvin equation. Refinements make allowance for the reduction of the
physical pore size by the thickness of the adsorbed film existing at the critical condensation pressure.
Still further refinements adjust the film thickness for the curvature of the pore wall.

The commonly used practical methods of extracting mesopore distribution from isotherm data using
Kelvin-based theories, such as the BJH method, were for the most part developed decades ago and were
designed for hand computation using relatively few experimental points. In general, these methods
visualize the incremental decomposition of an experimental isotherm, starting at the highest relative
pressure or pore size. At each step, the quantity of adsorptive involved is divided between pore emptying
and film thinning processes and exactly is accounted for. This computational algorithm frequently leads
to inconsistencies when carried to small mesopore sizes. If the thickness curve used is too steep, it
finally will predict a larger increment of adsorptive for a given pressure increment than is actually
observed; since a negative pore volume is non-physical, the algorithm must stop. Conversely, if the
thickness curve used underestimates film thinning, accumulated error results in the calculation of an
overly large volume of (possibly nonexistent) small pores.

The use of equation (1) represents an improvement over the traditional algorithm. Kernel functions
corresponding to various classical Kelvin-based methods have been calculated for differing geometries
and included in the list of models.

Models Based on Classical Theories
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MODELS INCLUDED

Kelvin Equation with Halsey Thickness Curve

N2 - Halsey Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Halsey equation with standard parameters:

 






( )
t = 3.54

P P

−5.00

ln /

1/3

0

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

N2 - Halsey Thickness Curve

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is the same as above except that cylindrical geometry is assumed.

Reference: G. Halsey, J. Chem. Phys 16, 931 (1948).

Kelvin Equation with Harkins and Jura Thickness Curve

N2 - Harkins and Jura Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Harkins and Jura equation with standard parameters:
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 

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1/2

0

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

N2 - Harkins and Jura Thickness Curve

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is the same as above except that cylindrical geometry is assumed.

References: W. D. Harkins and G. Jura, J.A.C.S. 66, 1366 (1944).
J. H. DeBoer et al., J. Colloid and Interface Sci. 21, 405 (1966).

Kelvin Equation with Broekhoff-de Boer Thickness Curve

N2 - Broekhoff-de Boer Model

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Broekhoff-de Boer equation with standard parameters:

 







p plog / = + 0.1682

t

t0 −16.11 −0.1137
2

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887g cm-3

N2 - Broekhoff-de Boer Model

Models Included
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Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is similar to the above except that cylindrical geometry is assumed, and the film
thickness depends on pore size (see reference).

References: Specifically, equations 20 and 21 in: J.C.P. Broekhoff and J.H. de Boer,
“The Surface Area in Intermediate Pores,” Proceedings of the International
Symposium on Surface Area Determination, D.H. Everett, R.H. Ottwill,
eds., U.K. (1969).

DFT MODEL REFERENCES
The papers listed below provide additional information on DFT models:

1. “Determination of Pore Size Distribution from Density Functional Theoretic Models of Adsorption
and Condensation within Porous Solids,” J.P. Olivier and W.B. Conklin, Micromeritics Instrument
Corp; presented at the International Symposium on the Effects of Surface Heterogeneity in Adsorp-
tion and Catalysts on Solids, Kazimierz Dolny, Poland (July 1992).

2. “Classification of Adsorption Behavior: Simple Fluids in Pores of Slit-shaped Geometry,” Perla
B. Balbuena and Keith E. Gubbins, Fluid Phase Equilibria, 76, 21-35, Elsevier Science Pub-
lishers, B.V., Amsterdam (1992).

3. “Modeling Physical Adsorption on Porous and Nonporous solids Using Density Functional The-
ory,” J.P. Olivier, Journal of Porous Materials, 3, 9-17 (1995).

4. “The Determination of Surface Energetic Heterogeneity Using Model Isotherms Calculated by
Density Functional Theory,” J.P. Olivier; presented at the Fifth International Conference on the
Fundamentals of Adsorption, Pacific Grove, CA (1995).

C - 16 ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015



D ERROR MESSAGES

If the Action response indicates to contact a Micromeritics service representative, record the error
message, then make backup copies of any files involved in the operation.

1023 | Preparation failed in primary data.

Cause: The data preparation failed for a report for either the selected sample file or an
overlay used by the report

Action: If this message references an overlay file, the report may still be printed for the
selected sample file.

1026 | Calculations failed for [n] overlay data.

Cause: Calculations failed for overlays in the BJH report.
Action: Continue printing the report for the primary data.

1026 | Calculations failed for [n] primary data.

Cause: Calculations failed for the selected sample file in the BJH report.
Action: Select a different sample file.

1043 | Isotherm calculation called with no points available.

Cause: Not enough valid data points are available for the Isotherm report.
Action: Select a different sample file.

1043 | Fewer than 2 points available for [n,n] calculations.

Cause: Calculations failed for overlays in the BJH report.
Action: Continue printing the report for the primary data.

1044 | No [n,n] reports. Fewer than 2 points meet [n] criteria.

Cause: Not enough data points are found with pressures and volumes Adsorbed mono-
tonically increasing (adsorption) or monotonically decreasing(desorption) for the
BJH report.

Action: Select a different sample file.

2401 | FATAL ERROR.

Cause: An internal processing and / or hardware error has occurred during communication
with the analyzer.

Action: Contact your Micromeritics service representative.

2430 | Error accessing file [n], error code = [n].

Cause A: Media may be damaged.
Action A: Clean the media drive. If this does not eliminate the problem, attempt operation

D Error Messages
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D Error Messages

using a backup copy of the file.
Cause B: Hard disk may be damaged.
Action B: Contact your Micromeritics service representative.
Cause C: A software error occurred when the file was accessed.
Action C: Contact your Micromeritics service representative.
Cause D: The file name specified contains one or more invalid characters.
Action D: Enter a valid file name. Do not use characters such as * or ?. Refer to the oper-

ating system manual.

2431 | Error writing file [n], error code = [n].

Cause A: User logged onto a computer that does not have Write permissions.
Action A: Contact your IT department to change user permissions.
Cause B: Insufficient hard disk to perform the operation.
Action B: Copy files not used regularly to the hard disk external media. Delete them from the

hard disk, and then try the operation again.

2432 | Invalid response from MMI ‘FILE_READ’ request.

Cause: An internal processing and/or hardware error has occurred.
Action: Contact a Micromeritics service representative if this error message continues.

2433 | New entries have been found in this directory. Refresh the directory information?

Cause: Several analyzer files (sample information, analysis conditions, adsorptive prop-
erties, or report options) have been added to this directory by some function other
than the analyzer program.

Action: Click Yes to update the directory information with data from each new file. This
operation may take a minute.

Click No to locate the file manually. This option may be feasible if a large number
of files have been copied into the directory and the file name is known.

2434 | File [n] — Subset [n] wrote wrong [n] of data, expected [n] bytes.

Cause: An internal processing and/or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2436 | Path specification [n] is invalid.

Cause: An invalid path name and / or extension was entered.
Action: Type a valid path name (including the proper extension), then press Enter.

2437 | File name [n] does not exist.

Cause: The overlay file selected in the report option does not exist.
Action: Enter an existing file specification, or select a file name from the list box.
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2437 | Overlay file [n] does not exist.

Cause: The overlay file selected in Report Options does not exist.
Action: Enter an existing file specification, or select a file name from the list box.

2438 | Cannot open scheduling diagnostic data save file: [n].

Cause: The file necessary for Unit [n] > Diagnostics > Schedule Diagnostic Test
(...\Hardware\scheddiagtests.dat) could not be read. It is likely corrupted.

Action: Exit the application. Delete or rename the file mentioned in the error message and
restart the software. A new file will be created.

2439 | Could not register file.

Cause: An unexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.

2440 | Subset not found.

Cause: An unexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.

2441 | Seek within file failed.

Cause: An unexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.

2442 | Bad header in subset file.

Cause: An unexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.

2443 | Subset owner denied access.

Cause: An unexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.

2444 | Not a valid file format.

Cause: An unexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.

2445 | Subset wrote the wrong amount of data.

Cause: An unexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.

2446 | Error reading data.

D Error Messages
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Cause: An unexpected error occurred when trying to access a data file.
Action: Contact your Micromeritics service representative.

2447 | Error writing data.

Cause: An unexpected error occurred when you tried to access a data file.
Action: Contact your Micromeritics service representative.

2448 | The library directory [n] does not exist. Please re-install to make use of Windows 7 lib-
raries.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | Basic Mode default parameter file directory [n] is invalid. Resetting to the installation dir-
ectory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | Default Adsorptive Properties directory [n] is invalid. Resetting to the installation dir-
ectory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | Default convert sample file directory [n] is invalid. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | Default parameter file directory [n] is invalid. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | Default report options directory [n] is invalid. Resetting to the installation directory.
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Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | Default sample file directory [n] is invalid. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | Default script test file directory [n] is invalid. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | File directory [n] is invalid. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
Directories list to move to the correct directory.

2448 | Problem diagnostic directory [n] is invalid. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | The export data file directory [n] cannot be used. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | The library directory [n] cannot be used. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | The library directory [n] does not exist. Please re-install to make use of Windows 7 lib-
raries.
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Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | The reference file directory [n] cannot be used. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | The z-table file directory [n] cannot be used. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2448 | User python script directory [n] is invalid. Resetting to the installation directory.

Cause: A working directory specified in the .INI file is invalid, has been moved, or has
been deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the
directories list to move to the correct directory.

2449 | This field does not contain a valid file specification.

Cause: An invalid file name was entered.
Action: See the description of file naming conventions in a Windows manual, then re-enter

the name.

2450 | Sample Defaults may not be edited while this operation is in progress. Do you wish to save
and close the Sample Defaults edit session?

Cause: An automatic analysis (an analysis in which sample files are created using the
defaults) was processing while editing the defaults.

Action: Finish the edit session of the defaults, close the window, then restart the automatic
analysis.

2451 | The specified folder does not exist.

Cause: Path entered in the file selector does not exist.
Action: Enter the correct file path, or browse for the correct file path.

2452 | The instrument is busy performing an operation of which this application is unaware. Do
you want to cancel?

Cause: The instrument is performing an operation which is not recognized by the applic-
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ation.
Action: Click Yes to have the application cancel the operation. Click No to allow the oper-

ation to continue.

2456 | Insufficient file handles available. Application cannot continue.

Cause: More than 50 files are open at the same time.
Action: Refer to an operating system manual then set the limit for open files to 50 or

greater. Alternatively, close any unused open files.

2458 | An instrument is performing a critical operation. Wait a few moments before exiting the
application.

Cause: An attempt was made to exit the application while the instrument was performing a
critical operation. This operation must be completed before the application can be
exited.

Action: Wait a short time and attempt to exit the application again.

2459 | An instrument is busy. A delay in restarting this application could result in loss of new
data. Continue with program Exit?

Cause: An attempt was made to exit the application while an analysis was in progress.
While this is possible, the data collected when the application is inactive will not
be permanently recorded until the application is re-started. A power failure to the
instrument could cause some data to be lost.

Action: If not concerned with the potential for loss of data should a power failure occur,
click Yes to continue; otherwise, click No.

2460 | Fatal Communications error on [n].

Cause: There was a fatal error in communication between the application and the software
in the instrument. All displays for that instrument will be closed.

Action: Ensure that the analyzer is connected to the computer on the communications port
configured in the Setup program. Stop and restart the analyzer software. Contact
your Micromeritics service representative.

2461 | No instruments are in operation. This application will unconditionally terminate.

Cause: At least one instrument must be active for the application to operate. The
initialization of all of the instruments configured with the Setup program has failed.
The application stops.

Action A: Usually this message is preceded by another message giving the reason for the
instrument’s failure to initialize. Refer to the instructions for that message.

Action B: Ensure that the instrument is attached to the computer on the communications port
configured with the Setup program. Verify that the instrument's power switch is in the
ON position and that the light on the front panel is illuminated. Contact a
Micromeritics service representative if this error message continues.
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2471 | [n] has an invalid communications port specified. It cannot be initialized.

Cause: The communications port specified for this analyzer during installation (or con-
figuration) is invalid.

Action: Use the Setup program to change the analyzer configuration.

2474 | [n] communications port [n] specified in the program control files is already in use. Unit can-
not initialize.

Cause: The communications port assigned to the indicated unit is in use by another pro-
gram.

Action: End the program using the busy port or use the Setup program to change the com-
munications port assigned to this program.

2475 | [n] communications port [n] specified in the program control files cannot be accessed. Unit
cannot initialize.

Cause: The operating system has prevented the application from accessing the com-
munications port.

Action: Review the hardware configuration of the computer. Ensure no other application is
using the port. Contact a Micromeritics service representative if this error message
continues.

2476 | [n] startup failed. Cannot initialize the communications port.

Cause: The communications port specified during installation is invalid.
Action: Use the Setup program to change the analyzer configuration. Contact a Micro-

meritics service representative if this error message continues.

2477 | [n] did not properly initialize.

Cause: The software was unable to initialize this instrument. This is usually caused by one
of the conditions listed in the previous error messages.

Action A: Run the Setup program and ensure that a valid port is specified; if not, specify a
valid one when prompted.

Action B: Reinstall the software, then restart application.
Action C: Contact a Micromeritics service representative if this error message continues.

2478 | Error copying sequential data segment.

Cause: An internal processing and / or hardware error occurred while accessing a portion
of a sample file.

Action: Confirm that the media being accessed does not contain errors.. Contact your
Micromeritics service representative.

2479 | Cannot open [n] because it is a [n] file.

Cause: The file cannot be opened because it came from a different Micromeritics applic-
ation
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Action: Select a different file.

2480 | File [n] cannot be analyzed. It is currently being edited.

Cause: An attempt was made to start an analysis using a file that is open for editing.
Action: Finish editing the file, save and close it, then start the analysis.

2481 | Error accessing the sample information file [n].

Cause: An unexplained error prevented access to this file.
Action: The hard disk drive may be corrupt. Run diagnostics.

2482 | File cannot be opened for writing.

Cause: An attempt was made to open a file currently being used.
Action: Locate the application using the file (in the Micromeritics application, use the

Windows menu item to get a list of all open windows, one of which may contain
this file).

2483 | An analysis cannot be performed on [n]. It is open for editing and contains errors.

Cause: An attempt was made to use a sample file containing errors that is currently open.
Action: Go to the window containing the file, correct the errors, then save it.

2484 | The edit session for [n] must be saved before the analysis. Save changes and continue with
the analysis?

Cause: An attempt was made to start an analysis using a file that contains unsaved
changes and is open for editing.

Action: Click Yes to save the changes, then proceed with the analysis. Click No to cancel
the analysis, then continue editing the Sample Information file.

2485 | The sample file [n] has an invalid status and cannot be used for this operation.

Cause: The selected file has a status other than No Analysis.
Action: Select a different sample file, or create a new one and use Replace All to copy

parameters from the file originally selected.

2485 | The service test file has an invalid status and cannot be used for this analysis.

Cause: The selected file has a status other than No Analysis.
Action: Select a different service test file, or create a new one and use Replace All to

copy parameters from the file originally selected.

2486 | Could not construct [n] report type. Program will terminate.

Cause A: Full rights to the application’s folders and files is required.
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Action A: Contact a system administrator to have full rights granted.
Cause B: An internal processing and / or hardware error has occurred.
Action B: Contact your Micromeritics service representative.

2487 | Could not start report generator. Error code [n]. Program will terminate.

Cause A: Full rights to the application’s folders and files is required.
Action A: Contact a system administrator to have full rights granted.
Cause B: An internal processing and / or hardware error has occurred.
Action B: Contact your Micromeritics service representative.

2488 | File [n] cannot be opened for editing.

Cause: The specified file is being used in another edit operation.
Action: Check the Windows list to locate the other edit session.

2489 | File [n] cannot be opened for writing.

Cause: The specified file in a Save As operation is already open for edit.
Action: Select a different file for the Save As operation.

2490 | No ‘.INI’ file present. Application will terminate.

Cause: The ASCII .INI file containing initialization information and system options inform-
ation used during program startup does not exist.

Action: Restore the .INI file from back-up, or re-install the software.

2491 | Highlighted fields contain errors. Please correct the errors before dialog box.

Cause: The fields highlighted in red contain invalid entries. The window cannot be closed
until all errors are corrected.

Action: Check the entries, correct the errors, then close the window.

2492 | This field’s entry is invalid.

Cause: The highlighted field contains an invalid entry.
Action: Check the entry and correct the error.

2493 | An entry is required for this field.

Cause: This field requires a valid entry to proceed.
Action: Enter or select an appropriate value.

2494 | Value is out of the valid range.

Cause: The entered value in the highlighted field is outside the valid range of values.
Action: Check the entry, then either enter or select an appropriate value.

2495 | Value is out of the valid range. Enter a value between [n] and [n].
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Cause: The entered value in the highlighted field is outside the valid range of values.
Action: Check the entry, then either enter or select an appropriate value.

2496 | Invalid number.

Cause: An invalid number was entered in the highlighted field.
Action: Check the entry, then either enter or select a valid number.

2497 | This field contains an invalid character.

Cause: An invalid character was entered in the highlighted field.
Action: Check the entry, then enter valid characters.

2498 | The requested change to the Sample’s status is invalid at this time.

Cause: A request to change the file’s status, for example, from automatically collected to
manually entered could not be done.

Action: Contact your Micromeritics service representative. Record the name of the sample
file in which the problem occurred.

2499 | Sequence number must contain at least 3 digits.

Cause: An attempt was made to enter a sequence number that did not contain at least three
digits.

Action: Enter a sequence number that contains at least three digits.

2500 | All sample file names that can be created using the sequence number pattern already exist.
You may want to modify the next sequence number.

Cause: No more sample information files can be created using the currently entered file
name sequence number.

Action: Go to Options > Default Method, then enter another sequence number.

2501 | System resources have reached a dangerously low level. Please close some windows to
avoid the loss of data.

Cause: A large number of windows are open and consuming the system resources
available to all applications.

Action: Close one or more windows. Contact your Micromeritics service representative.

2502 | Error writing to file [n] during print. Error code [n].

Cause: An error occurred in the file being written to during a print operation.
Action: Ensure there is sufficient space on the drive containing the file.

2505 | Error logger cannot be initialized. Error code [n]. Program will exit.

Cause: An internal processing error has occurred.
Action: Contact your Micromeritics service representative.
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2506 | Sample file [n] has a No Analysis status and cannot be used for this operation.

Cause: The selected sample file does not have collected data and cannot be used for
operations, for example, reporting.

Action: Enter the name of a file with a status of Complete, Analyzing, or Entered.
Alternatively, select a sample file from the list box.

2507 | The sample has an invalid status and cannot be used for degassing.

Cause: A sample file has been selected which does not have a No Analysis or Prepared
status.

Action: Select a different file with a status of No Analysis or Prepared.

2508 | The selected file [n] does not contain a valid script.

Cause: The selected service test file does not contain any steps or the file has become cor-
rupted.

Action: If the service test file has no steps, open the service test file and add steps to the
file using the Service Test Script tab .

2513 | Unable to read the calibration file [n].

Cause: An invalid calibration file was selected or cannot be read.
Action: Ensure the media containing the calibration file has no problems.

2514 | Unable to write the calibration file [n].

Cause: An attempt to save calibration data has failed due to possible media problems.
Action A: Ensure the destination location has no problems.
Action B: Choose an alternate media to save the calibration data.

2515 | Warning: Changing the calibration information will affect the performance of the instru-
ment. Only qualified service personnel should do this. Do you wish to proceed?

Cause: The process of performing a calibration operation was started.
Action: Calibration operations should only be done by or under the direction of qualified

service personnel.

2516 | Warning: Keeping a backup copy of the calibration data is recommended by Micro-
meritics. Would you like to do so now?

Cause: A calibration operation was performed and a backup copy is recommended.
Action: Go to Unit [n] > Calibration > Save to File to perform a calibration save

operation.

2517 | Canceling this dialog will reset the calibration state to what it was when this dialog was
first opened. Are you sure you want to cancel?
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Cause: The calibration has not been accepted.
Action: If the calibration operation was successful, click Accept.

2520 | No data points available for reporting.

Cause: The selected sample file does not have collected data and cannot be used for
reporting.

Action: Select a different sample file.

2521 | Unable to program controller.

Cause: A hardware malfunction has occurred.
Action: Contact your Micromeritics service representative.

2522 | Invalid controller application file.

Cause: The application’s control file has been corrupted or deleted.
Action: Reinstall the analysis program.

2523 | Programming controller failed.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2524 | CRC check failed on programming controller.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2525 | Unknown error programming controller.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2526 | Controller download was not successful.

Cause: An internal processing and / or hardware error has occurred.
Action A: Contact your Micromeritics service representative.

2527 | Controller CRC error on boot block.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2528 | Controller DRAM error.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2529 | Controller Com 1: error.
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Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2530 | Controller Com 2: error.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2531 | Controller debug port error.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2532 | The instrument contains a different software version. Do you want to reset it?

Cause: The application has discovered a different version of software operating in the
analyzer.

Action: If there are no analyzers other than the one connected to the computer, click Yes,
then allow the updated software to load.

2533 | Analyzer initialization failed.

Cause: An internal processing and / or hardware error has occurred.
Action: Contact your Micromeritics service representative.

2534 | Unable to establish the TCP connection with [n].

Cause: There was a problem establishing communication with the analyzer.
Action: Ensure that the communications cable is seated firmly in the Ethernet slot at the

analyzer connection and the computer connection.

Ensure that no other Micromeritics application is initializing another instrument. If
there is another Micromeritics application open and initializing an instrument, wait
until the instrument initialization completes or is canceled.

Contact a Micromeritics service representative if this error message continues.

2548 | System status [n] [n].

Cause: There was a problem establishing communication with the analyzer.
Action: Ensure that the communications cable is seated firmly in the Ethernet slot at the

analyzer connection and the computer connection. Contact your Micromeritics
service representative.

2549 | Error accessing online manual file [n].

Cause: The operator’s manual file could not be located.
Action A: Reinstall the application.
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Action B: Copy the contents of the manual folder from the setup CD to the application
directory.

2550 | Attempts to acquire the instrument’s status timed out.

Cause: There was a problem establishing communication with the analyzer.
Action: Ensure that the communications cable is seated firmly in the Ethernet slot at the

analyzer connection and the computer connection. Contact your Micromeritics
service representative.

2551 | Cannot access web page [n].

Cause: The Micromeritics web page for DFT models cannot be accessed. This could be
caused by an ISP problem of high internet traffic.

Action: Try the operation later.

2552 | Configured serial number does not match instrument.

Cause: An instrument was substituted without properly changing the instrument serial
number.

Action: Use the installation program to add or move devices as necessary.

2553 | Dialog ID [n] can not be created!

Cause: A required window could not be found by the software.
Action: Re-install the software.

2554 | File [n] does not contain any report data.

Cause: The selected sample file has no reports selected for printing.
Action: Edit the sample file and select reports to print in Report Options.

2556 | File [n] cannot be opened. It is currently selected for an analysis.

Cause: The sample file is currently selected and is undergoing a critical operation.
Action: Open the sample file after the critical operation has completed.

2557 | Directory [n] does not exist.

Cause: The directory entered in a file selector is not valid.
Action: Enter a valid directory.

2558 | The instrument is busy. The requested operation cannot be executed.

Cause: The instrument is analyzing and cannot be interrupted.
Action: Try the operation later.

2559 | SPC directory [n] does not exist.
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Cause: A directory in one or more of the files selected in a SPC Report is invalid.
Action: Click Samples in the SPC report and verify the locations of all sample files.

2560 | File [n] cannot be created or opened. It has an unrecognized extension.

Cause: The extension specified in the file you are trying to create is not one which is recog-
nized by the application.

Action: Change the extension of the file in the file name field of the file selector.

2563 | Cannot write. File or directory [n] read only.

Cause: The specified file name is marked as read-only
Action: Select a different file name.

2564 | Directory database [n] error [n] .

Cause: There is a problem creating the directory file used in file selectors.
Action: Verify the directory specified in this message is not marked read-only.

2570 | Instrument log database could not be opened: [n].

Cause: There is a problem opening the instrument log file [SN.LOG].
Action: Exit the software. Go to the \HARDWARE subdirectory of the instrument's pro-

gram directory and rename the [SN.LOG] file where SN is the serial number of
the instrument. A new log file will be created.

2571 | Instrument log database [n] error [n].

Cause: There is a problem opening the instrument log file [SN.LOG].
Action: Exit the software. Go to the \HARDWARE subdirectory of the instrument's pro-

gram directory and rename the [SN.LOG] file where SN is the serial number of
the instrument. A new log file will be created.

2572 | File [n] already selected for the analysis.

Cause: The file selected for analysis on one port has already been specified for another
port.

Action: Choose a different sample file for each port.

2573 | A maximum of [n] files may be selected.

Cause: When using one file selector to select samples for all ports, the number of samples
selected exceeds the number of ports on the instrument.

Action: Choose the proper number of samples or pick the sample for each port individually.

2574 | No samples, or completed samples selected.

Cause: When using one file selector to select samples for all ports, either no samples were
selected or a file with Complete status was selected.

Action: Select samples that do not have a Complete status.
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2576 | The instrument [n] is not calibrated.

Cause: The analyzer application is in the process of initializing the instrument and is
unable to locate the calibration files.

Action A: Click OK. Go to Unit [n] > Calibration > Load from File, then select a file
containing calibration data.

Action B: Click OK. Close the application, then use the Setup program to reinstall calibration
files.

2577 | The python directory is missing or some of its contents have been removed.

Cause: When using Advanced reports, a necessary component is missing.
Action: Re-install the software.

2578 | Not enough available resources. Application will have reduced functionality. Reduce the
number of open files or report windows.

Cause: There is not enough memory available to open the requested window.
Action: Close any unnecessary applications, then try the operation again.

2579 | The selected file has a status that is not compatible with the operation requested.

Cause: The selected sample file cannot be used for the selected operation. For example, a
sample file with a Complete status cannot be used for analysis.

Action: Select a different sample file.

2580 | Problem encountered trying to load dbghelp.dll.

Cause: Files necessary for the application are missing or have been corrupted.
Action: Re-install the software.

2581 | Problem encountered trying to create the trace file.

Cause: Files necessary for the application are missing or have been corrupted.
Action: Re-install the software.

2582 | Bad MiniDumpWrite function found in dbghelp.dll.

Cause: Files necessary for the application are missing or have been corrupted.
Action: Re-install the software.

2583 | Error writing trace.

Cause: Files necessary for the application are missing or have been corrupted.
Action: Re-install the software.

2584 | The application encountered an unexpected error and will be halted.

Cause: Files necessary for the application are missing or have been corrupted.
Action: Re-install the software.
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2585 | The following libraries are missing: [n]

Cause: This message is triggered on application start up if any of the library files used by
an application, do not exist on disk.

Action: Add the library into the libraries.

2586 | Sample file [n] has no pressure table entries.

Cause: Trying to analyze a sample file with no pressure entries in Analysis Conditions.
Action: Either edit the Analysis Conditions and enter the pressure points to be used for ana-

lysis, or choose a sample file that already has the pressure points entered.

2588 | Sample file [n] is a [n] file and can not be analyzed on this instrument.

Cause: The specified sample file is from another Micromeritics application which is not
usable with this application.

Action: Select a different sample file.

2589 | Sample file [n] can not be analyzed on this instrument.

Cause: The file specified for analysis cannot be used.
Action: Select a different file.

2590 | The default sample file [n] cannot be selected.

Cause: The default sample file (default method) cannot be used in this operation (e.g., as a
sample file for analysis).

Action: Select a different sample file from the data directory.

2590 | The default sample file [n] can not be overwritten.

Cause: The default sample file (default method) cannot be used in this operation (e.g., as a
sample file for analysis).

Action: Select a different sample file from the data directory.

2590 | An error occurred accessing file or directory [n].

Cause: The default sample file (default method) cannot be used in this operation (for
example — as a sample file for analysis).

Action: Select a different sample file.

2591 | Cannot open problem diagnostic data save file: [n]

Cause: The file necessary for Unit [n] > Diagnostics > Schedule Diagnostic Test (\Hard-
ware\probdiag.dat) could not be read. It is likely corrupted.

Action: Exit the application. Delete or rename the file mentioned in the error message and
restart the software. A new file will be created.

2592 | The selected file has an extension that is not supported by this operation.
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Cause: The selected file does not have a supported file extension.
Action: Open the adsorptive properties file. Open the FPI file selector and select another

file with a supported file extension.

2593 | Warning: The selected file uses Unicode [n] or n[] encoding with non-ASCII characters.

Cause: The Advanced report is not saved in ASCII format, which is required by Python.
Action: Edit the file and save it in ASCII (ANSI) format.

2594 | The selected file uses Unicode [n] or [n] encoding and could not be read.

Cause: The Advanced report is not saved in ASCII format, which is required by Python.
Action: Edit the file and save it in ASCII (ANSI) format.

2595 | The selected file is too large (maximum allowed size is [n] MB).

Cause: The Advanced report is too large.
Action: Edit the file and reduce the size.

4012 | Psat gas in sample file does not match any gas in the unit.

Cause: If usingMeasure psat of a gas in Po and T options in Analysis Conditions, the
selected gas is not one of the selected gases in Unit Configuration.

Action A: If the incorrect psat was selected, change the psat gas.
Action B: If the gas was recently connected to the instrument, update the Unit Configuration.

4013 | The Incremental Dosing option is not available on the selected unit.

Cause: The MicroPore option was selected but the instrument does not have the micropore
option.

Action: Install the MicroPore option before starting the analysis.

4014 | File [n] is not a valid file for conversion.

Cause: The file selected for conversion is not a valid file.
Action: Select only files that have been created by the proper program.

4015 | Error creating export file for sample [n].

Cause: A file error occurred during creation of an export output file.
Action: The output file name may be invalid. Ensure that the target directory exists and is

not full or write protected. The target disk drive may be damaged or inoperative.
Verify that other files may be created on the same drive. Contact your
Micromeritics service representative.

4016 | Sample [n] has no data for export.

Cause: The file selected for export has a status of No Analysis. No export file will be
created.
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Action: Select a file which contains analysis data.

4017 | Damage to the instrument will result if the sample [n] has not been manually evacuated.
Have you evacuated the sample?

Cause: Backfill sample at start of analysis was not selected on the Sample Backfill Options
window. The sample tube is normally at atmospheric pressure when an analysis is
started, and it must be backfilled before the analysis begins to prevent sample
material from being drawn into the manifold.

Action: If the sample tube has been manually evacuated, click Yes. If not, click No, either
perform a manual evacuation or go to the Sample Backfill Options window, then
select Backfill sample at start of analysis.

4020 | Disabling this option may damage the instrument. Are you sure that the sample should not
be backfilled?

Cause: Backfill sample at start of analysis was not selected on the Sample Backfill Options
window. The sample tube is normally at atmospheric pressure when an analysis is
started; it must be backfilled before the analysis begins to prevent sample material
from being drawn into the manifold.

Action: To manually evacuate the sample prior to the start of the analysis, click Yes.
Otherwise, click No, go to the Sample Backfill Options window, then select
Backfill sample at start of analysis.

4021 | The entered [n] value [n] and Temperature Option of the Analysis Conditions) is outside the
range of the pressures listed in the Psat vs Temperature Table ( Adsorptive Properties).

Cause: The entered P0 value is not within the range of pressures selected for analysis.
Action A: Enter a new P0 value.
Action B: Add more pressures and corresponding temperatures to the Analysis Conditions

pressure table to include the presently selected P0 value.

4022 | The entered bath temperature value ([n] and Temperature Options of the Analysis Condi-
tions) is outside the range of the temperatures listed in the Psat vs Temperature Table (Adsorpt-
ive Properties).

Cause: The entered bath temperature is outside of the range of temperatures specified in
the Adsorptive Properties.

Action A: Change the entered temperature.
Action B: Change the adsorptive.
Action C: Add more temperatures and corresponding pressures to Adsorptive Properties.

4023 | The file [n] cannot be prepared for analysis. It is open for editing and contains errors.

Cause: An attempt was made to start an analysis using a file that contains errors and is
open for editing.

Action: Finish editing this file, save and close it, then start the analysis.
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4024 | Backfill gas in sample file does not match any gas in the unit.

Cause: The backfill gas specified in the sample information file does not match the
analysis gas entered in the Unit Configuration.

Action A: If the wrong backfill gas was selected in the sample information file, change the
backfill gas in the file.

Action B: If necessary, attach the appropriate gas cylinder, then enter the gas in the Unit
Configuration.

4025 | There is no [n] attached to the unit.

Cause: The gas shown in the error message is specified in Analysis Conditions but is not
connected to the unit.

Action: Go to Unit [n] > Unit Configuration, then enter the gas.

4026 | Cannot calculate Dubinin-Astkahov: bad least squares data.

Cause: Less than two selected data points are within the fitted pressure range.
Action: Edit the selection of data points on the Dubinin interactive editor or on the Dubinin

Pressures window.

4027 | Fewer than two sample files have data suitable for heat of adsorption reports.

Cause: Less than two of the selected sample files for heat of adsorption reports contain
appropriate data.

Action: Edit the Quantity Adsorbed table, or select other sample files.

4028 | Dubinin calculations cannot be performed because the affinity coefficient of the analysis gas
is zero.

Cause: Dubinin values could not be calculated because the affinity coefficient of the
analysis gas is zero.

Action: Access the Dubinin Report Adsorptive options in the sample file, then enter an
appropriate value for the analysis gas.

4029 | At least two fitted data points are needed for Alpha-S calculations.

Cause: Fewer than two data points fall within the selected Alpha-s range.
Action: Edit either the calculation pressure in the fitted Alpha-s range, or use a different

reference curve.

4030 | Preparations failed in primary data.

Cause: Appropriate data were not available to generate the report.
Action: This message was preceded by a different error message. Refer to the cause/action

of the preceding message.

4030 | P0 cannot be measured at intervals when dosing from the Psat tube.
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Cause: The dosing option in Adsorptive Properties conflicts with the P0 option.
Action: Either edit Adsorptive Properties and change the dosing option, or edit the P0

option in Analysis Conditions.

4031 | Not enough points with a relative pressure in the range [n,n].

Cause: Fewer than two data points selected for the Dubinin report fall within the selected
relative pressure range.

Action: Edit the calculation pressure range or the fitted relative pressure range.

4032 | The Psat tube cannot be for dosing or for measuring saturation pressure when the cryostat
is used.

Cause: The dosing option in Adsorptive Properties cannot be used in conjunction with the
cryostat.

Action: Edit Adsorptive Properties and change the dosing option.

4033 | Not enough points to generate Dubinin Tabular Report.

Cause: There are fewer than two valid data points available for the Dubinin tabular
reports.

Action: At least two micropore pressures must be selected for inclusion in the Dubinin
report. Edit the selection of data points on the Dubinin interactive editor or on the
Dubinin Pressures window.

4034 | Fewer than 2 points available for Dubinin calculations.

Cause: There are fewer than two valid data points available for Dubinin reports in one of
the sample files selected for overlaying.

Action: At least two micropore pressures must be selected for inclusion in the Dubinin
report. Edit the selection of data points on the Dubinin interactive editor or on the
Dubinin Pressures window.

4035 | Cannot calculate optimized Astakhov exponent.

Cause: There are fewer than two valid data points in the relative pressure range specified.
Astakhov reports will not be produced.

Action: At least two pressures must be selected for inclusion in the Astakhov report. Edit
the selection of data points on the Astakhov interactive editor or on the Astakhov
Pressures window.

4036 | Fewer than 2 points available for Horvath-Kawazoe calculations.

Cause: At least two data points must be selected for inclusion in the Horvath-Kawazoe
analysis. No report will be produced.

Action: Edit the selection of points on the Horvath-Kawazoe interactive editor or on the
Horvath-Kawazoe window.
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4037 | Computations failed while processing the primary data set. No reports will be produced.

Cause: The preparation of data for reporting could not be successfully completed. No
Horvath-Kawazoe reports will be produced. This message will always be preceded
with another one containing additional information.

Action: Refer to the error message number which preceded this one for an explanation.

4038 | Fewer than 2 points available for the Langmuir Qm computation.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation requires the value of
the monolayer volume as calculated from the Langmuir equation. The isotherm
must include at least two points above 0.02 relative pressure for the Langmuir
equation to be applied.

Action: The analysis will be performed without the Cheng/Yang correction. Deselect
Apply Cheng/Yang correction on the Horvath-Kawazoe Report Options window to
prevent this message from appearing on future reports.

4039 | The isotherm does not meet the constraints of the Cheng/Yang assumption.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation requires the value of
the monolayer volume as calculated from the Langmuir equation. The isotherm
does not correlate to the Langmuir assumption with a coefficient of 0.98 or more.
The correction is not applicable to this isotherm or to the range of the data points
selected.

Action A: The analysis will be performed without the Cheng/Yang correction. Deselect
Apply Cheng/Yang correction on the Horvath-Kawazoe Report Options window to
prevent this message from appearing on future reports.

Action B: Generate the Langmuir report for the same data points selected for the Horvath-
Kawazoe report. If the Langmuir correlation coefficient can be brought above 0.98
by removing some points at high relative pressure, remove them, then reproduce
the Horvath-Kawazoe reports.

4040 | The value of Qm computed from the Langmuir equation is too low.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation requires the value of
the monolayer volume as calculated from the Langmuir equation. The computed
value is less than the volume adsorbed at the largest relative pressure included in
the analysis. The correction is not applicable to this isotherm or to the range of the
data points selected.

Action: The analysis will be performed and the Cheng/Yang correction will be applied to
all points with a volume adsorbed less than the value of Vm. The pore size will not
be calculated for data points with an invalid volume adsorbed. Deselect Apply
Cheng/Yang correction on the Horvath-Kawazoe Report Options window to clear
this message.

4041 | Cheng/Yang correction is inappropriate for some [n].
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Cause: The Cheng/Yang correction is usually inappropriate for any P/P0 above the
isotherm knee. In some instances, the computed pore sizes may decrease above the
knee. While it is possible to include these relative pressures (usually above 0.1
P/P0) in the analysis, the computed pore sizes for these pressures are usually
meaningless.

Action: Change the data points selected for the Horvath-Kawazoe report to include only
relative pressures at or below the knee of the isotherm, or change the Horvath-
Kawazoe report options so that the Cheng/Yang correction is not applied.

4042 | 0.0 cannot be a starting or ending pressure for a geometric progression from low pressure.

Cause: An attempt was made to generate a pressure table from a geometrically
progressing range.

Action: Change the 0.0 entered value.

4043 | 1.0 cannot be a starting or ending pressure for a geometric progression toward saturation.

Cause: An attempt was made to generate a pressure table from a geometrically
progressing range.

Action: Change the 1.0 entered value.

4044 | Points in the Langmuir report pressure table lie outside the collected data.

Cause: Calculation pressure range is not being used. More than one of the report pressure
table points is above the range of the collected data and more than one is below.

Action: Change the report pressure table to be more consistent with the collected data.

4045 | Points in the report pressure table lie outside the collected data.

Cause: Calculation range is not being used. More than one of the report pressure table
points is above the range of the collected data and more than one is below.

Action: Change the report pressure table to be more consistent with the collected data.

4046 | [n] could not be opened for reading.

Cause: A thickness curve file could not be opened.
Action: If the problem persists, restart the computer, then optionally perform a media

integrity check.

4047 | Warning: An error occurred while reading [n].

Cause: An error happened during a read operation of a thickness curve file.
Action: If the problem persists, restart the computer, then optionally perform a media

integrity check.

4048 | Warning: An error occurred while restoring the heat of adsorption report editor.
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Cause: The state of the heat of adsorption report editor could not be restored. Default
settings will be used.

Action: No action.

4049 | The sample [n] does not have enough data. A minimum of two adsorption points is required.

Cause: A sample file has been included in the Heat of Adsorption report that does not have
enough data.

Action: Remove the file from the selected file list.

4050 | None of the requested quantities adsorbed is within the range of the collected data of more
than one sample file.

Cause: The Heat of Adsorption report failed because the specified quantities are not within
the range of the collected data.

Action: Edit the quantities adsorbed so that they are within the range of the collected data,
or select other sample files.

4051 | The sample [n] does not have any data in the range of the requested quantities adsorbed.

Cause: The sample’s data cannot be interpolated to any of the quantities adsorbed.
Action: Edit the quantities adsorbed so that they are within the range of the collected data.

4052 | Fewer than three points are selected for this report.

Cause: At least three points are required for the BET calculations.
Action: Edit the calculation range in the BET report.

4053 | At least two data points must be selected for t-Plot calculations.

Cause: At least two points are required for the t-Plot calculations.
Action: Edit the calculation range for the t-Plot report.

4054 | Fewer than two data points are inside the fitted thickness range.

Cause: At least two points must be within the fitted thickness range for the t-Plot
calculations.

Action A: Edit the calculation range for the t-Plot report.
Action B: Edit the fitted thickness range in the t-Plot report editor.

4055 | A positive BET surface area was not calculated. Please check your BET Report.

Cause: Fewer than two points were assigned to the requested surface area calculation in
the collected data table.

Action A: Assign more points to the surface area calculation.
Action B: Select a different surface area in the t-Plot report editor.

4056 | A positive Langmuir surface area was not calculated. Please check your Langmuir report.
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Cause: Fewer than two points were assigned to the requested surface area calculation in
the collected data table.

Action A: Assign more points to the surface area calculation.
Action B: Select a different surface area in the t-Plot report editor.

4057 | At least two data points are needed for Freundlich calculations.

Cause: Less than two data points have been selected for the Freundlich report; at least two
are required.

Action: Edit the selection of points on the Freundlich interactive editor or on the Freundlich
Pressures window.

4058 | At least two data points are needed for Temkin calculations.

Cause: Less than two data points have been selected for the Temkin report; at least two
are required.

Action: Edit the selection of points on the Temkin interactive editor or on the Temkin
Pressures window.

4059 | Fewer than 2 points available for MP-Method calculations.

Cause: At least two points are required for the MP-Method calculations.
Action: Edit the calculation range for the MP-Method report.

4060 | Sample [n] contains no data points.

Cause: An attempt was made to save a sample without collected data as a t-curve or
alpha-S curve.

Action: Repeat the Save As t-curve or Save As alpha-S operation after opening a sample
that has collected data.

4061 | The t-curve must contain at least 2 points.

Cause: At least two points are required in a thickness curve definition.
Action: Edit the thickness curve.

4062 | Error during report preparation.

Cause: An internal processing error has occurred.
Action: Contact your Micromeritics service representative.

4063 | No subreports selected.

Cause: A report (e.g. BJH) comprised of several reports has no subreport selected.
Action: Edit the report in Report Options and select at least one subreport.

4067 | No data points are within the range of pressures in the reference isotherm.
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Cause: There are no collected data points within the range of pressures in the reference
isotherm.

Action: Select data points in the range of the reference isotherm, or select a more
appropriate reference isotherm.

4068 | No points were selected for the f-Ratio report.

Cause: The f-Ratio report does not have any points selected.
Action: Edit the selection of data points on the f-Ratio window.

4069 | Dosing method choice is invalid - the Analysis Conditions choice of Absolute pressure dosing
requires that the Adsorptive Properties Dosing Method is set to Normal.

Cause: There is an incompatibility between the analysis conditions choice of Absolute pres-
sure dosing and the adsorptive properties dosing method.

Action: Edit one of the choices.

4070 | Unable to load deconvolution model [n].

Cause: The list of available models was corrupted; therefore, the model selected could not
be loaded for the deconvolution.

Action: Exit the application. Reinstall the software, then try again.

4071 | The selected pressures points do not form a valid set for deconvolution.

Cause: The data points selected for analysis do not contain enough information to allow a
DFT data reduction.

Action: At least two points with strictly increasing pressures and volumes adsorbed are
required for a DFT Plus data reduction. Edit the selection of data points on the
DFT interactive editor or on the DFT Pressures window.

4072 | The range of pressures selected is too small to deconvolute using this model.

Cause: A null result was found using the selected model.
Action: At least two points with strictly increasing pressures and volumes adsorbed are

required for a DFT Plus data reduction. Edit the selection of data points on the
DFT interactive editor or on the DFT Pressures window.

4073 | The analysis gas [n] does not match the model gas [n].

Cause: The model assumes a specific gas, and the sample file uses a different one.
Action: Select a model that assumes the same gas.

4074 | The analysis temperature [n] does not match the model temperature [n].

Cause: The temperature for the selected model did not match the analysis temperature.
Action: Select a different model.
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4075 | The models cannot be located in the models folder. Reinstall the software.

Cause: The models could not be located. They may have been inadvertently deleted or
moved.

Action: Reinstall the software.

4076 | Invalid sample file - Adsorptive Properties Non-condensing adsorptive cannot be used unless
Analysis Conditions Absolute pressure dosing is selected.

Cause: Non-condensing adsorptive is selected in Analysis Conditions / Adsorptive Prop-
erties and the Absolute pressure dosing check box is not selected in Analysis Condi-
tions.

Action: If Absolute pressure dosing is needed, select Absolute pressure dosing on the Ana-
lysis Conditions window. Otherwise, edit the Analysis Conditions / Adsorptive
Properties and deselect Non-condensing adsorptive.

4077 | Cannot get surface area for: [n]

Cause: The Isotherm report for the named overlay file has Per gram selected for the
Volume Adsorbed, and the Isotherm report for the primary file has a surface area
option selected for the Volume Adsorbed.

Action A: Edit the Isotherm report for the named overlay file, then select a surface area
option for Volume Adsorbed.

Action B: Click Overlays on the Report Options window of the primary file, then remove the
named overlay file from the list.

4078 | Slope and Y-Intercept cannot be determined from the selected points.

Cause: The Langmuir report cannot be generated from the selected points.
Action: Edit the calculation pressure range in the Langmuir report pressure window.

4080 | The compressibility factor table has [n] pressure entries. Only [n] are allowed.

Cause: The fluid property information file has too many rows of compressibility inform-
ation.

Action: Delete rows for pressures that are not likely to be encountered in the analysis.

4081 | In the compressibility factor table for [n], the 4 temperatures below [n] and 7 temperatures
above must span at least 10 [n].

Cause: The fluid property information file does not have enough columns of com-
pressibility information for temperatures near the analysis temperature.

Action: Add rows for temperatures near the analysis temperature.

4082 | Compressibility factors must be greater than zero for temperatures near ambient and pres-
sures up to the maximum manifold pressure.

Cause: Fluid property information indicates that the analysis gas will condense.
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Action A: Check that the correct fluid properties are being used.
Action B: Change the pressure or temperature range for the analysis.

4083 | All rows of [n] do not have the same number of entries. Some rows will be filled or trun-
cated.

Cause: The compressibility table does not have the same number of temperature entries for
each pressure.

Action: Check the fluid property file for errors.

4084 | [n] does not have the correct format. Please load a fluid property information file.

Cause: The selected file was not a fluid property file.
Action: Select a file with fluid property information.

4085 | The temperatures of [n] are not strictly ascending.

Cause: The temperatures for the columns of compressibility factors are not in increasing
order.

Action: Order the columns of compressibility factors by increasing temperature.

4086 | The pressures of [n] are not strictly ascending.

Cause: The pressures for the rows of compressibility factors are not in increasing order.
Action: Order the rows of compressibility factors by increasing pressure.

4087 | Error reading [n].

Cause: An error occurred while reading the selected fluid property file.
Action: The file is likely corrupted. Restore the file from backups if possible. If the file

was one provided with the software, re-install the software.

4088 | Error writing [n].

Cause: An error occurred while writing the selected fluid property file.
Action: Check the disk and enure there is plenty of unused space. Scan the disk for bad sec-

tors, then retry the operation.

4089 | Can not open [n] for reading.

Cause: The selected fluid property information file could not be opened.
Action: The file is likely corrupted. Restore the file from backups if possible. If the file

was one provided with the software, re-install the software.

4090 | Can not open [n] for writing.

Cause: The selected fluid property information file could not be opened.
Action: Check the disk and ensure there is plenty of unused space. Verify if the file has

been marked as read-only. Restore the file from backups if possible. If the file was
one provided with the software, re-install the software.
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4090 | The compressibility factor table for [n] is empty.

Cause: The fluid property information in the file selected for analysis does not have any
compressibility factors.

Action: Update the adsorptive properties files using a different fluid properties file.

4091 | Can not load [n] because the fluid property table is too large.

Cause: The fluid property information file is too large to be stored in a sample file.
Action A: Verify that the selected file is really a fluid property information file.
Action B: Delete unneeded rows and columns from the compressibility factor table.

4093 | Pressure targets at or above [n,n] will be excluded to prevent condensation in the manifold.
Continue with the analysis?

Cause: The pressure table contains some points that would require dosing above the
adsorptive's saturation pressure.

Action: Click No and modify the pressure table before restarting the analysis. Click Yes
and perform the analysis omitting the points that would cause condensation.

4094 | All pressure targets were excluded. Analysis canceled.

Cause: All target pressures would require dosing above the adsorptive's saturation pres-
sure.

Action A: Verify that the saturation pressures for the adsorptive are correct.
Action B: Use lower target pressures in the pressure table.

4095 | The compressibility file [n] is obsolete. Please load the fluid property information file (.FPI)
for the adsorptive.

Cause: The sample file includes obsolete compressibility information from a *.DAT file.
Action: Load the *.FPI file for the adsorptive.

4096 | The Analysis Conditions dosing option Low pressure incremental dose mode cannot be used
with the Adsorptive Properties dosing method Selective Adsorption.

Cause: There is a conflict between Analysis Conditions selections and Adsorptive Prop-
erties selections.

Action: Change the Analysis Conditions dosing option or do not use selective adsorption.

4097 | The Analysis Conditions dosing option Maximum volume increment cannot be used with the
Adsorptive Properties dosing method Selective Adsorption.

Cause: There is a conflict between Analysis Conditions selections and Adsorptive Prop-
erties selections.

Action: Change the Analysis Conditions dosing option or do not use selective adsorption.

4098 | The Analysis Conditions dosing optionFirst pressure fixed dose cannot be used with the
Adsorptive Properties dosing method Selective Adsorption.
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Cause: There is a conflict between Analysis Conditions selections and Adsorptive Prop-
erties selections.

Action: Change the Analysis Conditions dosing option or do not use selective adsorption.

4099 | The Analysis Conditions dosing option Selective Adsorption requires the Analysis Conditions
choice of Absolute pressure dosing.

Cause: There is a conflict between Analysis Conditions selections and Adsorptive Prop-
erties selections.

Action: Change the Analysis Conditions to use absolute pressure dosing,or do not use select-
ive adsorption.

4100 | The Analysis Conditions choice of Absolute pressure dosing requires that the Adsorptive Prop-
erties dosing method is set to Normal or Selective Adsorption.

Cause: There is a conflict between Analysis Conditions selections and Adsorptive Prop-
erties selections.

Action: Change the Analysis Conditions to use relative pressure dosing,or change the
Adsorptive Properties dosing method.

4112 | Hard-sphere diameter, molecular weight, and mass flow constant have been updated from
the fluid property information.

Cause: A new fluid property information file was loaded. The indicated fields have been
updated with values from the file.

Action: This message is informational; no action is required.

4113 | An old version of the fluid property information was read. Please upgrade.

Cause: An older version of a fluid property information file was detected.
Action: Newer versions of the fluid property information files were installed with the soft-

ware. Locate a newer file in the Param directory.

4114 | The backfill gas [n] in sample file [n] does not match any gas in the unit.

Cause: The selected backfill gas for the Analysis Conditions is not one of the gases con-
nected to the instrument. Go to Unit [n] > Unit Configuration and verify the gas.

Action: Edit the Analysis Conditions backfill gas and change the gas to one which is con-
nected to the instrument.

4115 | The P0 [n] in sample file [n] does not match any gas in the unit.

Cause: The selected gas for the P0 and T for the Analysis Conditions is not one of the
gases connected to the instrument. Go to Unit [n] > Unit Configuration and verify
the gas.

Action: Edit the Analysis Conditions P0 and T and change the gas to one which is con-
nected to the instrument.

4116 | The adsorptive [n] in sample [n] is different from port [n] adsorptive [n].
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Cause: The adsorptive selected for one analysis port is different from the adsorptive that is
in the sample file selected for another port. All ports must use the same adsorptive.

Action: Edit the Analysis Conditions and change the adsorptive to match the other ports.

4117 | Gas [n] in sample file [n] does not match any gas in the unit.

Cause: The adsorptive selected for the analysis is not one of the gases connected to the
instrument. Go to Unit [n] > Unit Configuration and verify the gas.

Action: Edit the Analysis Conditions and change the adsorptive to one which is connected
to the instrument.

4117 | Analysis gas in sample file [n] is not specified.

Cause: The adsorptive selected for the analysis is not one of the gases connected to the
instrument. Go to Unit [n] > Unit Configuration and verify the gas.

Action: Edit the Analysis Conditions and change the adsorptive to one which is connected
to the instrument.

4118 | The pre-analysis backfill gases differ. Each port must use the same backfill gas.

Cause: The pre-analysis gas selected for one port in the analysis is different from the
adsorptive that is in the sample file selected for another port. All ports must use the
same adsorptive.

Action: Edit the Analysis Conditions and change the pre-analysis gas to match the other
port(s).

4119 | The post-analysis backfill gases differ. Each port must use the same backfill gas.

Cause: The post-analysis gas selected for one port in the analysis is different from the
adsorptive that is in the sample file selected for another port. All ports must use the
same adsorptive.

Action: Edit the Analysis Conditions and change the post-analysis gas to match the other
port(s).

4120 | The analysis gases differ. Each port must use the same analysis gas.

Cause: The -analysis gas selected for one port in the analysis is different from the gas that
is in the sample file selected for another port. All ports must use the same gas.

Action: Edit the Analysis Conditions and change the analysis gas to match the other port(s).

4121 | The Psat gases differ. Each port must use the same gas for P0 or Psat measurements.

Cause: The gas selected for Psat measurement in the analysis is different from the adsorpt-
ive that is in the sample file selected for another port. All ports must use the same
gas.

Action: Edit the Analysis Conditions and change the Psat measurement to match the other
port(s).

4122 | The dosing source gases differ. When dosing from a sample port or the Psat tube and the
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dosing source is charged from a gas inlet, each port must use the same dosing source gas.

Cause: The gas selected for dosing for one port in the analysis is different from the adsorpt-
ive that is in the sample file selected for another port. All ports must use the same
gas.

Action: Edit the Analysis Conditions and change the gas selected for dosing to match the
other port(s).

4123 | Helium adsorptive properties could not be found in the adsorptive properties library.

Cause: There is no Adsorptive Properties file for helium available to the application.
Action: An Adsorptive Properties file for helium was installed with the software. It was

likely deleted. Either re-install the software, or create an Adsorptive Properties
file for helium.

4124 | Dosing from port [n] cannot be done because a sample is selected for analysis on that port.

Cause: The Analysis Conditions of a sample file calls for dosing from a port which has a
sample file assigned to it for analysis.

Action: If the Analysis Conditions are correct for the currently selected sample file, clear
the sample file selection from the port used for dosing. Otherwise, select a dif-
ferent sample file.

4125 | Determination of P0 from the dosing source can only be done if dosing is done from the Psat
tube, sample port, or vapor source.

Cause: If measuring Psat over the source, one of the dosing options listed in the error mes-
sage must be selected.

Action: Select one of the dosing options from the error message.

4126 | Warning: Measured ambient temperature is not available for calculating the maximum man-
ifold pressure. Analysis will continue using [n].

Cause: Measured ambient temperature is not available. Analysis will continue with a reas-
onable room temperature

Action: Displayed as a warning. Continue the analysis.

4127 | The compressibility factor table has [n] temperature entries. Only [n] are allowed.

Cause: The fluid property information file has too many columns of compressibility inform-
ation.

Action: Delete columns for temperatures that are not likely to be encountered in the ana-
lysis.

4128 | Error reading from [n].

Cause: There was an error importing data from the Clipboard using copy/paste.
Action: Retry the operation.

4132 | Unable to read model data from directory: [n].
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Cause: A DFT model file is either missing from the Models subdirectory or has become
corrupted.

Action: Restore models from a backup or re-install the software to provide the DFT mod-
els.

4133 | Unable to open model file: [n].

Cause: A DFT model file is either missing from the Models subdirectory or has become
corrupted.

Action: Restore models from a backup or re-install the software to provide the DFT mod-
els.

4135 | HOA file [n] does not exist.

Cause: The sample file in the Heat of Adsorption report list does not exist.
Action: Go to Report > Heat of Adsorption. Click Add Samples, then select the sample

file.

4136 | HOA file [n] is corrupt.

Cause: The sample file in the Heat of Adsorption report list is corrupt.
Action: Go to Report > Heat of Adsorption. Select the corrupt sample file, then click

Remove Sample. Rerun the Heat of Adsorption report.

4137 | Measured P0 is not allowed with a cryostat.

Cause: In an analysis using a cryostat, Measured P0 was specified in Analysis Conditions.
Action: Edit the P0 and T options in Analysis Conditions and choose a different option.

4138 | Only entered temperature is allowed with a cryostat.

Cause: In an analysis using a cryostat, the analysis conditions specify something other than
entered temperature in the P0 and T options.

Action: Edit the existing file and change the P0 and T options, or choose a different sample
file.

4139 | Dosing from Psat tube is not allowed with cryostat.

Cause: In an analysis using a cryostat, dosing from Psat tube was specified in the Adsorpt-
ive Properties in Analysis Conditions.

Action: Edit Analysis Conditions / Adsorptive Properties and choose a different option.

4400 | The computer does not have the communications port specified for the SmartPrep(s). Can-
not initialize.

Cause: The communications port associated with this unit was not valid.
Action: Run the setup program and set up the unit on a valid port.

4401 | The communications port specified for the SmartPrep(s) is already in use. Cannot initialize.
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Cause: The communications port associated with this instrument is in use by some other
program in the system.

Action: Close the other program to release the port. Restart the analysis application.

4402 | The communications port specified for the SmartPrep cannot be accessed. Cannot ini-
tialize.

Cause: The communications port associated with this unit was not valid.
Action: Run the setup program and set up the unit on a valid port.

4403 | Cannot communicate with SmartPrep Unit [n].

Cause: The communications port associated with this unit was not valid.
Action: Run the setup program and set up the unit on a valid port.

4404 | The application version of the SmartPrep Unit [n] - S/N: [n] is invalid.

Cause: The controller software running on the designated instrument is invalid.
Action: Use the SmartPrep setup program to download the proper controller software to the

instrument, or if unavailable, contact a Micromeritics service representative.

4404 | The application version of the SmartPrep Unit [n] is invalid.

Cause: The controller software running on the designated instrument is invalid.
Action: Use the SmartPrep setup program to download the proper controller software to the

instrument, or if unavailable, contact a Micromeritics service representative.

4405 | Fatal communications error with SmartPrep Unit [n].

Cause: There was a fatal error in the serial communications between the application and
the SmartPrep Instrument Controller. All displays for that SmartPrep will be
closed.

Action: Ensure that the SmartPrep is properly chained to the computer on the com-
munications port configured in the Setup program. Stop and restart the application.
Contact a Micromeritics service representative if this error message continues.

4406 | A maximum of [n] files may be selected.

Cause: Too many files were selected for the SmartPrep start degas operation.
Action: Retry the operation with the proper number of files (1 per port).

4409 | A free IP address on the same subnet as [n] could not be found.

Cause: All IP addresses on the network for the Ethernet card specified during installation
are in use by other Micromeritics applications on this computer.

Action A: Uninstall unused Micromeritics applications.
Action B: Configure a different Ethernet card for use by the application using the application

installer.

4411 | Error dosing.

D Error Messages

ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015

D - 35



D Error Messages

Cause: The backfill timed out.
Action: Ensure there is gas available and the pressure regulator is set to the appropriate

pressure. Also ensure that the gas supply regulator shutoff valve is open.

4412 | Error calibrating the servo.

Cause: Calibration results are out of range.
Action: Follow standard calibration procedures and try again. Contact a Micromeritics ser-

vice representative if this error message continues.

4413 | Error overheating on port [n] . Current = [n,n], Target = [n,n], Limit = [n.n].

Cause: The temperature of the indicated mantle exceeded the maximum allowed value.
Action: Ensure the power and thermocouple connectors for the mantle are properly

installed. Contact a Micromeritics service representative if this error message con-
tinues.

4414 | Error thermocouple unplugged on port [n]. Target = [n,n].

Cause: The thermocouple is unplugged or has malfunctioned.
Action: Ensure the thermocouple is plugged in. Contact a Micromeritics service rep-

resentative if this error message continues.

4415 | Degas transducer zero calibration failed. Current Offset = [n] counts, Current Pressure =
[n,n], New Offset = [n] counts, Nominal = [n] counts.

Cause: The pressure transducer offset exceeds the recommended limit.
Action: Ensure that the vacuum pump is on. Repeat the pressure offset calibration..Contact

a Micromeritics service representative if this error message continues.

4416 | Degas transducer scale calibration failed. Reference = [n,n], Current = [n,n], New Scale =
[n,n] / count, Nominal = [n,n] / count.

Cause: The transducer scale calibration was rejected.
Action: Contact your Micromeritics service representative.

4417 | Degas vacuum gauge low point calibration failed. Reference = [n,n] / count, Current = [0]
counts.

Cause: The transducer offset calibration was rejected.
Action: Contact your Micromeritics service representative.

4418 | Degas vacuum gauge high point calibration failed. Reference = [n,n], Current = [0] counts.

Cause: The vacuum gauge calibration was rejected.
Action: Contact your Micromeritics service representative.

4419 | Error reading servo DAC.
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Cause: There is a problem with the servo DAC timing out.
Action: Contact your Micromeritics service representative.

4422 | The file [n] does not exist.

Cause: The selected file does not exist on the disk drive.
Action: Select an existing file. Ensure that the file has been created before use.

4423 | The sample [n] is already selected on port [n].

Cause: The selected sample file is already selected for use on a different port.
Action: Select another sample file for this port.

4424 | The file [n] on port [n] could not be opened. Check if the sample file is already in use for
editing or analysis.

Cause A: The selected sample file is already open by this or another application.
Cause B: The selected sample file is damaged.
Action: Select another sample file.

4425 | The sample [n] on port [n] has an invalid status and cannot be used for degassing.

Cause: The status of the file is not consistent with the current operation.
Action: Select a sample file that has not been used for an analysis. Only sample files with

a status of No Analysis or Prepared may be selected.

4426 | Port [n] is currently in use. Operation cannot be started.

Cause: The current operation cannot be completed because the port is already in use.
Action: Wait for port to terminate operation or perform the desired operation on an unused

port.

4430 | Pressure level is out of range.

Cause: The reference gauge reading is not valid for scaling the manifold pressure trans-
ducer.

Action: Adjust the manifold pressure until the reference gauge reading is in the recom-
mended scale calibration range.

4431 | Pressure is out of range.

Cause: The reference gauge reading is not valid for scaling the manifold pressure trans-
ducer.

Action: Adjust the manifold pressure until the reference gauge reading is in the recom-
mended scale calibration range.

6500 | Failed to evacuate manifold to VAC SET in [n] seconds. Calibration canceled.

Cause A: The vacuum set point is set too low.
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Action A: Reset VAC SET point to 5.0 mmHg. If the VAC SET point is already at 5.0 mmHg
or above, the vacuum gauge may need servicing.

Cause B: Leak in manifold.
Action B: Locate the leak and repair it. Restart calibration.
Cause C: Valve failure.
Action C: Identify the leaking valve. Contact your Micromeritics service representative.

6240 | Leak test failed on port [n].

Cause: With the sample port valve closed, the sample pressure increased by 0.15 mmHg
before the leak test duration was completed.

Action: Check sample tube fitting and ensure that it is securely attached to the port. Then
restart the analysis.

6241 | Maximum time limit exceeded before the port [n] elevator reached the UP position.

Cause A: The maximum time for the analysis was exceeded before the elevator reached the
UP position. Ice may be present in the bottom or the neck of the dewar.

Action A: Check the dewar and remove ice if necessary. Then restart the analysis.
Cause B: The Psat tube is interfering with elevator movement.
Action B: Ensure the Psat tube is close to the sample tube and the dewar lid is over both the

sample and Psat tubes. Then restart the analysis.

6241 | Maximum time limit exceeded before the port [n] elevator reached the DOWN position.

Cause A: The maximum time for the analysis was exceeded before the elevator reached the
UP position. Ice may be present in the bottom or the neck of the dewar.

Action A: Check the dewar and remove ice if necessary. Then restart the analysis.

6242 | Time limit exceeded while evacuating Psat tube.

Cause: The maximum time allotted for the Psat tube evacuation operation in a 2020 Phys-
isorption analysis was exceeded.

Action: Contact your Micromeritics service representative.

6243 |Time limit exceeded while dosing Psat tube to 925 mmHg.

Cause: The sample was at a pressure greater than 0.5 mmHg at the start of the leak test. A
leak test can not be performed unless the sample has been fully evacuated.

Action: Insert an evacuation task immediately before the leak test. If an evacuation task is
already present, ensure that the evacuation is being performed at the same tem-
perature as the test and that the duration of the evacuation is adequate.

6501 | The 1000 mmHg transducer offset exceeds recommended limits: [n]

Cause: The Pressure Gauge Calibration operation showed the transducer offset exceeds
the recommended limit.

Action: Repeat the Pressure Gauge Calibration operation. .Contact a Micromeritics ser-
vice representative if this error message continues.
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6502 | The 10 mmHg transducer offset exceeds recommended limits: [n]

Cause: The Pressure Gauge Calibration operation showed the transducer offset exceeds
the recommended limit.

Action: Repeat the Pressure Gauge Calibration operation. .Contact a Micromeritics ser-
vice representative if this error message continues.

6503 | The 0.1 mmHg transducer offset exceeds recommended limits: [n]

Cause: The Pressure Gauge Calibration operation showed the transducer offset exceeds
the recommended limit.

Action: Repeat the Pressure Gauge Calibration operation. .Contact a Micromeritics ser-
vice representative if this error message continues.

6504 | Unable to write the calibration file [n].

Cause: A Save to File operation failed.
Action: Confirm there is sufficient free space on the media receiving the file and that the

media is not corrupted. Contact a Micromeritics service representative if this error
message continues.

6505 | Unable to read the calibration file [n].

Cause: A Load from File operation failed.
Action: Confirm there is sufficient free space on the media receiving the file and that the

media is not corrupted. Contact a Micromeritics service representative if this error
message continues.

6506 | Calibration file for [n] is invalid.

Cause: A Load from File operation failed.
Action: Confirm there is sufficient free space on the media receiving the file and that the

media is not corrupted. Contact a Micromeritics service representative if this error
message continues.

6516 | Sample pressure greater than [n,n] is not allowed.

Cause: An absolute pressure greater than (pressure) mmHg was attained during low pres-
sure dosing (either fixed dose mode or incremental dose mode).

Action: The analysis was canceled. All previously collected data were stored.

6517 | Total volume dosed greater than [n,n] is not allowed.

Cause: The maximum total volume dosed in a 2020 Physisorption analysis was exceeded.
Action: Contact your Micromeritics service representative.

6518 | Pressure of [n,n] exceeds the maximum manifold pressure of [n,n].

Cause: The maximum pressure in a 2020 Physisorption analysis was exceeded.
Action: Contact your Micromeritics service representative.

D Error Messages

ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015

D - 39



D Error Messages

6519 | Psat gas is not condensing.

Cause A: The working dewar does not contain enough bath liquid.
Action A: Retry the operation after filling the dewar.
Cause B: The Psat gas is contaminated.
Action B: Replace the Psat gas supply.
Cause C: The Psat tubing from the regulator to the instrument is contaminated.
Action C: Pump out the tubing.

6520 | Power failure detected.

Cause: A power failure occurred in the specified unit, and any analyses in progress were
terminated.

Action: If the program was running and an Uninterruptible Power Supply (UPS) was
attached, data points were collected and stored in the sample file. If enough data
points were not collected, create another sample information file and start a new
analysis.

6521 | Transducer overrange detected.

Cause: The transducer in the specified unit has detected a pressure equal to or greater than
1000 mmHg. The exhaust port on the sample tube may be blocked.

Action A: Inspect for and clear any blockage.
Action B: Observe caution when operating the analyzer manually. Contact a Micromeritics

service representative if this error message continues.

6522 | Time limit exceeded while evacuating manifold.

Cause A: Maximum manifold evacuation time was exceeded before the vacuum set point
was achieved. Vacuum pump may be turned off.

Action A: Turn on vacuum pump switch. Then restart the analysis.
Cause B: The vacuum pump oil level is low.
Action B: Check the vacuum pump oil level and add more oil if necessary. Then restart the

analysis.
Cause C: The manifold is contaminated or leaking.
Action C: Correct the problem. Refer to the Testing for Leaks section in this manual. Then

restart the analysis.

6523 | Analysis canceled: Time limit exceeded while evacuating sample (unrestricted).

Cause: The maximum time for evacuating the sample through the unrestricted valve was
exceeded. Possible causes are a leak in the sample tube fitting or a crack in the
sample tube.

Action: Check the sample tube and the sample tube fitting; ensure that the tube is securely
attached to the port. Then restart the analysis.

6524 | Analysis canceled: Time limit exceeded while evacuating sample (restricted).
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Cause: The maximum time allowed for evacuating the sample through the restricted valve
was exceeded.

Action: Check the sample tube and the sample tube fitting to ensure that the tube is
securely attached to the port. Verify that the sample is properly degassed. Then
start the analysis again.

6525 | Power failure lasted too long.

Cause: A failure on an analyzer which has an Uninteruptible Supply attached has lasted
for an hour or more; therefore, the analysis has been canceled.

Action: Determine the cause of the failure and correct it.

6526 | Time limit exceeded while backfilling manifold to [n,n] with [n].

Cause A: The maximum time was exceeded before the target pressure point was reached.
The gas regulator may be set too low or turned off.

Action A: Set the gas regulator to 10 psig (0.7 bar). Then resume the analysis.
Cause B: The gas bottle is empty.
Action B: Connect a new gas bottle. Then resume the analysis.

6527 | Time limit exceeded while dosing manifold to [n,n] with [n].

Cause A: The maximum time was exceeded before the target pressure point was reached.
The nitrogen regulator may be set too low or turned off.

Action A: Set the analysis gas regulator to 10 psig (0.7 bar) then resume the analysis.
Cause B: The analysis gas cylinder is empty.
Action B: Connect a new analysis gas cylinder then resume the analysis

6528 | Low pressure gauge offset too high [n,n].

Cause: A check of the 10 mmHg or 0.1 mmHg gauge’s offset during an automatic oper-
ation indicated it was too high.

Action: Contact a Micromeritics service representative if this error message continues.

6529 | 1000 mmHg pressure gauge offset is too high [n,n].

Cause: A check of the 1000 mmHg gauge’s offset during an automatic operation indicated
it was too high.

Action: Contact a Micromeritics service representative if this error message continues.

6530 | Volume calibration canceled due to failure (code [n]).

Cause: A problem occurred during volume calibration.
Action: Contact your Micromeritics service representative.

6531 | The gas configuration file for [n] is invalid.

Cause: The contents of the gas configuration file are not valid.
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Action: Confirm there is sufficient free space on the media receiving the file and that the
media is not corrupted). Contact a Micromeritics service representative if this error
message continues.

6534 | Instrument [n] is not calibrated.

Cause: Calibration information for various analyzer components are missing.
Action: Run the application Setup program and reinstall calibration information for the spe-

cified unit.

6535 | Problem encountered evacuating to target [n,n], last pressure = [n,n], elapsed time = [n,n].

Cause: Evacuation during the manifold dosing operation did not come within the allowed
range of the target.

Action: Check that the outlet stage of the gas regulator is within specification. If the prob-
lem occurs frequently, contact a Micromeritics service representative

6538 | Power failure detected. The sample is in an unknown condition. A run termination will be
performed for safety.

Cause: A total power failure occurred and an Uninterruptible Power Supply was not con-
nected while an analysis was in progress.

Action: Allow the analysis to terminate.

6546 | Desorption sample pressure less than [n,n] is not allowed.

Cause: A desorption target pressure less than 0.050 mmHg was requested. A target abso-
lute pressure less than 0.050 mmHg can correspond to various target relative pres-
sures depending on the value of P0. For example, if P0 = 760 mmHg, a relative
pressure less than 0.050 / 760.0 = 0.0000658 will result in an error. The analysis
will terminate.

Action: Remove the low target relative pressure from the pressure table.

6547 | Vacuum group is not configured.

Cause: The vacuum group is incorrectly configured, or a 2060 attempted to access a
vacuum system belonging to another vacuum group.

Action: Open the Vacuum Groups window. Ensure that only instruments shown in this dia-
log are currently powered on and physically connected to the same network. If
other 2060s are on the same network, ensure that they are correctly configured or
powered off.

6548 | A request to access the shared vacuum system was rejected

Cause: The vacuum group is incorrectly configured, or a 2060 attempted to access a
vacuum system belonging to another vacuum group.

Action: Open the Vacuum Groups window. Ensure that only instruments shown in this dia-
log are currently powered on and physically connected to the same network. If

D - 42 ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015



other 2060s are on the same network, ensure that they are correctly configured or
powered off.

6549 | The shared vacuum system is not responding to requests for access.

Cause: The instrument managing a vacuum group is either powered off or is not connected
to the same network as another instrument in the same vacuum group.

Action: Open the Vacuum Groups window. Ensure that all instruments shown in this win-
dow are currently powered on and physically connected to the same network.

6550 | Opening this valve will prevent an analysis on Unit [n] Serial [n] from proceeding. Open
this valve?

Cause: A manual vacuum valve operation was requested on an instrument while another
instrument in the same vacuum group was using the shared vacuum system.

Action: Press Yes to interrupt the current vacuum system operation and actuate the vacuum
valve. Press No to allow the current vacuum system operation to continue; the
manual vacuum valve operation will not be performed.

6551 | The vacuum system is in use by Unit [n] Serial [n]. Open this valve?

Cause: A manual vacuum valve operation was requested on an instrument while another
instrument in the same vacuum group was using the shared vacuum system.

Action: Press Yes to interrupt the current vacuum system operation and actuate the vacuum
valve. Press No to allow the current vacuum system operation to continue; the
manual vacuum valve operation will not be performed.

6551 | The vacuum system is purging. Open this valve?

Cause: A manual vacuum valve operation was requested on an instrument while another
instrument in the same vacuum group was using the shared vacuum system.

Action: Press Yes to interrupt the current vacuum system operation and actuate the vacuum
valve. Press No to allow the current vacuum system operation to continue; the
manual vacuum valve operation will not be performed.

6551 | The vacuum system may be in use by another instrument. Open this valve?

Cause: A manual vacuum valve operation was requested on an instrument while another
instrument in the same vacuum group was using the shared vacuum system.

Action: Press Yes to interrupt the current vacuum system operation and actuate the vacuum
valve. Press No to allow the current vacuum system operation to continue; the
manual vacuum valve operation will not be performed.

6552 | The vacuum system is not responding.

Cause: The instrument managing the vacuum system was unavailable when an analysis
was started on another instrument in the same vacuum group.

Action: Open the Vacuum Groups window. Ensure that all instruments shown in this win-
dow are currently powered on and physically connected to the same network .
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6553 | Another instrument is currently using the vacuum system for a manual vacuum operation.

Cause: An analysis was started on one instrument while another instrument in the same
vacuum group had a vacuum valve open either due to a manual vacuum valve oper-
ation or to a manifold over-pressure event .

Action:

6554 | Vacuum system client has been reset.

Cause: An instrument in a vacuum group is failing to respond to a periodic network con-
nectivity check.

Action: Open the Vacuum Groups window. Ensure that all instruments shown in this win-
dow are currently powered on and physically connected to the same network.

6554 | Vacuum system server has been reset.

Cause: An instrument in a vacuum group is failing to respond to a periodic network con-
nectivity check.

Action: Open the Vacuum Groups window. Ensure that all instruments shown in this win-
dow are currently powered on and physically connected to the same network.
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E PYTHON MODULE - ADVANCED REPORTS
The mic Python module is automatically imported when running a user supplied script. The module
provides access to primary and overlay isotherm data and provides support for summary, tabular, and
graphical reports.

l Summary reports. Consist of summary sections, each containing a two-column table of label and
value pairs. Summary reports are created with the mic.summary call.

l Tabular reports. Consist of one or more tables each containing one or more labeled columns of
data.Tabular reports are created with the mic.table call.

l Graphical reports. Consist of a single graph with one or more curves on one or two y-axes. Graph-
ical reports are created with the mic.graph call.

Calls for accessing the sample file data can be found in the Mic Module Python Calls section of this
appendix. More advanced example python scripts are included in the analyzer software. Application
specific discussions can be found on http://www.micro-report.com

The examples in this topic are also included as a part of the Micromeritics installation pro-
cess and are located in the Scripts sub-directory.

RUN A SCRIPT
1. Open a sample file with a Complete file status.

2. Select Advanced in the drop-down list at the bottom of the window.

3. Select the Report Options tab.

4. Highlight Advanced in the Reports list box, then click Edit.

5. On the Advanced Report Options window, click Add. Locate and select one or more python
scripts then click Select. The selected scripts become a part of the drop-down list in the Available
Scripts section of the Advanced Report Options window.

6. In the Selected Reports section, select up to five Advanced reports in the drop-down lists. Use the
Pressures button to include or exclude available pressures in the report.

7. Click OK to close the window.

8. Click Preview on the Report Options tab to view all reports selected in the previous window.
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EDIT A SCRIPT

When a script is added, the code is stored within the application. If the script changes out-
side of the application, the script file will have to be re-added to the Advanced Report
Options window for the changes to take affect.

Field or Button Description
Add Adds one or more scripts to the Available Scripts box. The added scripts

then become available as options in the Selected Reports section.
Edit Edits the script stored within the application but does not affect the ori-

ginal .py text file.
Remove Removes the script from the Available Scripts box but does not affect ori-

ginal .py text file
Replace Replaces the contents of the selected script however, the script name

remains the same.

REMOVE A SCRIPT
Select the script in the Available Scripts box then click Remove. The script is removed from the
application however, the original .py text file is not affected.
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GRAPHIC REPORTS
Available Mic Python calls for graphic reports:

l Add a curve

l Add a curve using the second Y-axis

l Create a new graphic report

SUMMARY REPORT

This script produces a summary report with two summaries:

import mic
mic.summary( "My Summaries" )

mic.summary.add( "Summary A",
["label 1:", "label 2:", "label 3:"],
["val1", "val2", "val3"] )

mic.summary.add( "Summary B",
["label 4:", "label 5:", "label 6:"],
["val4", "val5", "val6"] )

The result is:

Graphic Reports
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TABULAR REPORT

If more than one column is required, the call mic.table is employed. This script produces a tabular report
consisting of two tables. NOTE: This script uses the Python package "numpy" and c-style formatting of
the numerical values.

import mic
import numpy as np

mic.table("My Tables")

mic.table.addtable( "My set A" )
mic.table.addcolumn( "x", ["1.0", "2.0", "3.0"] )
mic.table.addcolumn( "y", ["0.5", "1.0", "1.5"] )

x1 = 0.2
x2 = 0.5
x3 = 3.14159/2
mic.table.addtable( "My set B" )
mic.table.addcolumn( "x", ["%8.3f" % x1,

"%8.3f" % x2,
"%8.3f" % x3 ] )

mic.table.addcolumn( "sin(x)", ["%8.3f" % np.sin(x1),
"%8.3f" % np.sin(x2),
"%8.3f" % np.sin(x3)] )

mic.table.addcolumn( "cos(x)", ["%8.3f" % np.cos(x1),
"%8.3f" % np.cos(x2),
"%8.3f" % np.cos(x3)] )

The result is:
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ACQUIRE BASIC INFORMATION

To acquire the adsorption isotherm and other basic information about the sample being edited, the calls
mic.isotherm, mic.sample_information and mic.adsorptive_data are applied.

This script produces a graph of the adsorption and desorption isotherms for both relative and absolute
pressure, and prints summaries of the sample information and the adsorptive properties.

import mic

prel, qads, n_ads, warm_fs, cold_fs, mass, desc = mic.isotherm('rel')
mic.graph( 'Graphical Report 1', 'Rel. Press', 'Quantity Adsorbed' )
mic.graph.add( 'Sample isotherm', prel, qads )

pabs, qads, n_ads, warm_fs, cold_fs, mass, desc = mic.isotherm('abs')

mic.graph( 'Graphical Report 2' 'Abs. Press', 'Quantity Adsorbed')
mic.graph.add('Sample Isotherm', pabs, qads)

mass = mic.sample_information('sample mass' )
Tanl = mic.sample_information('analysis temperature' )
dens = mic.sample_information('sample density')

mic.summary( "Sample Information" )
mic.summary.add( "Sample Information:",

[ "Number of adsorption points:",
"Warm Free space:",
"Cold Free space:" ,
"Sample mass (g):",
"Description:",
"Analysis Temp:",
"Sample Density (g/cm^3):" ],

[ "%8.3f" % n_ads,
"%8.3f" % warm_fs,
"%8.3f" % cold_fs,
"%8.3f" % mass,
desc,
"%8.3f" % Tanl,
"%8.3f" % dens ] )

csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data()

mic.summary.add( "Adsorptive Data",
[ "Cross Sectional Area",

"Hard Sphere Diameter",
"Density Conversion Factor",

Acquire Basic Information
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"Molecular Weight",
"Analysis gas"],

[ "%8.3f" % csa,
"%8.3f" % hsd,
"%8.3f" % dcf,
"%8.3f" % mol_weight,
analysis_gas ] )

Note the calls to mic.isotherm and mic.adsorptive_data above are each returning results as a list with
elements of varying return type.
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ACQUIRE REPORT RESULTS
Sample file report results may be accessed using the mic.report call. This script prints a summary of the
results of the t-plot and BET reports.

import mic

sa = mic.report("bet", "surface area")
c = mic.report("bet", "bet constant")
vm = mic.report("bet", "monolayer capacity")
esa = mic.report("tplot", "external surface area")
vol = mic.report("tplot", "micropore volume")

mic.summary( "BET and T-plot Results" )

mic.summary.add( "Report Results",
[ "bet surface area",

"bet constant",
"bety 6" ,
"tplot external surface area",
"tplot micropore volume"],

[ "%10.5f" % sa,
"%10.5f" % c,
"%10.5f" % vm,
"%10.5f" % esa,
"%10.5f" % vol ] )

The result is:

Acquiring the results from a pore-distribution report such as the BJH method is done in a similar way as
in the previous script except the return values from the mic.report call are slightly different since they
involve lists of data. For example,

import mic
xdat, ydat, desc = mic.report('bjhads' ,'incremental distribution' )
mic.graph( 'BJH Ads/Des', 'Pore diameter', 'Incremental Volume' )
mic.graph.add( desc, xdat, ydat )

The result is:

Acquire Report Results
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See the Mic Module Python Calls section for a more complete description of the usage and scope of the
mic.report call.

ACQUIRE OVERLAY SAMPLE DATA
The call to obtain overlay sample data is similar to the calls for the primary sample. This script involves
two overlay sample files.

The calls to obtain adsorptive data and report results for an overlay sample file using mic.report and
mic.adsorptive_data have a very similar interface as the mic.overlay call, and a summary of their usage
is shown in the example in this topic.

import mic

p, q, n, fsw, fsc, mass, desc = mic.isotherm('rel')
p1, q1, n1, fsw1, fsc1, mass1, desc1 = mic.overlay( 1, 'rel')
p2, q2, n2, fsw2, fsc2, mass2, desc2 = mic.overlay( 2, 'rel')

mic.graph( 'Three Sample Isotherms',
'Rel. Press',
'Quantity Adsorbed (cm^3/g)' )

mic.graph.add( 'Primary Isotherm ', p, q )
mic.graph.add( 'Overlay Isotherm 1', p1, q1 )
mic.graph.add( 'Overlay Isotherm 2', p2, q2 )

mic.summary( "A summary report" )

mic.summary.add( "Two samples",
[ "Primary Sample:",

"Overlay Sample 1:",
"Overlay Sample 2:" ],

[ desc,
desc1,
desc2] )

The results are:
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To enable the use of overlay data in the Advanced reports, the following two actions must be taken prior
to running the script.

l Sample files to overlay must be selected, and

l The Overlay samples checkbox on the Advanced Report Options window must be selected

Acquire Overlay Sample Data
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ENABLE THE USE OF OVERLAY DATA
1. On the Report Options tab, click Overlays.

2. On the Plot Overlay Sample Selection window, use one of the following options to move up to 25
files from the Available Files box to the Selected Files box:

l Double click a file name in the Available Files box to move the file to the Selected Files box.
To move a file from the Selected Files box back to the Available Files box, double click the
file name in the Selected Files box, or

l Select a file name in the Available Files box. Click Add to move the selected file to the
Selected Files box. To move a file from the Selected Files box back to the Available Files box,
select a file name in the Selected Files box, then click Remove. To select more than one file,
hold down the Ctrl key on the keyboard while selecting the files, or hold down the Shift key to
select a range of files.

3. Click OK.

4. On the Report Options tab, highlight Advanced in the Selected Reports list box.

5. Click Edit to the left of the Selected Reports list box.

6. Select the Overlay samples checkbox to the right of the selected report.

7. Click OK.

8. Run the script using the instructions found in Run a Script on page E - 1.
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MIC MODULE PYTHON CALLS

TABLES

Available Mic Python calls for tables:

l Create a new tabular report

l Add a column

l Add a table

Create a New Tabular Report

mic.table( title='User Table' )

Keyword arguments:

title --- the tabular report title (default = 'User Table')

Add a Table

This script adds a table to the last created tabular report:

mic.table.addtable( name )

Keyword arguments:

name --- the table name

Add a Column

This script adds a column to the last created table:

mic.table.addcolumn( header, values )

Keyword arguments:

header --- column header; must be a string (or convertible)
values --- column values; must be a list of strings (or convertible)
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SUMMARY REPORTS

Available Mic Python calls for summary reports:

l Add a summary section to the last created summary report

l Create a new summary report

Create a New Summary Report

mic.summary( title='User Summary' )

Keyword arguments:

title --- the summary title

Add a Summary Section

This script adds a summary section to the last created summary report:

mic.summary.add( name, labels, values )

Keyword arguments:

name --- summary section name
labels --- column of labels; must be a list of strings

(or convertible) and the same length as values
values --- column of values; must be a list of strings

(or convertible) and the same length as labels

Summary Reports
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GRAPHIC REPORTS

Available Mic Python calls for graphic reports:

l Add a curve

l Add a curve using the second Y-axis

l Create a new graphic report

Create a New Graphical Report

mic.graph( title='User Graph', xlabel='X axis', ylabel='Y axis', yylabel='YY
axis', xlinear=True, ylinear=True, yylinear=True )

Keyword arguments:

title --- the graphical report title (default = 'User Graph')
xlabel --- x-axis label (default = 'X axis')
ylabel --- y-axis label (default = 'Y axis')
yylabel --- yy-axis label (default = 'YY axis')
xlinear --- x-axis linear scale; if false, use log scale

(default = True)
ylinear --- y-axis linear scale; if false, use log scale

(default = True)
yylinear --- yy-axis linear scale; if false, use log scale

(default = True)

Add a Curve

This script adds a curve to the last created graphical report:

mic.graph.add( name, x, y, yyaxis=False, color=None, linestyle='-', mark-
er='a', graphtype='both' )

Keyword arguments:

name --- the curve name
x --- list of x values; must be a list of floats

(or convertible) and the same length as y
y --- list of y values; must be a list of floats

(or convertible) and the same length as x
yyaxis --- place this curve on the yy-axis if True

otherwise place on the y-axis (default = False)
color --- RGB color as an HTML hex string (e.g., '#4169e1')

or a three-element list or tuple (e.g., [65,105,225]);
if None, color is automatically selected (default = None)

linestyle --- line style; (default = '-')
'-' : solid
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'--' : dash
'.' : dot
'-.' : dash dot
'-..' : dash dot dot

marker --- marker shape; (default = 'a')
'+' : plus
'o' or '0' : circle
'x' : cross
'^' : up triangle
'v' : down triangle
's' : square
'd' : diamond
'8' : hourglass
'~' : horizontal hourglass
'' or None : no marker
'a' : automatically selected

graphtype --- graph type; (default = 'both')
'curve' or 'c' : curve
'points' or 'p' : points
'both' or 'b' : curve-and-points
'hist' or 'h' : histogram

Add a Curve Using the Second Y-Axis

This script adds a curve to the last created graphical report using the second y-axis:

mic.graph.addyy( name, xx, yy )

Add a curve to the last created graphical report using the second
y-axis. The arguments to this call are the same as to mic.graph.add
with the argument

GET PRIMARY ISOTHERM DATA

mic.overlay( overlay_number = 1, press_type='rel' )

Keyword arguments:

overlay_number --- the overlay number (1 through 8; default = 1)
press_type --- the pressure basis; use 'rel' for relative pressure,

'abs' for absolute (default = 'rel')

Usage:

p, qads, num_ads, warm_fs, cold_fs, mass, desc = mic.overlay(1, 'rel')

p --- array of pressure (relative or absolute);

Get Primary Isotherm Data
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empty-array if overlay is unavailable
qads --- array of cumulative quantity adsorbed;

empty-array if overlay is unavailable
num_ads --- number of points in the adsorption curve;

0 if overlay is unavailable
warm_fs --- warm free-space; 0.0 if overlay is unavailable
cold_fs --- cold free-space; 0.0 if overlay is unavailable
mass --- sample mass; 0.0 if overlay is unavailable
desc --- sample description; empty-string if

overlay is unavailable

GET OVERLAY ISOTHERM DATA

mic.overlay( overlay_number = 1, press_type='rel' )

Keyword arguments:

overlay_number --- the overlay number (1 through 8; default = 1)
press_type --- the pressure basis; use 'rel' for relative pressure,

'abs' for absolute (default = 'rel')

Usage:

p, qads, num_ads, warm_fs, cold_fs, mass, desc = mic.overlay(1, 'rel')

p --- array of pressure (relative or absolute);
empty-array if overlay is unavailable

qads --- array of cumulative quantity adsorbed;
empty-array if overlay is unavailable

num_ads --- number of points in the adsorption curve;
0 if overlay is unavailable

warm_fs --- warm free-space; 0.0 if overlay is unavailable
cold_fs --- cold free-space; 0.0 if overlay is unavailable
mass --- sample mass; 0.0 if overlay is unavailable
desc --- sample description; empty-string if

overlay is unavailable

GET ADSORPTIVE DATA FOR EACH SAMPLE

mic.adsorptive_data( sample_number = 0 )

Keyword arguments:

sample_number --- Identifier for the adsorptive data to retrieve
0 : the current sample file
1 through 8 : the corresponding overlay sample file
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Usage:

csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data()
csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data(0)

csa --- cross sectional area (nm^2)
hsd --- hard sphere diameter (angstroms)
dcf --- density conversion factor (dimensionless)
mol_weight --- molecular weight
analysis_gas --- mnemonic for the analysis gas species

(e.g., 'CO', 'H2')

GET SAMPLE INFORMATION ITEM

mic.sample_information( item, sample_number = 0 )

Keyword arguments:

item --- string identifying the item to be returned.
Accepted identifiers are

'sample mass'
'sample description'
'analysis temperature' (degrees Kelvin)
'sample density' ( g/cm^3 )

sample_number --- Sample to retrieve (default = 0).
0 : the current sample file
1 through 8 : the corresponding overlay sample file

Usage:

mass = sample_information('sample mass')
mass = sample_information('sample mass',0)

GET REPORT RESULTS

This script gets report results for the indicted report and sample.

mic.report( report_name, result, sample_number = 0 )

Keyword arguments:

sample_number --- Identifier for the sample data to retrieve
0 : the current sample file
1 through 8 : the corresponding overlay sample file

Get Sample Information Item
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Usage:

sa = mic.report( 'bet' , 'surface area' )
porewidth, incvol, desc = mic.report( 'bjhads' ,

'incremental distribution' )

The available report keywords, result keywords and a corresponding
description of the result is listed in the table below:

Report keyword Result keyword Description
-------------- -------------- -----------

bet surface area Surface area ( m^2/g )
bet bet constant BET constant ( dimensionless )

bet monolayer capacity Monolayer capacity ( cm^3/g )
tplot external surface area External surface area (m^2/g)
tplot micropore volume Micropore volume (cm^3/g)
bjhads incremental distribution Incremental Distribution
bjhdes incremental distribution Incremental Distribution
dhads incremental distribution Incremental Distribution
hk incremental distribution Incremental Distribution
dft incremental distribution Incremental Distribution
nldft incremental distribution Incremental Distribution

where the incremental pore distribution result above (for those
reports which return this) is a list with three components being,

porewidth --- array of pore dimension boundaries (angstroms);
empty-array if unavailable.

incvol --- array of incremental pore volumes (cm^3/g);
empty-array if unavailable.

desc --- Name of data set; empty-string if unavailable.

GET IMPORTED PORE DATA

mic.imported_pore_data( import_number = 1 )

Keyword arguments:

import_number --- the import number (1 through 8)

Usage:

xdat, ydat, desc = mic.imported_pore_data(1)

xdat --- array of pore dimension boundaries (angstroms);
empty-array if unavailable.

ydat --- array of incremental pore volumes (cm^3/g);
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empty-array if unavailable.
desc --- Name of data set; empty-string if unavailable.

Get Imported Pore Data
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F WORKSHEETS

Worksheets in this section may be copied as needed.

l Input Gas Worksheet

l Sample Data Worksheet

F Worksheets

ASAP 2060 Operator Manual
206-42800-01 (Rev -) — June 2015

F - 1



INPUT GAS WORKSHEET

Port Gas
P1
P2
P3
P4
P5
P6

Physisorption

Copy and use this form as needed



SAMPLE DATA WORKSHEET

Use this form to assist in obtaining an accurate sample mass for report calculations.

Sample tube: Sample:

Before Degas:
1. Mass of empty sample tube g
2. Mass of sample tube plus sample g
3. Mass of sample (step 2 minus step 1) g

After Degas:
4. Mass of sample tube plus sample g
5. Mass of sample (step 4 minus step 1) g

After Analysis:
6. Mass of sample tube plus sample g
7. Mass of sample (step 6 minus step 1) g

Compare the sample mass obtained after analysis (Step 7) with the sample mass after degas (Step 5).
These two values should be close in range. If a significant difference is noted, analysis problems may
exist or the sample may have been improperly degassed.

Copy and use this form as needed
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